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End-User Software License
Agreement

PLEASE READ THIS SOFTWARE LICENSE AGREEMENT
"LICENSE" CAREFULLY BEFORE USING THE SOFTWARE. BY
USING THE SOFTWARE, YOU ARE AGREEING TO BE BOUND
BY THE TERMS OF THIS LICENSE. IF YOU DO NOT AGREE
TO THE TERMS OF THIS LICENSE, PROMPTLY RETURN THE
SOFTWARE TO ROGUE RESEARCH INC.

ROGUE RESEARCH AND ITS SUPPLIERS DO NOT AND
CANNOT WARRANT THE PERFORMANCE OR RESULTS YOU
MAY OBTAIN BY USING THE SOFTWARE OR DOCUMENTA-
TION. ROGUE AND ITS SUPPLIERS MAKE NO WARRANTIES,
EXPRESSED OR IMPLIED, AS TO MERCHANTABILITY, OR
FITNESS FOR ANY PARTICULAR PURPOSE. ANY LIABILITY
DUE TO FAILURE OF BRAINSIGHT WITHIN THE 1 YEAR
WARRANTY PERIOD SHALL BE LIMITED TO REPLACEMENT
OF THE SOFTWARE. IN NO EVENT WILL ROGUE ORITS
SUPPLIERS BE LIABLE TO YOU, YOUR STAFF OR CUSTOM-
ERS FOR ANY CONSEQUENTIAL, INCIDENTAL OR SPECIAL
DAMAGES, INCLUDING ANY LOST PROFITS OR LOST
SAVINGS, EVEN IF A ROGUE REPRESENTATIVE HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR
ANY CLAIM BY ANY THIRD PARTY.

BRAINSIGHT IS A RESEARCH APPLICATION, AND HAS NOT
BEEN APPROVED FOR ANY APPLICATION BY ANY MEDICAL
AUTHORITY. IT IS THE RESPONSIBILITY OF THE END-USER
TO ENSURE THAT BRAINSIGHT IS USED IN ACCORDANCE
ANY APPLICABLE LAWS.

1. License.

The software accompanying this License, whether on
compact disc or any other media, the related documen-
tation and other materials (collectively, "Brainsight
Software") are licensed, not sold, to you by Rogue
Research Inc. (“Rogue”). The Brainsight Software in this
package and any copies which this agreement authorizes
you to make are subject to this License. The Brainsight
Software accompanying this License includes third party
open source and other commercial software whose use
is governed exclusively by the terms of their respective
licenses.

2. Permitted Uses and Restrictions.

You may install the Software on up to 10 computers, So
long as they are all associated with the license owner.
For example, a lab member who wishes to install the
Software on his laptop for the purposes of preparing or
reviewing data acquired by this system.

e You may use Brainsight for investigational use.

* You may not use Brainsight for therapeutic or
diagnostic applications or for surgical guidance
involving humans.

3. Copyright.

The Software is owned by Rogue and its suppliers, and its
structure, organization and code are the valuable trade
secrets of Rogue and its suppliers. The Software is also
protected by Canadian Copyright Law and International



Treaty provisions. You must treat the Software just as you
would any other copyrighted material, such as a book.
You may not copy the Software or the Documentation,
except as set forth in the "Permitted Uses and Restric-
tions" section. Any copies that you are permitted to

make pursuant to this Agreement must contain the same
copyright and other proprietary notices that appear on or
in the Software. You agree not to modify, adapt, translate,
reverse engineer, decompile, disassemble or otherwise
attempt to discover the source code of the Software,
except in the case of included third party software where
such rights are expressly granted by their respective
licenses. Trademarks shall be used in accordance with
accepted trademark practice, including identification of
trademark owner's name. Trademarks can only be used
to identify printed output produced by the Software. Such
use of any trademark does not give you any rights of
ownership in that trademark. Except as stated above, this
Agreement does not grant you any intellectual property
rights in the Software.

4. Transfer.

You may not rent, lease, sublicense or lend the Software
or Documentation. You may, however, transfer all your
rights to use the Software to another person or legal
entity provided that you transfer this Agreement, the
Software, including all copies, updates and prior versions,
and all Documentation to such person or entity and

that you retain no copies, including copies stored on a
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computer.

Trademarks

Brainsight® is a trademark of Rogue Research, Inc.
Polaris® and Vicra™ are registered trademarks of
Northern Digital, Inc.

Macintosh®, Mac OS X® and QuickTime® are registered
trademarks of Apple Computer, Inc.

Intel® is a registered trademark of Intel Corporation or its
subsidiaries in the United States and other countries.
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Conformity

Manufacturer

Rogue Research Inc.
206-4398 boul. St-Laurent
Montréal, Québec H2W 175
Canada

Product: Brainsight NIRS
Brainsight NIRS conformity pending.

Roch M. Comeau, Ph.D.

President



Component License
agreements

Brainsight 2 employs several open-source components
and we have contributed to many of these through devel-
opment and testing of new features (both automated and
manual). The license agreements of each open-source
components are printed here in compliance with their
respective license agreements.

VTK
VTK is an open-source toolkit licensed under the BSD
license.

Copyright (c) 1993-2008 Ken Martin, Will Schroeder, Bill
Lorensen

All rights reserved.

Redistribution and use in source and binary forms, with
or without modification, are permitted provided that the
following conditions are met:

- Redistributions of source code must retain the above
copyright notice, this list of conditions and the following
disclaimer.

- Redistributions in binary form must reproduce the
above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other
materials provided with the distribution.

- Neither name of Ken Martin, Will Schroeder, or Bill
Lorensen nor the names of any contributors may be

Brainsight' WEEE  USER MANUALV2.5

used to endorse or promote products derived from this
software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT
HOLDERS AND CONTRIBUTORS "AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING,

BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
AUTHORS OR CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY,
OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE
OR OTHERWISE) ARISING IN ANY WAY QUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSI-
BILITY OF SUCH DAMAGE.

ITK

NumFOCUS holds the copyright of this software. NumFO-
CUS is a non-profit entity that promotes the use of open
source scientific software for educational and research
purposes. NumFOCUS delegates project governance to
the Insight Software Consortium Council, an educational
consortium dedicated to promoting and maintaining
open-source, freely available software for medical image

analysis.

The software is distributed as open source under an
OSl-approved license. Starting with ITK 4.0, the Apache
2.0 license is used. For versions prior and including 3.20,
the new and simplified BSD license is used. Before 3.6, a
variation of the BSD license is used.

GDCM
Copyright (c) 2006-2011 Mathieu Malaterre

Copyright (c) 1993-2005 CREATIS

(CREATIS = Centre de Recherche et d'Applications en
Traitement de 'Image)

All rights reserved.

Redistribution and use in source and binary forms, with
or without

modification, are permitted provided that the following
conditions are met:

- Redistributions of source code must retain the above
copyright notice, this Llist of conditions and the following
disclaimer.

- Redistributions in binary form must reproduce the
above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other
materials provided with the distribution.

- Neither name of Mathieu Malaterre, or CREATIS, nor
the names of any contributors (CNRS, INSERM, UCB,
Universite Lyon 1), may be used to endorse or promote



products derived from this software without specific prior
written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT
HOLDERS AND CONTRIBUTORS “AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING,

BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
AUTHORS OR CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY,
OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSI-
BILITY OF SUCH DAMAGE.

OpenCV
Copyright 2000-2022 Intel Corporation, OpenCV Founda-
tion, and others

Licensed under the Apache License, Version 2.0 (the
“License"); you may not use this file except in compliance
with the License.

You may obtain a copy of the License at

http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing,
software distributed under the License is distributed on
an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDI-
TIONS OF ANY KIND, either express or implied. See the
License for the specific language governing permissions
and limitations under the License.

AMSerialPort
Copyright © 2009, Andreas Mayer

All rights reserved.

Redistribution and use in source and binary forms, with
or without modification, are permitted provided that the
following conditions are met:

- Redistributions of source code must retain the above
copyright notice, this list of conditions and the following
disclaimer.

- Redistributions in binary form must reproduce the
above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other
materials provided with the distribution.

- Neither the name of Andreas Mayer nor the names

of its contributors may be used to endorse or promote
products derived from this software without specific prior
written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT
HOLDERS AND CONTRIBUTORS "AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING,
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF

MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL

THE COPYRIGHT HOLDER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA,
OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
OF THE POSSIBILITY OF SUCH DAMAGE.

Remote Control Wrapper
Copyright (c) 2006-2014 Martin Kahr

MIT Style License

Permission is hereby granted, free of charge, to any
person obtaining a copy of this software and associated
documentation files (the "Software"), to deal in the
Software without restriction, including without limitation
the rights to use, copy, modify, merge, publish, distribute,
sublicense, and/or sell copies of the Software, and to
permit persons to whom the Software is furnished to do
S0, subject to the following conditions:

The above copyright notice and this permission notice
shall be included in all copies or substantial portions of
the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT



WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE AND NONINFRINGEMENT. IN NO EVENT
SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE
LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABIL-
ITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR
OTHERWISE, ARISING FROM, OUT OF OR IN CONNEC-
TION WITH THE SOFTWARE OR THE USE OR OTHER
DEALINGS IN THE SOFTWARE.

FeedbackReporter
Copyright 2008-2019 Torsten Curdt

Licensed under the Apache License, Version 2.0 (the
“License"); you may not use this file except in compliance
with the License.

You may obtain a copy of the License at
http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing,
software distributed under the License is distributed on
an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDI-
TIONS OF ANY KIND, either express or implied. See the
License for the specific language governing permissions
and limitations under the License.

libusb
GNU LESSER GENERAL PUBLIC LICENSE (LGPL) 2.1

GNU LESSER GENERAL PUBLIC LICENSE TERMS AND
CONDITIONS FOR COPYING, DISTRIBUTION AND
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MODIFICATION

0. This License Agreement applies to any software
library or other program which contains a notice placed
by the copyright holder or other authorized party saying
it may be distributed under the terms of this Lesser
General Public License (also called “this License").

Each licensee is addressed as "you".

A "library" means a collection of software functions
and/or dataprepared so as to be conveniently linked with
application programs (which use some of those functions
and data) to form executables.

The "Library", below, refers to any such software library
or work which has been distributed under these terms.
A "work based on the Library" means either the Library
or any derivative work under copyright law: that is to
say, a work containing the Library or a portion of it,
either verbatim or with modifications and/or translated
straightforwardly into another language. (Hereinafter,
translation is included without limitation in the term
“modification”.)

“Source code" for a work means the preferred form of
the work for making modifications to it. For a library,
complete source code means all the source code for all
modules it contains, plus any associated interface defini-
tion files, plus the scripts used to control compilation and
installation of the library.

Activities other than copying, distribution and modifica-
tion are not covered by this License; they are outside its

scope. The act of running a program using the Library is
not restricted, and output from such a program is covered
only if its contents constitute a work based on the Library
(independent of the use of the Library in a tool for writing
it). Whether that is true depends on what the Library
does and what the program that uses the Library does.

1. You may copy and distribute verbatim copies of the
Library's complete source code as you receive it, in any
medium, provided that you conspicuously and appro-
priately publish on each copy an appropriate copyright
notice and disclaimer of warranty; keep intact all the
notices that refer to this License and to the absence of
any warranty; and distribute a copy of this License along
with the Library.

You may charge a fee for the physical act of transferring
a copy, and you may at your option offer warranty protec-
tion in exchange for a fee.

2. You may modify your copy or copies of the Library
or any portion of it, thus forming a work based on the
Library, and copy and distribute such modifications or
work under the terms of Section 1 above, provided that
you also meet all of these conditions:

a) The modified work must itself be a software library.

b) You must cause the files modified to carry prominent
notices stating that you changed the files and the date of
any change.

¢) You must cause the whole of the work to be licensed
atno charge to all third parties under the terms of this



License.

d) If a facility in the modified Library refers to a
function or a table of data to be supplied by an applica-
tion program that uses the facility, other than as an
argument passed when the facility is invoked, then you
must make a good faith effort to ensure that, in the event
an application does not supply such function or table, the
facility still operates, and performs whatever part of its
purpose remains meaningful. (For example, a function
in a library to compute square roots has a purpose that
is entirely well-defined independent of the application.
Therefore, Subsection 2d requires that any application-
supplied function or table used by this function must be
optional: if the application does not supply it, the square
root function must still compute square roots.)

These requirements apply to the modified work as a
whole. If identifiable sections of that work are not derived
from the Library, and can be reasonably considered
independent and separate works in themselves, then

this License, and its terms, do not apply to those sections
when you distribute them as separate works. But when
you distribute the same sections as part of a whole

which is a work based on the Library, the distribution of
the whole must be on the terms of this License, whose
permissions for other licensees extend to the entire
whole, and thus to each and every part regardless of who
wrote it. Thus, it is not the intent of this section to claim
rights or contestyour rights to work written entirely by
you; rather, the intent is to exercise the right to control

the distribution of derivative or collective works based on
the Library.

In addition, mere aggregation of another work not based
on the Library with the Library (or with a work based

on the Library) on a volume of a storage or distribution
medium does not bring the other work under the scope of
this License.

3. You may opt to apply the terms of the ordinary GNU
General Public License instead of this License to a given
copy of the Library. To do this, you must alter all the
notices that refer to this License, so that they refer to the
ordinary GNU General Public License, version 2, instead
of to this License. (If a newer version than version 2 of
the ordinary GNU General Public License has appeared,
then you can specify that version instead if you wish.) Do
not make any other change in these notices.

Once this change is made in a given copy, it is irrevers-
ible for that copy, so the ordinary GNU General Public
License applies to all subsequent copies and derivative
works made from that copy.

This option is useful when you wish to copy part of the
code of the Library into a program that is not a library.

4. You may copy and distribute the Library (or a portion
or derivative of it, under Section 2) in object code or
executable form under the terms of Sections 1 and 2
above provided that you accompany it with the complete
corresponding machine-readable source code, which
must be distributed under the terms of Sections 1 and

2 above on a medium customarily used for software
interchange.

If distribution of object code is made by offering access
to copy from a designated place, then offering equivalent
access to copy the source code from the same place
satisfies the requirement to distribute the source code,
even though third parties are not compelled to copy the
source along with the object code.

5. A program that contains no derivative of any portion
of the Library, but is designed to work with the Library
by being compiled or linked with it, is called a “work
that uses the Library". Such a work, in isolation, is not a
derivative work of the Library, and therefore falls outside
the scope of this License.

However, linking a "work that uses the Library” with
the Library creates an executable that is a derivative of
the Library (because it contains portions of the Library),
rather than a “work that uses the library”. The execut-
able is therefore covered by this License. Section 6 states
terms for distribution of such executables.

When a "work that uses the Library" uses material from
a header file that is part of the Library, the object code
for the work may be a derivative work of the Library even
though the source code is not. Whether this is true is
especially significant if the work can be linked without the
Library, or if the work is itself a library. The threshold for
this to be true is not precisely defined by law. If such an

object file uses only numerical parameters, data structure



layouts and accessors, and small macros and small
inline functions (ten Llines or less in length), then the use
of the object file is unrestricted, regardless of whether

it is legally a derivative work. (Executables containing
this object code plus portions of the Library will still fall
under Section 6.)  Otherwise, if the work is a derivative
of the Library, you may distribute the object code for

the work under the terms of Section 6. Any executables
containing that work also fall under Section 6, whether or

not they are linked directly with the Library itself.

6. As an exception to the Sections above, you may also
combine or link a "work that uses the Library” with the
Library to produce a work containing portions of the
Library, and distribute that work under terms of your
choice, provided that the terms permit modification of the
work for the customer's own use and reverse engineering
for debugging such modifications.  You must give promi-
nent notice with each copy of the work that the Library is
used in it and that the Library and its use are covered by
this License. You must supply a copy of this License. If
the work during execution displays copyright notices, you
must include the copyright notice for the Library among
them, as well as a reference directing the user to the copy
of this License. Also, you must do one of these things:

a) Accompany the work with the complete correspond-
ing  machine-readable source code for the Library
including whatever  changes were used in the work

(which must be distributed under  Sections 1 and 2
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with the
Library, with the complete machine-readable "work that
uses the Library", as object code and/or source code, 50
that the
produce a modified  executable containing the modified
Library. (Itis understood  that the user who changes
the contents of definitions files in the

above); and, if the work is an executable linked

user can modify the Library and then relink to

Library will not
necessarily be able to recompile the application  to use

the modified definitions.)

b) Use a suitable shared library mechanism for linking
with the
usesatruntime a

Library. A suitable mechanism is one that (1)
copy of the library already present
on the user's computer system,  rather than copying
library functions into the executable, and (2)  will
operate properly with a modified version of the Library,

if  the user installs one, as long as the modified version
is interface-compatible with the version that the work

was made with.

¢) Accompany the work with a written offer, valid for at
least three years, to give the same user the materials
specified in Subsection 6a, above, for a charge no more
than the cost of performing this distribution.

d) If distribution of the work is made by offering access
to copy
access to copy the above
same place.

from a designated place, offer equivalent
specified materials from the

e) Verify that the user has already received a copy of
these  materials or that you have already sent this user

a copy.
“work that uses the Library" must include any data and
utility programs needed for reproducing the executable

For an executable, the required form of the

from it. However, as a special exception, the materials to
be distributed need not include anything that is normally
distributed (in either source or binary form) with the
major components (compiler, kernel, and so on) of the
operating system on which the executable runs, unless
that component itself accompanies the executable.

It may happen that this requirement contradicts the
license restrictions of other proprietary libraries that do
not normally accompany the operating system. Such a
contradiction means you cannot use both them and the
Library together in an executable that you distribute.

7. You may place library facilities that are a work based
on the Library side-by-side in a single library together
with other Library facilities not covered by this License,
and distribute such a combined library, provided that the
separate distribution of the work based on the Library
and of the other library facilities is otherwise permitted,
and provided that you do these two things:

a) Accompany the combined library with a copy of the
same work
other library
the terms of the

based on the Library, uncombined with any
facilities. This must be distributed under
Sections above.

b) Give prominent notice with the combined library of
the fact
and explaining

that part of it is a work based on the Library,
where to find the accompanying



uncombined form of the same work.

8. You may not copy, modify, sublicense, link with, or
distribute the Library except as expressly provided under
this License. Any attempt otherwise to copy, modify,
sublicense, link with, or distribute the Library is void,
and will automatically terminate your rights under this
License. However, parties who have received copies, or
rights, from you under this License will not have their
licenses terminated so long as such parties remain in full
compliance.

9. You are not required to accept this License, since
you have not signed it. However, nothing else grants
you permission to modify or distribute the Library or its
derivative works. These actions are prohibited by law if
you do not accept this License. Therefore, by modifying
or distributing the Library (or any work based on the
Library), you indicate your acceptance of this License
to do so, and all its terms and conditions for copying,
distributing or modifying the Library or works based on it.

10. Each time you redistribute the Library (or any work
based on the Library), the recipient automatically receives
a license from the original licensor to copy, distribute,
link with or modify the Library subject to these terms and
conditions. You may not impose any further restrictions
on the recipients’ exercise of the rights granted herein.
You are not responsible for enforcing compliance by third
parties with this License.

11. If, as a consequence of a court judgment or allega-

tion of patent infringement or for any other reason (not
limited to patent issues), conditions are imposed on you
(whether by court order, agreement or otherwise) that
contradict the conditions of this License, they do not
excuse you from the conditions of this License. If you
cannot distribute so as to satisfy simultaneously your
obligations under this License and any other pertinent
obligations, then as a consequence you may not distrib-
ute the Library at all. For example, if a patent license
would not permit royalty-free redistribution of the Library
by all those who receive copies directly or indirectly
through you, then the only way you could satisfy both

it and this License would be to refrain entirely from
distribution of the Library.

If any portion of this section is held invalid or unenforce-
able under any particular circumstance, the balance

of the section is intended to apply, and the section as a
whole is intended to apply in other circumstances. Itis
not the purpose of this section to induce you to infringe
any patents or other property right claims or to contest
validity of any such claims; this section has the sole
purpose of protecting the integrity of the free software
distribution system which is implemented by public
license practices. Many people have made generous
contributions to the wide range of software distributed
through that system in reliance on consistent application
of that system; it is up to the author/donor to decide if he
or she is willing to distribute software through any other
system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is
believed to be a consequence of the rest of this License.

12. If the distribution and/or use of the Library is
restricted in certain countries either by patents or by
copyrighted interfaces, the original copyright holder
who places the Library under this License may add an
explicit geographical distribution limitation excluding
those countries, so that distribution is permitted only in
or among countries not thus excluded. In such case, this
License incorporates the limitation as if written in the
body of this License.

13. The Free Software Foundation may publish revised
and/or new versions of the Lesser General Public License
from time to time. Such new versions will be similar in
spirit to the present version, but may differ in detail to
address new problems or concerns. Each version is given
a distinguishing version number. If the Library specifies
a version number of this License which applies to it and
"any later version", you have the option of following the
terms and conditions either of that version or of any later
version published by the Free Software Foundation. If
the Library does not specify a license version number,
you may choose any version ever published by the Free
Software Foundation.

14. If you wish to incorporate parts of the Library into
other free programs whose distribution conditions are
incompatible with these, write to the author to ask for
permission. For software which is copyrighted by the
Free Software Foundation, write to the Free Software



Foundation; we sometimes make exceptions for this. Our
decision will be guided by the two goals of preserving the
free status of all derivatives of our free software and of
promoting the sharing and reuse of software generally.

NO WARRANTY

15. BECAUSE THE LIBRARY IS LICENSED FREE OF
CHARGE, THERE IS NO WARRANTY FOR THE LIBRARY,
TO THE EXTENT PERMITTED BY APPLICABLE LAW.
EXCEPT WHEN OTHERWISE STATED IN WRITING
THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES
PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF
ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING,
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE. THE ENTIRE RISK AS TO THE QUALITY
AND PERFORMANCE OF THE LIBRARY IS WITH YOU.
SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME
THE COST OF ALL NECESSARY SERVICING, REPAIR OR
CORRECTION.

16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE
LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT
HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY
AND/OR REDISTRIBUTE THE LIBRARY AS PERMITTED
ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING
ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUEN-
TIAL DAMAGES ARISING OUT OF THE USE OR INABILITY
TO USE THE LIBRARY (INCLUDING BUT NOT LIMITED TO
LOSS OF DATA OR DATA BEING RENDERED INACCURATE
OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR
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A FAILURE OF THE LIBRARY TO OPERATE WITH ANY
OTHER SOFTWARE), EVEN IF SUCH HOLDER OR OTHER
PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES.

Labjack exodriver
AlL exodriver library and example source code are
licensed under MIT X11.

Copyright (c) 2009 LabJack Corporation <support@
labjack.com>

Permission is hereby granted, free of charge, to any
person obtaining a copy of this software and associated
documentation files (the "Software"), to deal in the
Software without restriction, including without limitation
the rightsto use, copy, modify, merge, publish, distribute,
sublicense, and/or sell copies of the Software, and to
permit persons to whom the Software is furnished to do
S0, subject to the following conditions:

The above copyright notice and this permission notice
shall be included in all copies or substantial portions of
the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT
WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE AND NONINFRINGEMENT. IN NO EVENT
SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE
LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABIL-
[TY, WHETHER IN AN ACTION OF CONTRACT, TORT OR

OTHERWISE, ARISING FROM, OUT OF OR IN CONNEC-
TION WITH THE SOFTWARE OR THE USE OR OTHER
DEALINGS IN THE SOFTWARE.

# CocoaAsyncSocket
This class is in the public domain.

Originally created by Robbie Hanson in Q3 2010.
Updated and maintained by Deusty LLC and the Apple
development community.

# Quesa

Quesa is distributed under the BSD License and is
Copyright © 1999-2005, Quesa Developers. For some
background information about this license, you may wish
to visit this web site.

The BSD license allows you to link Quesa into your
software, as either a static or dynamic library, with no
obligation. You may not redistribute Quesa without
preserving its copyright statement.

Although not a requirement, we would prefer that any
local customisations you make to Quesa are made
available to the project. This ensures that your changes
are carried forward into future releases of Quesa, and will
be maintained as part of normal development.

Redistribution and use in source and binary forms, with
or without modification, are permitted provided that the
following conditions are met:

- Redistributions of source code must retain the above
copyright notice, this list of conditions and the following



disclaimer.

- Redistributions in binary form must reproduce the
above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other
materials provided with the distribution.

- Neither the name of Quesa nor the names of its
contributors may be used to endorse or promote products
derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT
HOLDERS AND CONTRIBUTORS “AS IS" AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING,

BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL

THE COPYRIGHT OWNER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA,
OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
OF THE POSSIBILITY OF SUCH DAMAGE.

MNI 152 Average Brain (used in MNI-based projects)

Copyright (C) 1993-2009 Louis Collins, McConnell Brain
Imaging Centre, Montreal Neurological Institute, McGill
University. Permission to use, copy, modify, and distribute
this software and its documentation for any purpose and
without fee is hereby granted, provided that the above
copyright notice appear in all copies. The authors and
McGill University make no representations about the
suitability of this software for any purpose. It is provided
“as is" without express or implied warranty. The authors
are not responsible for any data loss, equipment damage,
property L0ss, or injury to subjects or patients resulting
from the use or misuse of this software package.

Warnings and Cautions

Always connect the power cable to the Polaris optical
position sensor while its power switch is OFF (or in the
case of the Vicra, with the power cable un-plugged).
Failure to do so may cause serious damage to the Polaris

camera.

Change Log

Note: the project file format has changed (if migrating

from 2.4 or earlier). Brainsight 2.5.x can open documents
created by older versions of Brainsight, but older versions
of Brainsight cannot open documents created by Brainsight
2.5.x.

hanges in version 2.5.11 (since 2.5.10): (2026-02-06)

* Fixed a bug where speech recognition did not work

on macOS 26 Tahoe.

e Improved the network server feature to provide
more information related to the currently selected
target. A new packet named request:get-current-
target-in-session’ can be used to get the current
target information at any time, and the existing
‘response:create-sample' and ‘response:list-session-
targets' packets were updated to also include
information about the current target.

e Fixed a bug where if an inline, inline 90, or perpen-
dicular view was first panned and then zoomed,
portions of the crosshairs were drawn in the wrong
place.

e Fixed a bug where the (subtle) direction indication in
the disc shape for targets was rotated 90 degrees.

 Fixed miscellaneous bugs.
Changes in version 2.5.10 (since 2.5.9): (2025-11-27)

» Fixed a bug where invoking BabelBrain to compute a
TMS simulation would fail if the anatomical NIfTI file
did not contain a gform.

* Added a new button to attempt to clear error condi-
tions reported by the Vet Robot. This is mostly to use
in response to the ‘critical motion error', should it
oceur.

e Improved error messages when the Vet Robot
reports an error.

* Made the green dots representing Polaris tools in



2D views a little bit bigger, thus easier to see from Changes in version 2.5.8 (since 2.5.7): (2025-03-28) Changes in version 2.5.6 (since 2.5.5): (2025-01-24)

farther away. o Fixed a bug in the response:select-target-  Brainsight can now act as a TCP/IP network server,

* Fixed a rare bug where 2D and 3D MPR slices could

sometimes appear blank. This only happened with
certain datasets with particular spacing.

Fixed a cosmetic bug where the NIRS wavelength
selection buttons were still visible even if the legend
was collapsed.

in-session’, response:list-session-targets’,
‘response:create-sample’, 'stream:sample-creation’,
and ‘stream:sample-emg' packets where the
‘coordinate-system' field behaved as intended, but
the ‘position’ field was always in Brainsight coordi-
nates instead of the indicated coordinate system.

and accept connections from one or more client
applications. Clients can request that Brainsight
perform certain actions, and Brainsight can inform
clients when certain events occur. We provide
documentation for the network communication
protocol and sample Python code. (This feature
requires at least macOS 10.14, and 10.15 for full

 Fixed miscellaneous bugs.

Changes in version 2.5.7 (since 2.5.6): (2025-02-26)

* Fixed miscellaneous bugs.

Changes in version 2.5.9 (since 2.5.8): (2025-07-04)

functionality.)

e Oblique images (inline, inline 90, and perpendicular)
* Fixed a bug in the ‘create-target-at-location’ packet

* Various text fields (particularly those related to

coordinates or matrices) now allow entering more
decimal digits.

Exported Brainsight .txt files (from Review window, or
file streaming feature) now use many more decimal
digits, for more exact results.

When invoking SimNIBS, a custom coil file can now
be specified (instead of only being able to choose
from a fixed popup List).

Improved Vet Robot stereo calibration results when
using 50 mm lenses.

Improved Vet Robot tool calibration quality,
especially for unusual tool shapes and orientations.

When creating Vet Robot tool calibrations, the user
interface now gives more information on the quality
of the calibration.

Fixed miscellaneous bugs.
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in the network protocol where the reported index
path of the created target would (usually) be incor-
rect if there were any folders amongst the session’s
targets.

Changed the 'create-target-at-location' packet in
the network protocol to allow the target position
to be unspecified, in which case the target will be
positioned at the current crosshairs position in the
Session Perform window.

When exporting curvilinear reconstructions to a file,
they are now always coloured using the anatomi-
cal's voxels. For curvilinears created from ROI, this

is a bug fix because previously they weren't being
coloured at all. For curvilinears from overlays, this is
a behaviour change as they were previously coloured
from the overlay they were created from.

 Fixed miscellaneous bugs.

use a better interpolation algorithm and thus now
appear less grainy.

e Fixed a bug where long EMG channel names (from
NEURO PRAX) were sometimes truncated in the
legend.

e Improved error messages when connection to a
network-based Polaris fails.

 Fixed miscellaneous bugs.

Changes in version 2.5.5 (since 2.5.4): (2024-11-22)

* Made substantial improvements to Vet Robot tool
calibration. The workflow is mostly the same except
that you no longer need to identify the tool tip and
shaft in both cameras simultaneously, you can
instead do so in one camera at a time, which is
helpful as the camera field of view is small and it
can be hard to position a tool to be visible in both
simultaneously. The algorithm that calculates the



tool calibration is also much improved, giving more
accurate tool calibrations.

Improved Vet Robot tool-relative movement user
interface to be more intuitive, and consistently move
and rotate the tool around its axes: injection/retrac-
tion, Left/right, forward/backward. Previously, the
behaviour was not predictable.

Vet Robot target reachability checks now have the
option of checking that not only is the target itself
reachable, but that a few millimetres deeper is also
reachable. A new textfield in the Perform window
allows setting this amount.

Improved Vet Robot stereo calibration for small
animal systems, to better cover the cameras' field of
View.

Fixed a rare bug where Vet Robot stereo calibration
could get stuck in an infinite Loop.

When importing targets from a text file, if the
coordinate system name is set to “Relative", the
positions in the file can be interpreted as relative to
another (already-existing) target.

Fixed a bug where projects based on a SImNIBS
.gmsh file could get the NIfTI sform and gform
confused and result in an error message when
invoking BabelBrain to perform a TMS simulation.

Fixed a bug where Polaris tool tracking could
sometimes show the subject tracker move with
respect to the subject’s head. This was merely a

visual glitch, and did not affect correctness.

Improved performance working with many targets
(example: big grids).

Improved performance working with many
electrodes (example: big EEG/NIRS caps).

Improved performance opening .dxf files.

The Polaris firmware version number is now shown
in the Polaris Configuration window.

In waveform views, when in staggered mode, you can
now click a waveform to get a tooltip showing the
channel name.

Fixed a crash opening corrupt project files.

Fixed a bug where recalibrating a NIRS block would
program an incorrect version number into the
block's memory.

Fixed a bug where the bullseye view would show a
TMS coil in the background when a fUS tool was
being used.

Fixed a bug where the Vet Robot firmware version
number would sometimes be displayed incorrectly.

Fixed a bug where changing a sample's EMG peak-
to-peak value or its “contribute” checkbox would fail
to refresh the sample's colour in 2D and 3D views.

Fixed a bug where changing the time index in a 4D
overlay would sometimes fail to refresh 2D and 3D
Views.

Fixed a bug where, if there were multiple surface

reconstructions, changing the colour or other
attribute of one would sometimes fail to refresh 3D
views.

Fixed a bug where, if there were multiple curvilinear
reconstructions, changing the peel depth of one
would sometimes fail to refresh 3D views.

Fixed miscellaneous bugs. Changes in version 2.5.4 (since
2.5.3): (2024-06-26)

Moved some user interface controls from the bottom
to the top of the window, namely the 3D Crosshairs
and Driver popup buttons. This gives more vertical
space for images and makes the contents of the
popup menu less likely to overflow.

Added a new option in the Trigger Options window

to allow creating samples even when the relevant
Polaris tools are not visible (by default samples
cannot be created when, for example, the coil tracker
is not visible.)

Now default to looking for SImNIBS 4.1 (newest at
time of writing), instead of 4.0. If you have an older
(or newer) version, adjust the path in Brainsight >
Settings.

Added a fourth set of tool-relative Vet Robot
movement controls that only have buttons to inject
and retract the tool. The controls that allow the
more dangerous tool-relative rotations are now
separated in a different pane.

No longer allow Vet Robot to move to a marker-type



target, only to trajectory-type targets. This is a safety
precaution because, although markers technically
have an orientation, it's not displayed, and so the
robot risks moving in an unexpected direction.

Fixed a bug where Vet Robot subject registration
would fail if the skull reconstruction was not
watertight and consisted of several disjoint pieces
and one of the initial registration landmarks was
touching a secondary piece.

For Vet Robot sessions, the default threshold range
in the Validation step was tightened from 0.5 to
0.3 mm, reflecting recent improvements in system
accuracy.

Made various improvements for Axilum Robot /
Cobot support:

* An error message is now shown if the Cobot is not
in MCP (manual control panel) mode.

» Added functionality to switch Cobot sides.

* The force sensor check procedure must now be
redone if the coil is changed.

* Coil names are now partly anonymized, to no
longer reveal if a sham coil is being used (to help
with blind studies).

» Extended the range of the contact sensor sensitiv-
ity.

The Polaris Lyra is now configured to track at 30 Hz

instead of 20 Hz.
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* Fixed a bug where a bumps to a Polaris were not
reported.

 Fixed a bug that could result in a failure to read
some valid NIfTI files, for example those generated
by BabelBrain.

* Fixed a bug where vector field arrows (for TMS
simulation for example) sometimes did not display
when then should have.

* Fixed a bug where 4D datasets with exactly 4 time
components would be interpreted and drawn as
vector fields.

» Added a new fUS transducer option for 3D Cross-
hairs shape.

¢ Added a new button next to the scene selection
popup menu to quickly customize a view.

e ATMS coil is no longer shown in bullseye views
when the selected tool calibration is fUS-type.

* Creating a surface/skin reconstruction is now about
25% faster.

* Creating a curvilinear reconstruction is now about
35% faster.

 Fixed various crashes that could occur opening
corrupt files.

 Fixed miscellaneous bugs.

Changes in version 2.5.3 (since 2.5.2): (2024-03-01)

* Brainsight can now simulate the acoustic effect of

transcranial focused ultrasound (fUS) at a target
location. It does this by interacting with BabelBrain,
a third party software that must be installed
separately. The Targets window now allows invoking
BabelBrain, wherein simulation parameters can be
set. The resulting simulation appears overlaid in
2D and 3D images, and can be customized from the
Inspector window.

When writing to our .txt file formats, we now use
slightly different coordinate system names for
NIfTI files, which may require updating code that
reads these files. The coordinate system name now
includes whether it's from the file's sform or gform.
So, for example, where we used to use a string

like "NIfTI:Scanner” we now use “NIfTI:Q:Scanner".
For this reason, exported .txt files increased from
version 13 to 14, and .txt files created by streaming
increased from version 6 to 7.

Improved performance when creating hundreds of
samples. There should be noticeably less latency
between the trigger that creates a sample and its
appearance in the application.

Substantially improved accuracy of Vet Robot subject
registration, thus improving accuracy results overall.

Fixed a bug, introduced only in 2.5.2, where selecting
two or more samples was not showing the average
waveform for EEG and NIRS views (but was for EMG
views).



Fixed a bug where EMG waveform views sometimes
did not show the visual indication (crosshatching)
of when a waveform has exceeded the EMG pod
device's maximum range of 2.25 mV.

Fixed a bug in EMG views where the line indicating
the EMG latency would sometimes not redraw after
the time range was changed (with the green vertical
bars).

Fixed a bug where electrodes could still be clicked in
3D views, even when all electrodes were hidden.

Fixed miscellaneous bugs.

Changes in version 2.5.2 (since 2.5.1): (Sept. 2023)

Added calculation and display of EMG latency using
the SHTE algorithm (by Soda, Vidakovi¢, Lorincz,
Jerkovi¢, and Vujovic). The Perform and Review
windows now have a new optional table column that
can show the latency for each sample. In addition,
waveform views now draw a vertical line at the
latency time. This line can be dragged to adjust the
automatically computed value if it seems incorrect.
Latency can also be exported to .txt files from the
Review window.

Each reconstruction can now be configured to
participate in overlay blending or not. If the option is
off, overlays will never be blended on that recon-
struction. If the option is on, overlays will be blended
atop that reconstruction, provided the overlay is
enabled in the Inspector window (as usual). This

option is on by default for curvilinear reconstruc-
tions, and off by default for surface reconstructions.

A tool calibration's 4x4 matrix can now be exported
to a MINC xfm text file.

The Vet Robot can now be moved relative to the
currently used tool.

The Session Polaris window now allows selecting the
Polaris, and also has a button in bring up the Polaris
Configuration window.

More windows now have the option of showing the
crosshair's numerical coordinates (at the bottom
right).

Fixed a bug where some projects with corrupt NIRS
data would fail to load.

Fixed a longstanding bug where the brightness/
contrast slider did not work in the Curvilinear From
Overlay and Surface From Overlay windows when an
overlay was used as the source of the reconstruction.

Fixed a bug where Brainsight would not automati-
cally connect to a Polaris, even if it was detected.

Fixed a bug where some image views would stop
drawing after Brainsight was running in the
background.

Fixed a crash creating motor maps on old Macs with
Nvidia GPUs .

e Improved performance creating motor maps on
Macs with Apple Silicon processors.

Fixed several crashes that could occur when opening
corrupt files of various formats.

Fixed miscellaneous bugs.

Changes in version 2.5.1 (since 2.5): (2023-06-27)

Fixed a crash in the Tool Calibrations window when
using a TTL trigger to start the calibration proce-
dure.

There is now a user-resizable box in the ROl window
to constrain the extent of the seed flood fill.

There is a new disc shape option for targets and
samples.

Added support for the new Polaris Lyra® position
Sensor.

Fixed a bug where vector fields from SimNIBS
simulations were sometimes not shown correctly in
the Session Perform and Session Review windows.

Fixed a bug where the Park and Welcome buttons
to move the Axilum robot/cobot were disabled when
they shouldn't have been.

If a sample cannot be created, a brief error message
is now shown.

Improved the robustness of the Vet Robot stereo
calibration procedure.

Fixed an error in the header comments of the
stream-to-file feature.

Fixed a bug where zooming a waveform image view



sometimes did not work.

e Fixed a bug where the time index of 4D datasets was
not shown correctly.

 Fixed miscellaneous bugs.
Changes in version 2.5.0 (since 2.4.11): (2022-03-24)

e Note: macOS 10.13 High Sierra is now the minimum
requirement, increased from macOS 10.11 EL
Capitan in Brainsight 2.4. For a free update, visit
https://support.apple.com/macos/upgrade. Contact
us if you need to upgrade your Mac hardware.

e Brainsight can now simulate the induced electric
fleld due to a TMS stimulation at a target location. It
does this by interacting with SImNIBS, a third party
software that must also be installed. The Targets
window now allows associating a TMS coil model
and stimulation strength with each target. The
resulting simulation appears overlaid in 2D and 3D
images, and can be customized from the Inspector
window.

¢ 3D reconstructions (Like the skin reconstruction) are
now coloured by blending any enabled overlays atop
the reconstruction's own colour.

 QOverlays now support time series data (though only
from NIfTI and MINC2 files, not other formats). The
Overlays window and Inspector window now have a
new slider to choose the time offset.

 \ery large datasets (with more than 2731 voxels)
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can now be used.

* Made various accuracy improvements to Vet Robot
stereo calibration and subject registration, resulting
in more accurate targeting during surgery.

* In the Session Perform window, creating new
samples is now disallowed if the relevant Polaris
tools are not visible.

* Inthe Session Perform window, the ‘'stream to file'
feature now includes EMG waveform data and the
coordinate system for selected targets and created
samples.

* In the Session Perform window, the ‘Sample Now'
button is now disabled if the required tools are not
visible to the Polaris camera.

» When working with the Axilum robot/cobot, a
new ‘scalp offset’ distance can be specified to keep
the TMS coil a few millimetres above the scalp to
account for the thickness of an EEG cap for example.

e EMG waveform views now visually indicate when
a waveform has exceeded the EMG pod device's
maximum range of 2.25 mV.

» Added support for the Cornell University (Johnson,
Philippa J; Barry, Erica F) canine atlas.

e Fixed various bugs with some DICOM datasets, where
images would appear split in half, have gaps, or have
missing slices.

* Fixed a longstanding bug where reconstructions

based on ROIs would claim that re-computation
was necessary, even though the ROl hadn't changed.
(This was partly fixed in 2.4, but still occurred for
re-opened projects.)

ROIs can now be created by importing from a
medical image file (DICOM, NIfTI, MINC, etc.).

Fixed a bug in the ROl window where the pencil and
eraser tools would not work correctly at the edge of
view, especially when moving the mouse quickly.

NIRS waveforms can be imported from a .nirs file,
thus allowing importing data from other manufac-
turers' NIRS devices.

Fixed a bug (introduced in Brainsight 2.4.11) where
the SD.SrcPos and SD.SrcPos3D fields in exported
.nirs files were swapped.

Fixed a bug (introduced in Brainsight 2.4.5) where
the SD.SrcPos field in exported .nirs files were in
decimetres instead of centimetres. (The SD.SrcPos3D
field was exported correctly in millimetres though.)

Assembly Lists and Cap Layouts can now be created
by importing from a .nirs file.

Calibrating a TMS coil or other tool now allows for
the tool tracker and calibration tracker to move
together (relative to the camera), instead of failing if
either tool moved relative to the camera.

Polaris tool visibility status now uses a larger
coloured area, making it more visible from father
away.



The enabled/disabled state of Polaris tools in the
Polaris Configuration window are now remembered
across quit/relaunch.

Landmarks, targets, electrodes, and samples can
now be clicked in 3D image views to select the
corresponding item in the related table view.

Targets can now be exported to a text file from the
Targets window (export was previously possible, but
only from the Session Review window).

In the Targets window, if a reconstruction is chosen
in the 'optimize traj. to' popup menu, clicking in 2D
views no longer reorients crosshairs.

Exporting curvilinear reconstructions in the PLY
format now includes the voxel values in greyscale,
whereas previously no colour was exported, only the
shape.

When exporting reconstructions as STL, VTK, and
PLY you can now choose between the ASCIl and
binary variants of these file formats.

* When importing a reconstruction from file, the

The crosshairs offset slider now allows a large
range.

When opening a project file, if there are referenced
external files (datasets, CAD files) that can't be
found, the dialog that asks to find them now (by
default) disables files with different names, thus
making it much easier to find the correct file.

A new preference allows changing the colours of
the bullseye views, especially useful for colour blind
users.

A new preference allows changing the font size of
the bullseye views.

A new preference allows specifying default EMG
baseline and trial durations that will be used when
creating new sessions.

Native support for Apple Silicon processors.

Improved support for macOS 11 Big Sur, macOS 12
Monterey, and macOS 13 Ventura.

Various performance improvements:

Creating skin and other surface reconstructions is
faster.

Fixed miscellaneous bugs.

Changes in version 2.4.11 (since 2.4.10): (2022-07-12)

Fixed a longstanding (but rare) crash that occurred
when closing a window that contains image views.

Fixed a bug where the name of proximity detectors
was not exported correctly in .nirs files.

Fixed a bug where macOS could warn of an expired
certificate by updating our Developer ID code signing
certificate.

Updated support for newest iterations of our Vet
Robot hardware, notably for the NHP 45 degree
inclination setup.

Fixed a bug where the date/time metadata from
MINC1 files would sometimes not be shown.

Improved error checking when communicating with
a Magstim TMS stimulator.

Fixed miscellaneous bugs.

) ) Exporting DXF files is now much faster, especially for

object can now be placed relative to a chosen target . Changes in version 2.4.10 (since 2.4.9): (2022-03-01)
_ large reconstructions.

(useful for placing chambers for example).

« Updating an atlas space template overlay is now e Fixed a crash that could occur when computing the

* The crosshairs in 2D image views now have a small
much faster.

distance from a point to a surface, which occurs in

gap in the middle so as not to obscure the very thing several places, Like the Targets and Session windows.

being targeted. * Reorienting the anatomical dataset is now much

e Fixed a bug where importing a dxf file resulted in the
colours being read incorrectly.

. ' faster.
* Wherever 4x4 matrices can be imported from a file,

a new file format is now supported namely plain text » Creating curvilinear reconstructions is now much

Ales with 16 ! i faster * Updated support for newest iterations of our Vet
es wit numbers within. :
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Robot hardware, notably the 50 mm Llens.

Fixed a small inaccuracy in the visual positioning of
an LCT (large coil tracker) object in 3D images. (This
did not affect the actual measured position of the
tracker.)

Fixed miscellaneous bugs.

Changes in version 2.4.9 (since 2.4.8): (2021-10-18)

There is a new checkbox in the Session > I0Box
step to indicate if you want to save or discard the
Live/full EMG waveform. It's usually not necessary
to save it, because samples contain a copy of the
EMG waveform just before and after the TMS pulse,
and as it can grow very large it slows performance,
especially saving and opening project files.

Resuming a session no longer overwrites any exist-
ing live/full EMG waveform, instead it now appends
new data to the end.

Fixed a bug where the EMG pod was sometimes not
detected between closing and resuming sessions or
when disconnecting and reconnecting its USB cable.

Fixed a bug where exporting .nirs files would fail if
the project did not contain any NIRS Aux data.

When stopping an Axilum session, we now perform
an extra movement to make sure the robot arm
stays in the working space.

Fixed miscellaneous bugs.

Changes in version 2.4.8 (since 2.4.7): (2021-06-25)
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* The Polaris Configuration window now has a new
popup menu where you can choose which Polaris
device to use. This is especially useful for network-
based Polaris cameras, of which you may have
several on your network.

 Fixed a bug where the application would sometimes
become unresponsive when communicating with a
Polaris Vega.

* The ‘extended pyramid’ volume shape supported
by some Polaris Spectra and Vega cameras is now
supported and will be used automatically if avail-
able.

* Fixed a bug where the NIRS Configuration window
would indicate a firmware update was available
when in fact no update was available.

* The Vet Robot stereo calibration procedure was
improved to capture slightly more points.

* The 'Mini TMS Coil' 3D crosshairs shape now has a
slightly longer shaft.

 Fixed miscellaneous bugs.

Changes in version 2.4.7 (since 2.4.6): (2020-12-23)

» Added support for the new macOS 11 Big Sur,
notably communication with Polaris cameras now
works.

e Numerous changes to Axilum Robotics support:

* A new feature in the Session Perform window now
allows visiting a sequence of targets, pausing for

a specified number of TMS pulses, with a specified
duration between them, and then moving to the next
target.

The "Align” buttons have changed behaviour in
several notable ways:

They now only act on the sole selected target. They
no longer can be used for a folder of targets.

They now move in whatever path is necessary to
ultimately reach the target and always descend the
coil to contact the skin. (Previously, there were two
behaviours: if the coil was already on the skin, they
would only try to slide along the skin, and if the
target was too far, no movement would result at all.
If the coil was in orbit, they would align above the
new target, but not descend to the skin.)

To signal this behaviour change, the buttons have
been renamed from "Align" to "Move".

The "Stop" button now moves the robot arm away
from the subject's head, if it was in contact.

Closing a session window now warns if you are
connected to a robot, instead of just closing.

Added tooltips to most of the Axilum-related
buttons, to help understand what they each do.

Added a second kind of subject registration for Vet
Robot sessions. Instead of using two landmarks
and the laser grid, you can now use three or more
landmarks for a classic rigid body registration.
This requires being able to accurately locate such



landmarks both on the anatomical scan and in the
camera images.

The Targets window now allows importing target
names and coordinates from a text file.

Fixed a bug where older documents sometimes
failed to convert to the newest format with the
message “crosshairs is a required value”.

Fixed a bug where the "switch" input on the 10Box
was triggering from high to low voltage instead of
Llow to high voltage, resulting in presses of the foot
switch being recognised upon releasing the pedal
instead of upon depressing the pedal.

Fixed a crash that could occur choosing some
colours in the ROl window.

Fixed a crash importing some SPM12 .mat files.

Fixed a crash on macOS 10.14 and older that could
occur if a TTL trigger was received while editing the
peak-to-peak value in the Inspector > Motor Maps
window.

Fixed various bugs with macOS dark mode, where
some things were drawn with incorrect or illegible
colours.

Fixed a bug where landmark/electrode names that
contained two parts, like "LA43-LA44", would only
have the first half spoken.

The Session Validation window now allows choosing
the crosshairs shape, Llike most other steps in the

Session window.

Fixed an old bug where the first use of the Apple
Remote after booting the Mac resulted in the first
button press being reacted to twice.

Fixed a bug where the Apple Remote up and down
buttons did not work on macOS 10.13 and newer.

Fixed a bug where the Apple Remote did not work at
all on macOS 10.15 and newer.

Fixed miscellaneous bugs.

Changes in version 2.4.6 (since 2.4.5): (2020-10-21)

The Vet Robot subject registration procedure
no longer requires manually cropping the skull
reconstruction, it is now done automatically.

Vet Robot stereo calibration and subject registration
calculations are now much faster.

Judging the quality of the Vet Robot stereo calibra-
tion procedure is now easier because we now show a
graphical representation of the quality of the results.

SPM12 .mat files can now be loaded everywhere a
4x4 matrix can be loaded from file; notably this can
be used for atlas space registrations.

When exporting .txt files from the Session Review
window, the option to snap samples to a reconstruc-
tion previously only snapped inwards but now it

will now snap in either direction, thus working for
samples created inside the head (due to use of
‘crosshairs offset’ slider for example).

Fixed a bug where the NEURO PRAX impedance
check failed to update the electrode colours.

Fixed miscellaneous bugs.

Changes in version 2.4.5 (since 2.4.4): (2020-06-29)

Fixed a crash that could occur opening projects
created by older versions of Brainsight, where the
project once contained NIRS data that was subse-
quently deleted.

Exporting .nirs files can now include the results of
any analysis that was performed.

Exported .nirs files now contain metadata indicating
that centimetres are used for positional information.
This will prevent Homer2 from having to ask.

The Vet Robot Configuration window no longer
shows a ring around the flange in the camera views
because the concept does not apply to the newest
hardware.

The newest version of the FTDI device driver (2.4.4)
is now installed (this controls communication with
RS-232 serial devices like the Polaris camera and

Magstim TMS stimulator).

Improved compatibility with macOS 10.15 Catalina
by supporting ‘notarization'. This eliminates the
“Brainsight can't be opened because Apple cannot
check it for malicious software" error message.

Fixed miscellaneous bugs.

Changes in version 2.4.4 (since 2.4.3): (2020-04-09)
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* Fixed a bug where the newly-released macOS
Catalina 10.15.4, but not earlier versions, caused
Brainsight to crash.

e Added support for the Logothetis / Saleem D99
Macaque atlas. (You also need to install Support
Files Vet 1.3.)

 Fixed miscellaneous bugs.
Changes in version 2.4.3 (since 2.4.2): (2020-01-23)

* Reverted the updated FTDI device driver that was
included in Brainsight 2.4.2 because it does not
work correctly on newer versions of macOS. Now
the same version that Brainsight 2.4.1 and earlier
included is once again included.

Changes in version 2.4.2 (since 2.4.1): (2020-01-20)

e When performing coil (or tool) calibrations, relaxed
the check for how much the calibration block and
tool tracker moved (it became too strict in Brainsight
2.4, resulting in calibrations sometimes failing even
when the trackers were reasonably still).

* When using the ‘target positioning tool targets are
once again drawn semi-transparent (this broke in
Brainsight 2.3.4).

e The driver for the KeySpan USB-serial adapter is
no longer installed because it does not work well
with recent versions of macQOS. If you have the driver
already installed (from a previous version of Brain-
sight), it won't be uninstalled, so you can continue to
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use it, however, we recommend contacting us for a
free replacement.

* The newest version of the FTDI device driver is now
installed (this controls communication with RS-232
serial devices like the Polaris camera and Magstim
TMS stimulator).

 Fixed miscellaneous bugs.
Changes in version 2.4.1 (since 2.4): (2019-12-23)

* Improved compatibility with macOS 10.15 Catalina
by supporting ‘notarization'. This eliminates the
“Brainsight can't be opened because Apple cannot
check it for malicious software"” error message.

* Fixed a bug where some Analog Receivers / EMG
Pods were not detected. We discovered that a
small number of such devices were not correctly
programmed by us. If this is the case for your device,
when you open a session window you will receive a
message explaining the situation with a button to
reprogram the device correctly.

 Fixed miscellaneous bugs.
Changes in version 2.4 (since 2.3.12): (2019-12-06)

e Important: Brainsight 2.4 now requires Mac 0S X
10.11 (EL Capitan) or newer. If your Mac is reason-
ably recent (~2008 or newer), you only need to
update the OS, see Apple's website. If your Mac is
older, it's possible you might not be able to update
your OS, in which case contact Rogue Research for

other upgrade options.

Note: the project file format has changed. Brainsight
2.4 can open documents created by older versions of
Brainsight, but older versions of Brainsight cannot
open documents created by Brainsight 2.4.

Added various Homer2-equivalent NIRS analysis
features:

 Support for multiple conditions.
* Onset creation:

From existing samples already
created in the session window.

By pulse detection in auxiliary data
(low to high, high to low, threshold with dead
time).

By manual time entry of onsets.

 Optical density calculation and visualization,
both unfiltered and with low-pass, high-pass, or
band-pass filtering.

e Concentration calculation and visualization of
HbO, HbR, and HbT for:

Whole recording.
Block averages, with optional error bars.

Fast and easy recalculation when adding/
removing onsets, changing baseline param
eters, etc.

 Fasy selection and visualization of NIRS data:



Clicking on 3D representation of optodes on
subject head shows corresponding waveform
data.

Clicking on waveform label selects corre
sponding optodes in 3D image views.

e Made many improvements to Vet Robot support:

* Significantly improved the overall accuracy of the
system.
 Region painting of the skull in sessions is now

both saved in the project and undoable.

* In the Session window, camera image views can
now be zoomed and panned Like other views.

¢ /et Robot sessions can now be cloned.

* Made many improvements to Axilum Robotics
support:

» Added support for the Axilum Robotics
TMS-Cobot.

e The skin reconstruction is now shown in the
Session>Axilum step.

 Greatly improved performance of projecting
targets to the skin reconstruction.

» Added support for the Polaris Vega® position sensor.

e The Session > Polaris window now shows the exact
field of view shape for the Polaris Krios and Polaris
Spectra, where previously it was showing the shapes
of their respective predecessor models.

Instead of a generic 'diagnostic pending' message,
more exact messages are provided for various
Polaris error conditions (ex: bump detected, battery
fault, temperature high, etc.).

If your Polaris' bump detector is triggered, Brainsight
itself can now clear the error, obviating the need for
the NDI Toolbox application.

If the Polaris reports a dead battery or a tempera-
ture error, tool tracking will now work regardless.
(You should still schedule a repair of your Polaris, as
tracking accuracy may be reduced.)

In the Session>Perform window, changing the active
coil/tool calibration (from the ‘driver’ popup menu)
now disables/enables the corresponding Polaris
tools. For example, changing from a calibration that
uses CT-123 to one that uses CT-456 will stop the
camera from tracking the former and start tracking
the latter.

Changed the legend in NIRS views to have a global
wavelength toggle button, that applies to all pairs,
instead of per-pair control of wavelength visibility.

In 3D image views, clicking a tube that represents a

NIRS pair now selects the corresponding channel in
the legend of waveform views.

Selecting a NIRS channel in the legend table or
rectangles view now selects the corresponding NIRS
tube in 3D image views.

Selecting an EEG/EMG/ECG/EQG channel in

the legend table now selects the corresponding
electrode in 2D/3D image views.

In sample-based waveform views, when selecting
multiple samples, error bars can now optionally be
shown for averages (for EEG/EMG/ECG/EOG and
NIRS data).

In sample-based waveform views, clicking a
waveform now shows a tooltip that indicates which
waveform the sample is from or if it is an averaged
waveform.

Waveform views now default to showing a better
range of data in both the x and y axes.

Creating an Assembly List from a .txt file now gives
the option of linking it to an existing Cap Layout or
creating a new Cap Layout.

When creating a reconstruction, you can now
choose to keep only the largest piece (as opposed to
previously, where all pieces were kept). This can be
useful for skin reconstructions, where you don't want
artifacts.

Overlays can now be configured to colour values
above/below the threshold to be either transparent
(as previously) or to repeat the hi/low colour of the
lookup table.

When exporting samples into DICOM files, you can
now optionally project the sample along its axis to
the intersection of a chosen reconstruction (ex: the
brain surface).
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The ‘Manual (AC-PC+scale)’ atlas space window now
shows resizable lines (instead of a box) to scale the
template to the subject head. This better indicates
how it is meant to be used.

Added marmoset, pig, and sheep atlases.

Added much more information to the text file
streaming feature. In addition to raw Polaris tool
locations that it output before, it now logs when:
the selected target changes, a TTL trigger occurs, a
sample is created, the crosshairs move.

Added buttons to the Targets and Session Perform
windows to navigate up/down/left/right on a
rectangular grid.

Added a button to reorient the crosshairs to be
perpendicular to a chosen surface.

AlL threshold sliders now have text fields below them
so that exact ranges can be specified.

Added a new preference to disable sounds played
when creating samples or sampling landmarks.

Partly fixed a longstanding bug where reconstruc-
tions based on ROIs would always claim that
re-computation was necessary, even though the ROI
hadn't changed. (This will still occur for re-opened
projects though.)

Fixed a longstanding but minor bug where the
threshold mask in an ROl window did not exactly
match the effect of flood fill.

i Brainsight WEEE  USER MANUAL V2.5

Fixed a longstanding bug where converting a sample
to a target made all hidden targets become visible.
Now the visibility of targets is unaffected.

In an ROl window, the up and down arrow keys and
up and down mouse wheel now move by exactly one
slice, instead of by the 'slice increment size' of the
Preferences window.

In image views, the name of a landmark/target/
sample can now be shown/hidden using a new
button below the brightness/contrast slider.

Changes to .txt format export:

e The .txt file format has been changed from version
8 to 12 due to some minor changes to the file
format. If you have scripts/code that reads such
files, you may need to adjust them slightly.

e When exporting EMG data, the time range used
for peak-to-peak calculations is now included.

e When exporting TMS stimulation information,
the Magstim® BiStim? inter-pulse duration and
second power are now included.

Fixed a bug where Magstim® BiStim? inter-pulse
duration confused ps versus ms.

Trackpad gestures are now supported in image
views. You can now zoom with a two-finger-pinch
gesture, and rotate with a two-finger-rotate gesture.

Greatly improved performance snapping targets,
grids, and electrodes to a reconstruction surface.

Improved performance working with the Polaris.

Improved support for non-admin macOS accounts.
An admin account is still needed to install, but
non-admin users can now run Brainsight.

Improved support for macOS 10.14 Mojave and
10.15 Catalina, particularly their ‘dark mode' feature.

Fixed miscellaneous bugs.



Welcome to Brainsight NIRS! Brainsight NIRS
represents the fruition of over a decade of effort

in design and development in both hardware and
software. Brainsight NIRS builds on our experience
in neuronavigation and multimodality acquisition
as well as feedback from our hundreds of custom-
ers. We hope that you find this new generation of
neuronavigation based image acquisition tools
useful, and as always, we value your feedback.

Chapter 1: Introduction

HOW THIS DOCUMENT IS ORGANIZED

This document is intended to give you all the informa-
tion you need to take advantage of all the features of
Brainsight NIRS. The overall structure is designed to
present the information in the same logical order as you
would need it in the normal use of the system. There are
occasions where some background information that will
be useful throughout the document will be presented.
These will be given in the first place where they will be
needed, and usually highlighted by being in a grey box.

Document formatting

In numerous places, you will be instructed to select menu
items, or click on buttons. Rather than describing these
in a "long winded " way (e.g. “select Open... from the

File menu", or “click on the OK button"), a more concise
shorthand will be used. For example, “select Flle->Open"
will be used for menu selection and “click OK" will be
used for button clicks. For popup menu buttons (buttons
that, when clicked, present a short menu list of actions
to pick from), the instruction “click New->Surface” will be
used. The verb click implies that you are asked to click on
a button and the arrow implies that the click will allow
you to select the item from the List.

MULTIMODALITY USE

Brainsight is designed from the start as a multimodal-
ity neuronavigation system. While the focus in this
manual are the features specific to NIRS imaging, you
may intend to use Brainsight to record NIRS along
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with electroencephalography (EEG), or while using a
transcranial magnetic stimulator (TMS), or both. When
relevant, this manual will describe how to perform some
of these together, however it will be assumed that you
have familiarized yourself with the specific functionality
by reading the Brainsight user manual specific to that
functionality (e.g. Brainsight NIBS).

SYSTEM REQUIREMENTS

Brainsight 2.5 requires a recent Macintosh computer with
the following minimum characteristics:

e Mac OS X 10.13 or greater
e Intel or Apple Mx CPU
e 8 GB RAM (16+ recommended)

If you are contemplating a new computer purchase, we
recommend a computer with the latest Apple M-series
CPU at least 32GB RAM to ensure that the computer will
be useful for a long time.

HOW TO GET HELP (or HOW YOU CAN HELP US MAKE
BRAINSIGHT BETTER FOR YOU)

Brainsight 2 was designed and developed using high
standards in product planning, software coding and
testing. It is our expectation that on the whole, the
software will work without major issues, however you
may use Brainsight in ways that we did not foresee, and
encounter new issues. You can provide us with valuable
feedback in the following ways:
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* Automated crash reporting
If Brainsight 2 crashes ("Quit unexpectedly”, or "Quit
while unresponsive”), a message will appear after
the crash to send info to Apple. Please use this,
however only Apple gets that message and is useful
if the crash was caused by the OS. When you restart
Brainsight, a second crash reporter will appear that
allows you to send the report directly to us. The
second reporter will include a screen with an error
message and a record of what the software was
doing when it crashed. Please add a brief description
of what you were doing, and any information that
you think might be helpful to us to reproduce the
event. Finally click on the Send to Rogue Research.
Several team members will receive an e-mail alert
and will act on it quickly. No personal information
(other than the IP address of your computer) is
included, so if you want us to follow-up with you
regarding the crash, please include your name and
e-mail in the comments, or send us an e-mail (so
we know who to contact).

While Brainsight is running, help can be obtained from
the help menu. It contains a link to a PDF version of the
user manual, which is always up to date, and a shortcut
to our support e-mail address.

* e-mail support@rogue-research.com.
As with the crash reporter, several experienced
people get the support e-mail so you should get a
reply as soon as possible.

If you are a Brainsight 1 user, your current version 1.x
software licence key (serial number) will not be able to
enable the functionality of Brainsight 2. Rogue Research
has adopted a new serial number scheme for Brainsight
2. For upgrade information, please contact us at info@
rogue-research.com.

Note: If you are using a beta or a trial version, it will have an
expiry date. After it expires, you will still be able to load projects
and view your data and perform 3D reconstructions, but you
will not be able to perform NIRS sessions. In the case of a beta
version, a newer one will have already been released for you to
download. If it was a trial version, contact us (infor@rogue-
research.com) for upgrade information.

SAFETY

Safety Symbols
The following symbols may be used throughout the user
manual

Attention! This symbol denotes infor-
mation regarding the safe use of the
equipment to prevent injury or damage
the equipment.

Advice. This symbol denotes advice to
obtain the best results using the system.

Consult instructions for use.

| (&)




Do not trash. Dispose of this product
according to the disposal instructions
described in this manual.

The NIRS system includes a key-based
interlock to prevent unauthorized use
of the lasers. Remove the key from the
interlock when not in use.

Intended use

This device is intended for use in teaching and research
applications only. This device is not intended nor
should be used for medical applications. It shall not be
used for any treatment, diagnosis or monitoring on a
patient.

It's the user's responsibility to design and validate
safeness of their stimulation protocols.

The output of the Brainsight fNIRS device with the
705nm and 830nm configuration using flat-lensed
optodes is consistent with type 1M lasers. Do not
attempt to view the output directly from the optode
using optical focusing equipment (e.g. microscope or
additional lenses).

Warnings and Cautions
Follow these warnings and cautions to ensure safe use
and maximize signal quality.

In the case of a damaged optical fiber, do
not touch exposed glass fibers. Doing so
may introduce glass splinters into the skin.

Do not step on the optical fibers. Doing
so may damage the fibers and reduce the
signal quality.

ok

While the Brainsight computer controls
the acquisition settings of the NIRS device,
the acquisition system is autonomous. If
the Brainsight software halts unexpect-
edly during the acquisition, the device is
designed to continue operating until the
planned acquisition completes. The lasers
will remain on as indicated by the laser on
light on the front panel. Touch the “Stop
Lasers" button on the touchscreen to abort
the acquisition if needed.

Do not look directly into a source optode
during operation. Doing so may cause
eye damage. It is recommended to wear
protective glasses if manipulating the

optodes while the lasers are on.
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Chapter 2: Introduction to NIRS Imaging

INTRODUCTION

This chapter is intended for those that are new

to NIRS imaging and/or neuronavigation. The
general concepts of NIRS imaging will be explained
followed by a brief description of the typical steps
on how to perform a NIRS experiment. Each step
will be covered in more detail in subsequent
chapters.

Vicra

Position Sensor

i B NIRS Brainsight
Main Unit Computer

Fig. 2-1

Typical Brainsight NIRS system
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NIRS PRIMER

In NIRS, infrared (IR) light is sent into the head using
small lasers in the NIRS device. The lasers create a high

Fibre

intensity beam (not high enough to be harmful) of two .
J ¢ d (small section shown)

or more distinct wavelengths. This light is channeled Lens
into a fibre optic cable (see Fig. 2-2), which has a small Fig. 2-2
lens on the one end (called an optode, similar to an Close-up of a NIRS optode

electrode for EEG, except it measures optical light instead
of electrical current). That lens is put in contact with the
scalp so the light enters the head (see Fig. 2-3). Some

of it is absorbed by the head (scalp, skull, brain etc...)
and some of it is scattered. One of the materials that
absorb light is the hemoglobin in the blood within the
brain. The amount of oxygenated and de-oxygenated
hemoglobin in the blood will influence the amount of

light absorbed. Changes in the amount of oxygenated

3 Light collected via Detector

and deoxygenated hemoglobin in the blood will thus lead
detector fibre optic cable

to very small changes of light absorbed within the brain.

A second set of optodes and optical fibres are placed

on the head to collect some of that scattered light that

exits the head. The fibres channel that collected light

into sensitive detectors inside the NIRS device and this

signal is digitized for analysis. Mathematical algorithms ,I Light injected via
source fibre optic cable

: 2 Light diffuses inside
head and brain

are applied to process the collected data to calculate the
changes in oxy and deoxy hemoglobin concentration.

These changes can be associated in changes in brain Flg- 2-3
function (as the brain works, it consumes oxygen in the Illustration of how light from the NIRS source optode propa-
blood), so in the end, a map of brain activation can be gates in the head and is collected by the detector optode

created by the NIRS device.
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Multiple sources and detectors are placed close to each
other on the head, usually about 3cm apart (see Fig.
2-4). In most cases, a specific detector optode will collect
light from more than one source. In order to tell them
apart, each source injects the light at a specific frequency
(Fig. 2-5). The signal recorded by each detector will

have a spectrum of all the frequencies associated with
the sources that were close enough to be recorded. The
software then separates each signal, creating a set of
signals that represent the light from each specific source
to each specific detector.

After the NIRS session, the data is analyzed by the
computer software, where the changes in measured
signal strength are examined and converted into changes
in brain activity. The results are displayed on the subject's
MRI'images (or that of a standard brain) for interpreta-
tion and analysis.

Multiple
modulation -
frequencies of
IR light e e mema

injected into head

Fig. 2-5
Illustration of how the injected light is coded (modulated) so it
can be separated out after collection by the detectors.

Fig. 2-4

Illustration of a common 3x3 array of optodes. S indicates
sources and D indicated detectors. The red regions illustrate
the region of the brain that is imaged between each source
and detector pair. Light from each individual source may
travel to multiple detectors, conversely, each detector may
record Light from more than one source. Note the signal
strength will be greater for the source detector pairs that
are closest to each other.

Overlapping light
frequencies picked up
by single detector

—

Different frenquencies
in the same tissue

Computer software
separates unique frequencies
and creates separate data set for
each one
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MAPPING THE DATA TO THE BRAIN

The ultimate goal of NIRS is to measure brain function.
When the data is acquired, it must be associated with

a corresponding region on the brain. Brainsight has
multiple methods of associating each source and detector
with a region of the brain. In short, we include a neuro-
navigation system to localize each optode with respect to
the brain.

INTERPRETING THE NIRS DATA

The NIRS Signal

Interpreting the NIRS signal requires careful consider-
ation and is an active field of research in of itself. The
signal being recorded (refer back to Fig. 2-3) is a sum of
multiple contributions including:

 photons that were scattered/reflected within the
cortex that vary with changes in brain activation as
well as physiology (e.g. pulse)

 photons that were scattered/reflected within the
scalp and CSF that change with physiology and in
some cases due to other factors correlated with the
experimental task (e.g. movement during task)

* outside light (with IR content and high frequency
flicker)

* Noise generated by the electronics of the NIRS
instrument including cross-talk from other optode
signals occurring within the instrument

These signals are converted from light intensity to optical
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density and then converted to relative changes in oxy and
de-oxygenated concentrations.
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NEURONAVIGATION

Neuronavigation (often referred to as frameless
stereotaxy or Image-guided *something®) has it's roots
in modern neurosurgery. It can be described like a GPS
system for the brain. A GPS system uses satellites to

find the GPS unit on the earth. Software in the GPS unit
translates the calculated position that are in latitude and
longitude coordinates to coordinates on a map in the
GPS" memory. The GPS uses this information to display a
representation of the unit on the map. It is assumed that
you are holding the GPS unit since we don't care where
the GPS is unless it is attached to whatever we want to
track (us, our car etc...).

A neuronavigator does the same thing. The satellite is
replaced by a position sensor, usually an optical camera.
The GPS antenna (that receives the satellite signals)

is replaced by a tracker, in our case a small triangular
shaped object with 3 or more reflective spheres on it, or
a hand-held pointer. The map is replaced by anatomical
images (usually MR images) of the subject. The naviga-
tion software communicates with the position sensor to
obtain the location of the pointer or trackers (perhaps
one of them on a NIRS patch and one on the subject)
and uses a registration matrix (obtained by identifying
homologous anatomical landmarks on the images and
the subject) to map the location of the tracked object
from the real world to the image space. Once calculated,
a representation of any tracked object can be displayed
on the images. Points of reference, be they targets for
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Main components of a neuronavigator

imaging or stimulation can be identified in advance
and the navigator can help you get the NIRS patch,
EEG electrode or TMS coil over the target, or record the
location of the NIRS optodes and/or EEG electrodes and
map them to the subject's images.

The steps involved to operate the system can be
separated into two classes: System maintenance/
preparation and subject-specific information entry. The
system specific operations that relate to the software

are accessed by various menu items when running
Brainsight. The subject specific steps are accessed via the
Brainsight project file window.

The overall layout of Brainsight project window is
designed to follow the typical steps involved in preparing
and ultimately performing a NIRS study, each tab along
the top of the window represents one step in the process
of getting ready for or carrying out a NIRS session. The
results of these preparations are stored in a Brainsight
Project file. This file will contain links to the image data
used as well as all the information you've input into the
system. It will also be the repository for all data acquired
during the NIRS session(s) you perform using the project
file.

The remainder of this chapter will introduce each step
and how they are related. Each step will be explained in
detail in the chapters that follow.

Chapter 2 > Overview of Image-guided NIRS



TYPICAL STEPS FOR IMAGE-GUIDED NIRS: SYSTEM
SPECIFIC STEPS

Define your NIRS cap(s)

The optodes used to inject (sources) or collect light
(detectors) must be placed on the head, and held in
close contact to the skin in order to work properly. While
that sounds simple, it is Likely the most challenging and
potentially frustrating part of NIRS. There are a wide
variety of layouts for optodes to image different portions
of the brain. There are a wide variety of approaches and
each of them have their strengths and weaknesses.

When you purchase a Brainsight NIRS system, it will
come with one or more caps and one or more sets of
fibres. For the purposes of this user manual, a cap is
defined as an apparatus that is worn on the head with
the purpose of rigidly holding one or more NIRS optodes
and/or EEG electrodes on the head. The caps may be
similar to EEG caps (where full head coverage is desired)
or smaller patches that are fixed to the head in one

way or another. A cap definition in Brainsight consists
of a name for the cap itself, a list of the names of each
receptacle (referred to simply as holes) onto which
optodes and electrodes may be fixed and optionally, the
location of the holes within the cap in a standardized
coordinate system (e.g. MNI coordinates). Using EEG as
an analogy, a cap might have holes in it that are labeled
according to anatomical locations using a standard grid
system (T1, FP2 etc...). These locations are cap specific
and do not assume anything is attached in any given
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receptacle; it is the Llist of all possible places where an
optode or electrode may be attached.

There are several methods to arrange and hold the
optodes on the head. One of the most common is to
use an EEG-style fabric cap with plastic receptacles for
the optodes. Rogue Research has developed a novel
cap layout where the receptacles are evenly (relatively)
spaced from each other to offer flexibility in generating
good montages. The naming convention of the optode
holders uses an L-R (for left and right side) for the
column of receptacles that are roughly over the motor
cortex to the ear with numbers going from the midline
in the inferior direction (e.g. L1, L2 etc...). Receptacles
anterior to this line are labelled LA (LA11, LA12, LA21,
LA22 etc..) and those posterior are labelled LP (LP11,
LP12, LP21, LP22 etc...). Since the receptacles are
equidistant, any source and detector adjacent to each
other become a potential source-detector pair.

Brainsight contains a software based cap manager, where
your physical caps are defined for use later.

When a cap is to be used, optodes and/or electrodes must
be attached to the cap at one or more of the receptacles.
This list of cap holes and associated optodes is called

a connection list. It defines what specific optode (be it a
detector or source) from the NIRS device is fixed to which
hole on the cap. One can use this List list to physically
insert the optodes into the receptacles in the cap prior

to a scan (and may be stored this way for re-use for
subsequent scans when the configuration does not need

to change). This enables Brainsight to associate the data
acquired by each source-detector pair with a specific
region of the brain. This cap-connection list associa-
tion is called an assembly. A cap may be associated

with multiple connection lists and thus have multiple
assemblies, but a connection List can only be associated
with a single cap. Thus an assembly is a unique pair of a
cap and connection List.

Brainsight includes a software tool to define one or more
caps. The purpose is to be able to quickly assign each
optode to a pre-determined location on the images.

Define a cap assembly

The cap defines the name and location on the head onto
which an optode can be placed. The NIRS system must
know what optode is attached to each specific hole in the
cap. In contrast to each cap hole being associated with a
specific anatomical region, each optode is attached to a
specific channel number on the NIRS module. In order to
associate the recorded NIRS signal to a specific anatomi-
cal region, a connection list must be defined to map the
anatomical location to the NIRS detector channel.

NEURONAVIGATION: HOW MUCH OF IT WILL YOU
USE?

When using Brainsight, you have multiple options in how
much you wish to use the neuronavigation. The main
purposes for neuronavigation are to be able to ensure
that the optodes are placed over the regions you wish

to image and to associate the locations of the optodes
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An ‘assembly list’ is based on a ‘cap layout’ and specifies the connections between the cap holes and the hardware device. Specifically, for EEG, the
association between the cap and the EEG devices' channel number. For NIRS, the association between the cap hole and the block number and

Measurement pairs for “F3 (B2-S1)":

® O O Assembly Lists

source/detector number. Additionally, for NIRS, it describes which source-detector pairs are of interest.

Assembly lists: Connection list:

Name Name Usage Block # Optode #

bly List 1 Fz NIRS ¢ 1 : D6

Cz NIRS ¢ 2 : D6
Pz NIRS ¢ 1 D7
F1 NIRS 7 2 ; D1
F2 NRS 7 1 7 D1
F3 NIRS 7 2 7 s1
F4 NIRS ¢ 1 7 s1
F7 NIRS ¢ 2 : S2
F8 NIRS ¢ 1 7 S2
[ex] NIRS 7 2 ; D2
C4 NRS 7 1 7 D2
T3 NIRS 7 2 7 D3
T4 NRS 71 ;D3
P3 NIRS ¢ 2 v S3
P4 NIRS ¢ 1 : S3
T5 NIRS ¢ 2 v sS4
T6 NIRS ¢ 1 T S4
o1 NIRS 7 2 7 D4
02 NRS 71 7 D4

| Remove || New.. ~| Based on: 10-20 Grid

Fig. 2-9

Assembly list manager

(and associated NIRS data) with the subject's anatomy
(as defined by their MR images). How much of this is
needed (or how accurately you need to record the optode
locations) for your particular application is up to you to
decide. Essentially, there are two decisions to make: First,
are you going to use the subject's MR images, or are you
going to use a model date set (e.g. MNI head)? Second,
are you going to rely on the pre-recorded estimates of the
optode locations (either on the MNI head, or warped to
the subject's head) or will you use the position sensor to
record the optode locations?
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EEG Ch # Use Name

Distance (mm)
& Fz (B1-D6) 54.43

Cz (B2-D6) 82.77

Pz (B1-D7) 124.96

F1 (B2-D1) 44.23

F2 (B1-D1) 89.20

C3 (B2-D2) 48.05

&L

J

O

(] C4((B1-D2) 117.09
] T3(B2-D3) 64.69
(] T4 (B1-D3) 134.85
[ 01(B2-D4) 133.29
[ ] 02(B1-D4) 157.37

The least accurate, but simplest is to use the MNI

head and estimated optode locations. In this case, the
anatomical images are based on a standard brain Like
the ICBM152 average brain or the MNI-based “super”
brain. Both MNI brains are in the same coordinate
system. The average brain is a composite data set taken
from averaging 152 normal subjects. The super brain is
a composite date set of several T1 anatomical scans of
a single individual, warped to the same MNI coordinate
system. Both can be referred to as an MNI brain since
they share the same shape. The average brain gives you
an idea of the relative variability of the different brain

regions (structures that vary a lot are blurrier than ones
that are relatively constant), while the super brain is a
clear, high contrast example of an individual brain in MNI

space. We tend to use the superbrain more often because
it happens to have a better defined skin for the recon-
struction (the top was not clipped). The optodes are on a
cap whose receptacle locations were pre-measured in the
MNI coordinate system. Assuming the cap was correctly
placed, a reasonable estimate of the optode locations is
provided. This may be sufficient for illustration purposes.

The next level up is to use the subject's MR images, but
still rely on the estimated locations of the optodes. This
requires that you first obtain an anatomical MRI data set
of the subject, and that you perform the MNI registration
step (see... ). This allows Brainsight to take the initial
estimate of the optode locations in the MNI coordinate
system and transform them to the subject's native
coordinate system as defined by the subject's MRI. The
accuracy is limited by the assumption that the cap is well
placed on the subject's head and by the accuracy of the
subject->MNI registration.

Finally, the most accurate way to determine the optode
locations on the subject's head is to actually record them
using the position sensor. In this case, you would place
the subject tracker on the head and use the Polaris
camera and traced pointer to record the optode locations
at the start of the NIRS recording session.

TYPICAL PREPARATION STEPS FOR IMAGE-GUIDED



NIRS: SUBJECT SPECIFIC STEPS

Before performing a NIRS acquisition session, a Brain-
sight project file needs to be created and completed. This
is typically done only once for a particular subject and
the project file is recalled for each NIRS session.

Select the Anatomical Data Set

This is a short, simple step. You will select the anatomi-
cal image file(s). Currently, we support DICOM (and
ACR-NEMA), MINC (both MINC1 & MINC2), Analyze 7.5,
NIfTI-1, PAR/REC and BrainVoyager™ anatomical (vmr).

Co-register to the MNI (and Talairach)

Coordinate Space

This step is optional. If your caps included MNI
coordinates defining their locations, then you need

to co-register the individual subject's MR to the MNI
coordinate space. This will allow Brainsight to map the
initial locations of the optodes to the subject specific MRI
coordinate space. You can do this by loading the matrix
from MINC tools (e.g. using mritotal), typing in the matrix
from SPM, or you can perform the registration manually
in Brainsight.

Once the registration is performed, the images will

not change (it is common in fMRI analysis to warp the
individual's MR into MNI space for comparison) as we
remain in "native” space. The transformation between the
native MRl and MNI space (and by extension, Talairach
space) is kept in memory allowing the coordinates of the
cursor to be expressed in native or MNI coordinates.

Select One or More Overlay Data Sets

This step is optional. If you wish ot overlay one or more
data sets (e.g. other MRI scans, or functional data), you
can load them in Brainsight and display them on both
the 2D slices as well as the curvilinear reconstruction
(described below).

Create a Region of Interest Using the

Region Paint Tool

This step is optional. If you wish to highlight a particular
region (e.g. motor cortex), use the region paint tool to
paint the region in the anatomical (or any overlay) data.
The region of interest will be visible in any of the 2D
views, and can be used as the boundary to generate a 3D
representation of it as well (see Perform 3D reconstruc-
tion).

Perform 3D reconstruction(s)

One of the most important features in modern image
display software is the ability to display 3D representa-
tions of your data. This is especially useful in neuro-
navigation where you are required to use the image
display to position a tool in 3D over the subject's head.

Brainsight currently supports two types of reconstruction:

Surfaces based on voxel labelling (either automatically
using intensity thresholding) or manual region painting,
and curvilinear reconstruction.

The first is often referred to as a segmented surface
mesh, or isosurface, where a surface (e.g. skin) is
represented as a series of triangles generated by

segmenting the raw MRI voxels (see Illustration of how
light from the NIRS source optode propagates in the head
and is collected by the detector optodea for an example
of a segmented skin surface) based on a voxel intensity
threshold.

The second reconstruction technique is called curvilinear
reconstruction. This technique was originally developed
for visualization of a class of lesions involved in Epilepsy
called focal cortical dysplasia (see Bastos et. al, Annals of
Neurology, July 1999). The technique also proves useful
for TMS because it allows for detailed viewing of the brain
anatomy within the region of the cortical ribbon that is
thought to be reached by NIRS.

In short, a smooth surface representing the outer shape
of the brain is generated along with a series of concentric
surfaces (like the layers of an onion), and those surfaces
are painted with the intensity values of the voxels that
intersect that surface. By interactively peeling these
surfaces, an excellent appreciation of the anatomy within
the cortical ribbon can be obtained (see Illustration of
how light from the NIRS source optode propagates in the
head and is collected by the detector optodeb).

Select anatomical lLandmarks for registration

As mentioned earlier, co-registering the subject to the
images is performed by identifying homologous points
between the images and subject. The image version of
the landmarks are identified in advance, typically by
clicking on the landmark on the 3D skin and/or the 2D
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MRI slices, and recording the landmark.

Select your target(s)

Targets can be chosen using a variety of methods. The
most straightforward is to visualize the target anatomi-
cally on the image display and record the location. If an
MNI registration was performed, then MNI or Talairach
coordinates can be used. Finally, if functional data is
superimposed, then functional peaks can be used by
clicking on the peaks and dropping a marker.

Targets can be recorded as a simple point (x, y, 7), a
trajectory (which is a point along with an orientation), or
a grid of points for mapping exercises.

PERFORM A NIRS SESSION

Once all the "homework" has been done, a NIRS session
can be performed. The session itself is performed as a
sequence of steps. As with the main window, the steps for
a session are laid out as a sequence of buttons along the
top of the window.

1. Prepare the setup. Before starting the session
(usually before the subject arrives), you need to set
up your equipment. Much of the setup is dependent
on the protocol for the experiment. In the context of
the neuronavigation equipment, the setup involves
making sure the position sensor camera is in a
position to see the trackers on the subject and the
pointer in the various positions required to identify
the landmarks.
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2. Connect the equipment. The NIRS main unit
communicates with the Brainsight computer via
Ethernet network (wired or wireless). The position
sensor camera is connected to the computer

3. Sit the subject, apply the NIRS cap and fix the
subject tracker. Once the apparatus is set, you are
ready to begin the experiment. Apply the cap (with
the optodes in place) on the head. Try to move any
hair that might be between the optode and the skin
out. Place a subject tracker on the subject’s head
using either the head strap or the glasses. Place the
subject in the chair (if you are using a chair).

4. Perform the subject-image registration. Under
the direction of the software, touch the same
landmarks on the subject's head that were identified
on the images. After identifying all the points, verify
the quality of the registration by touching the scalp
at different locations about the head and observe
where they are on the computer screen.

5. Turn on the NIRS and ensure that the optodes are
acquiring data. Now, turn on the lasers and observe
the data as it is being acquired. Make any adjust-
ments to the laser power or detector gain.

Review the acquired data

After the NIRS session, you may want to review the
data acquired. For example, you may wish to look at
the recorded data to ensure that the acquisition is free
of artefacts. After you have reviewed the data, you can

export it in the .nirs format for analysis on your favorite
NIRS processing software.

ANALYZE THE DATA

Refer to the instructions that come with the analysis
software (e.g. Homer).



Chapter 3: Brainsight System Overview

Your Brainsight NIRS system comprises of many MAJOR SYSTEM COMPONENTS
parts, including hardware and software. Brainsight The Brainsight NIRS system comprises of multiple parts
NIRS is a distributed system, with functions spread and was designed as a distributed system. For example,

over multiple devices. This increases flexibility the NIRS unit itself has no major user interface. Instead

L ) of the traditional computer/screen incorporated into
on the setup as well as the data acquisition. This P P

a device, the NIRS unit is connected to the control

chapter will introduce you to each component of computer (“client") via Ethernet network. This enables

the hardware and how to set it up.

Vicra
Position Sensor

® @ NIRS Brainsight

Main Unit Computer

Fig. 3-1

Main Components of Brainsight NIRS
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you to have the NIRS device close to the subject while Fig_ 3-2
having the control computer near the operator, be it next NIRS Unit Fibre Support Arm 7
to the subject, or in the next room. This client-server n

model also enables you to have more than one device -

-«

Fibre Optic
Cables

communicate with the NIRS device at one time, much

like how a printer in your office can communicate with

8-Channel
Optical Modules

&

more than one computer. This enables more flexibility

in sharing data during complex, multi-modality experi-
ments where, for example, in addition to the Brainsight
computer, you may need another computer running
Matlab™ or similar program to be fed the NIRS stream in
real time during the experiment.

This section will describe each component, including how
to assemble, set it up and maintain them. How they work

Main Unit

Brai
="' P

together as a system and how to perform experiments
will be presented in later chapters of this manual.

/

NIRS UNIT

The NIRS unit contains most of the hardware required TroIIey
to acquire NIRS data (see Fig. 3-2). The Brainsight NIRS |

!

\
\

N

system is modular in that the electronics and optical

components have been separated into the “main unit" )
and 8 channel optical modules. This simplifies upgrading \ )
the system in the future. For example, you can purchase O 4
additional 8 channel modules to increase the number 4
of channels you have (up to 32), or use modules with
3-wavelength sources instead of two. Switching modes

Y

would be achieved easily by swapping the block. You
could also purchase longer fibres (for use in MEG or MR
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scanners) and either switch the fibres connected to the
block, or purchase an optical module along with the
fibres to simplify switching back and forth. The unit is
held on a mobile trolley that incudes an articulated arm
to hold the fibres.

Main Unit

The main unit contains the electronics that are required
to manage the optical modules, acquire and process the
data and interface with external clients, including the
Brainsight computer. The unit has four bays to receive
the optical blocks and the necessary ports to connect it
to the network as well as to record up to 8 channels of
auxiliary analog data.

The main unit body has arms on either side to allow you
to move it, either by lifting it (if it is not on a trolley), or by
pushing it on the trolley.

On the top of the unit, there are four bays for optical
modules. The system can function with one or more
modules connected, and the presence of the modules is
detected when the system it turned on (boots up).

The front of the unit contains the LCD touch-screen,
power button and status display lights. The power button
is used to boot the system. Once the system has booted,
a power down and stop laser button will appear on the
touch screen (Fig. 3-4). Touch the power down button

to shut the system down. Since there is a computer
built-into the device, it is important to use this to shut
down the device to allow the embedded control computer

Optical Module Bays |

Handle

Acquisition On Indicator
Laser On Indicator

LCD Status Display

afety
Interlock

WIFI Antenna

™) .‘_’.
© © ©
© © 0

¢ Auxiliary In
-]

\

» (1 Master Key

| Mains In Cooling Fan |

Fig. 3-3

Main Unit Details.
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to perform its shut-down sequence.

Next to the LCD screen are two status lights. The upper
(green) light indicates when the system is on. Once the
system has completed its startup sequence, the Brain-
sight logo will appear on the LCD screen.

On the rear of the main unit, you will find the input
connectors for analog channels. These are used to record
external data, including physiological data (heart rate,
respiratory etc...) as well as experiment state information.
These data channels are synchronized to the NIRS data
for analysis and the sampling frequency can be set up to
8kHz. The connectors are standard BNC connectors.

Just above the analog input connectors, you will find

the Ethernet port. This is used to connect the device to

a network to allow it to communicate with the control
computer (which must also connected to the network).
Connecting and configuring the network will be described
later in tis chapter.

One the rear, you will also find the safety interlock. This
interlock prevents unwanted activation of the lasers. The
interlock must be in place before the experiment starts.
The interlock is activated by connecting the interlock key
to the interlock port. It is a good practice to remove this
key when the system is not in use.

Finally, the main power switch/fuse module can be

found on the rear. The power switch enables power to
the system, but does not boot the interface computer.
Conversely, the power button on the front of the unit
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Fig. 3-5
Closeup of the rear panels.

auxiliary (analog) channel input connectors, the main switch
and the two interlocks.
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will not function unless the main power switch is on.
Before using the unit for the first time, make sure that
the correct fuses are installed. The correct fuses for your
local power voltage are listed on the label on the rear
panel. The main power cord is connected to the main
power switch/fuse module. Use the included power cord
to connect to the appropriate power outlet.

Optical Module

The optical module contains the electronics and optical
components to generate the IR light that is channeled
into the head and measure the resulting light scattered
within the brain.

On the bottomn, you will find the electrical connector to
interface the module to the main unit. The receptacle for
this connector is in one of the four module bays on the
top of the main unit. The connector is divided into two
sections, the emitter (red portion) and detector (black
portion)

If you open the module, you will expose the optical
connectors. The connectors are standard SMA connec-
tors commonly used for fibre-optic cables. They are
divided into two sections, one for the sources and one
for the detectors. Each source fibre can have two or
three wavelengths enabled (depending on the module)
however there are always 3 connectors per source. The
source labelling scheme 1-1-1 for source one, with the
wavelength of each connector beneath the number, so
for a 2 channel module, under the 1st “1", you would

Optical Fibre
Exit Hole

Cooling Vents

Fig. 3-6
Optical module.

Top: Module with cover in place. Right:
View of he bottom of the module showing

Bottom

the connector to the optical bay. Bottom:
Inside of the module with the cover

removed showing the SMA connec- Source SMA connectors

tors onto which the optical fibres are
connected.

@Dmm“ €5 = close source detection
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Detector SMA connectors

Top (cover removed)
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see N/A, since it is not used, and under the second , you
would see 830nm (the 830nm laser) and under the third,
685nm for the 830nm laser.

The module is secured into the bay using the twist handle
at the top. Inside the module, you will find the optical
connectors with the corresponding red/black sides. To
connect the module to the main unit, insert the module
into a free bay taking care to align the red and black
sides. As the module reaches the bottom, you should feel
the center post enter the receptacle. Once in, twist the
handle clockwise until you feel it click (approximately X
turns).

Optical Fibre

The optical fibres serve two purposes. First, they conduct
the light from the laser sources in the optical module to
the head and second, conduct the scattered light from
the head back to the light sensors (avalanche photodiode,
or APD) for measurement and recording. Brainsight uses
two type of fibers that are optimized for the purpose. We
refer to them as source and detector fibres. Both fibres
types have a unique serial number and are character-
ized at the factory prior to shipment to ensure that they
conform to specifications, especially in their ability to
conduct light.

The detector fibre uses a bundle style fibre optic cable
which has hundreds of small fibres in a tight bundle.
This provides a large surface area for light collection
(particularly for diffuse light) as well as good flexibility. It
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Fig. 3-7

Optical Fibres

Fibre
(small section shown)

has a single optode at one end that is placed in contact
with the scalp, and a single SMA connector at the other
end that is connected into a detector receptacle in the
optical module.

The source fibre is used to carry the light from the laser
diodes to the scalp. It has the same optode at one end

as the detector fibre (that is placed in contact with the
scalp), but uses two or three single core fibres to conduct
the light, depending on whether it is a two or three
wavelength fibre. At the other end of the fibre, there are
two or three SMA connectors. The purpose is to take

the light from two or three laser diodes (each using a
different wavelength and modulation frequency) and emit
the light into a single, common point on the scalp via
the optode lens. The fibre diameter is smaller than the
detector fibres, but a little stiffer.



Support Arm

The support arm is a n articulated, telescoping arm to
support the weight of the fibres between the NIRS main
unit and the subject's head. It is designed to be easy to
position so that an optimal orientation can be found

to have the fibres securely supported, reducing the
weight carried by the subject's head and reducing the
forces exerted on the optodes themselves to minimize
movement during acquisitions.

The arm has two ring shaped receptacles to hold the
fibres. The rings have magnetically closed latches that
open to allow you to insert or remove the fibres.

The arm is attached to the mobile trolley and an
adjustable piston is used to set the vertical resistance if
the arm. This ensures that the arm stays in a constant
location while holding the optodes while allowing easy
movement by the operator.

The arm is telescopic. It can be extended and retracted
by grasping the end of the arm, and pressing the brake
lever. Once pressed, pull the arm to extend it, or push it
in to retract it. Take care when doing so as changes in
position will change the weight carried by your hand.

Fig. 3-8

Support Arm
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Trolley

The Brainsight NIRS unit may be placed on the trolley to
simplify placement of the NIRS unit next top the subject
(to allow a simple path for the fibres to get to the head)
and to use the articulated arm to support the fibres
(assuming the arm is attached to the trolley). The main
unit is fixed to the trolley by placing it on the wishbone-
shaped support (that is fixed to the trolley back-bone)
and secured using the 4 bolts that go through the
wishbone into the bottom of the unit.

The trolley base uses 4 large swivel caster wheels to
allow easy movement of the trolley. The trolley may be
secured at any time by locking the front wheels. This

is done by gently stepping on the break levers on the
wheels to push them down, into the locked position. The
wheels are unlocked by placing the foot under the brake
lever, and pulling up.

Fig. 3-9

NIRS trolley
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SETTING UP THE POLARIS VICRA POSITION SENSOR

Your Brainsight system will have come with a Polaris
Vicra position sensor system. If you are upgrading from a
previous version of Brainsight with the traditional Polaris

camerg, refer to the Brainsight 1.7 user manual for
connection instructions.

The Polaris Vicra position sensor system comprises the
camera body, a cable with integrated USB-Serial adapter
(dongle), a power supply and camera stand. If your
Brainsight system included the mobile computer trolley,
then refer to Chapter 20 for instructions on how to make
the electrical and data connections to the Vicra from the
trolley's I/0 interface box as some of these components
are in the 1/0 box.

Physical Setup

The camera sits on top of a lighting stand with a flexible
“‘gooseneck” segment between the two (Fig. 2-6). To
assemble these:

e QOpen the legs of the camera stand. As you open
each of the three legs, they will snap into position at
120° increments of each other.

e The flexible "gooseneck” bar has two ends, one for
the camera mount adapter, and the other with a
receptacle that fits on the top of the camera stand.
Insert the camera stand end into the camera stand
top, and tighten the set screw.

¢ Fix the camera adapter to the other end of the
gooseneck as in figure Fig. 2-7.

Fig. 3-10
Right: Camera on stand

The camera is connected to a flexible gooseneck segment using
a camera mount adapter. The gooseneck is fixed to the top of the
camera stand with a set screw.

Middle: Close-up of Vicra on the camera stand.

The bottom of the gooseneck connects to the top of the stand,
while the Vicra is connected to the gooseneck via the mounting

adapter.
Bottom:

Wiring diagram for Vicra (without Brainsight computer /0 box)

To Computer USB Port

Vicra Power Suppl

To AC Power
(via Surge Suppressor)

Sty .
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» Fix the camera body to the camera adapter, again
referring to Fig. 2-7.

e The Vicra cable has a plug at one end (Lemo
connector) that connects to the camera, and a
dongle with power and USB jacks at the other end.
String the Vicra connector through the hole in the
camera mount adapter and then plug it into the
Vicra. Stringing it through the hole acts as a strain
relief for the cable.

e If you are using your own Brainsight computer (or an
early model Brainsight trolley without the I/0 box:

» Connect the power supply cable into the power
jack of the dongle.

e Connect the USB cable into the dongle, and the
other end into the Brainsight computer. Take care
not to use a USB port on the keyboard as it may
not provide enough power for the USB-Serial
adapter causing the Vicra to function intermit-
tently, or cause USB-over current error messages.
If you are lacking ports, use a USB 2.0 (or higher)
compliant powered hub.

* The Vicra power supply does not have a power
switch. When using the Vicra, simply plug the
power into a powered surge protector.

e If you are using the Brainsight trolley with an 1/0
box:

e The power and USB cables should come out of
the 1/0 box (are tied together). Connect the two
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into the power and USB jacks of the dongle.

* The trolley will have a Vicra power button on the
rear panel (see Chapter 20), so turn it on when
you need to use the Vicra.

Physical Setup (Vega)

The Vega uses the same camera stand however instead of
the flexible gooseneck, it includes a ball mount that can
support the weight of the Vega.

* Unscrew the thumbscrew on the side of the cylindri-
cal mount protruding from the bottom of the ball
mount adapter enough for it to fit on the top of the
camera stand. Place the ball mount on the camera
stand and tighten the thumbscrew to secure the ball
mount to the pole.

 The top platform of the ball mount (from which you
removed the flat plate in the previous step should
have a thumb lever that lock intop place when the
flat plate is replaced into position. Pull the lever
out so the flat portion (with the screw that attaches
he camera to it) of the top of the ball mount can be
removed. The thumb lever should remain open to
receive the plate again.

 Attach the flat plate to the mounting hole of the rear
of the Vega. Note the arrow indicating the side of the
mount that should face the bottom of the Vega.

 Carefully attach the Vega to the ball mount by
presenting the front edge of the plate into the
receiver (see instructions that came with the ball

mount for more details) and when it is inserted, tilt
the camera to bring the plate flat into the receiver.
When it is inserted correctly, the thumb lever should
snap into place to lock the plate in the correct
position. Verify that the camera is locked into place.

e Connect the supplied Ethernet cable (that supports
the POE standard) to the Ethernet jack on the rear
of the Vega. Connect the other end to the supplied
power supply to the jack labelled Ethernet out.

e Connect an Ethernet cable from the Ethernet in of
the power supply to your Ethernet router or directly
to the Ethernet port of the Brainsight computer.

To turn on the Vega, plug the Power adapter to a suitable
outlet. Note that there is no power switch.

Testing the Vicra

The best way to verify proper functioning of the Vicra is to
try to track tools with it. Make sure the Vicra is turned on,
and connected to the computer via the USB cable. Select
Windows->Polaris Configuration to open the window (see
Fig. 2-4). You should hear the Polaris reset beeps (2).
Make sure the tools are enabled in the list, and move
one of them in front of the camera while observing the
checkbox next to the tool in the list. If the check changes
from a red "X" to a green “check”, then it is tracking the
tool. If instead of a red “X" or green check, you see a grey
X", then the tool is not enabled due to an error. Contact
Rogue Research in this case. You can perform a more
detailed check with the Polaris visualizer described in Fig.



2-7.

INSTALLING THE SOFTWARE

Brainsight uses an installer to install the software as well
as the drivers and support files. Double-click on the disk
image to mount it on your desktop.

Double-click on the installer package to initiate the
install process (Fig. 3-1).

Click on Continue to get to the terms of use page. If you
agree to the terms, then click “Continue” a second time.
In the next screen (Fig. 3-2), simply click “Install” and all
the required components will be installed.

Once you click the Install button, you will be requested to
enter the name and password of a user with administra-
tive privileges. Enter it to continue the install.

Once the install is complete the final screen will appear
confirming success. Click on the Close button to complete
the install.

INSTALLING SUPPORT FILES

(Perform this only once)

If you have not already done so, install the NIRS support
files. These include sample data (which will be installed
on your desktop) as well as the files needed for MNI atlas
support.

Double-click on the NIRS Support Files.mpkg icon to
launch the installer. Follow the same steps described in
“Installing the Software” on page 25 to complete the

installation.

QUICKLOOK PLUGIN

One of the software components installed is a Quick-
look™ plugin. This adds the ability to display preview
thumbnail images rather than a generic icon. The plugin
supports many of the image data formats supported by
Brainsight including (but not Llimited to) DICOM, MINC,
NIfTI and Analyze. Note that if you use other software on
your computer that installs its own QuickLook plugin for
the same formats, either one may be called upon by the
operating system.

INSTALLING YOUR TOOLS

(Perform this only once)

Brainsight keeps files that describe each of your tracked
tools in a private folder on the hard drive, and manages
those files directly. In order to "tell" brainsight about the
existence of one of your tracked tools, you only need to
open the tool file in Brainsight once and it will copy the
tool file to the appropriate place.

Note that if you have already installed your new tools
for an earlier version of Brainsight (including any beta
versions), you can skip this step, otherwise:

Make sure your tools folder is accessible (i.e. decompress
itifitis an archived folder by double-clicking on the
archive).

1. Launch Brainsight, and click I Agree to dismiss the
splash screen.

Polaris Configuration

To differentiate tools, Brainsight must know the serial numbers of all the tools you use.
The serial numbers are written on the tools themselves and are of the form "P-123".

Visit <www.rogue-research.com/downloads>, downloa
then add them to the list below.

Supported Polaris Tools:

Type

Calibration Block
Coil Tracker

Coil Tracker

Coil Tracker
Large Coil Tracker
Pointer

Pointer

Pointer

Pointer

Pointer

Pointer

Pointer

Pointer

Pointer

Pointer

Pointer

Pointer

Large Coil Tracker

Polaris device: P9-00850.local.
Polaris status: OK & Tracking
Serial number: P9-00850

Last characterization: October 17, 2018

d your "Polaris Tools Archive,

Serial ~  Visible Enable
CB685 v
CT_DeymedTest x
cT438 x
cT848 x
LCT340 x
P702 x
P704 x
P819 x
P940 x
P1052 x
P1207 x
P1331 x
P1456 x
P1458 x
P1505 x
P1511 x
P10000 x
POL-ADAP-MAG-03_SN-2013-1.. ¥

Remove Add...

. B  Reset

If the Polaris was off/unplugged when this
window was opened, or if it is unable to see
any of your tools, press the button below.
Once reset, the Polaris should emit its

characteristic double beep sound

Scan All Serial Ports

Fig. 3-11

Polaris Configuration Screen
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2. Select Window->Polaris Configuration to open the
Polaris window (NIRS Unit).

3. Click Add... and select all the tools in the subsequent
file selection dialog box. Click Open to confirm the
selected tools. Note that the tools should appear in
the List of tools.

4. Ifthey are not already enabled, Enable each tool by
clicking on the check box next to each one. Note that
you can only enable one tracker of a type (e.g. CT-xxx
class of trackers) at any given time. If, for example,
you wish to calibrate two separate coils, both with
CT-type trackers, then you will have to enable one
first, perform the calibration, then return to this
screen again to switch the enabled tracker to the
other, then calibrate that second coil. When you are
using the coils during a TMS session, Brainsight will
automatically switch the active tracker if you switch
the tracked tool.

Once all the tools have been added, you can delete the
tools folder you downloaded since Brainsight has copied
the tools into the private folder.

Newer models of the Polaris camera (e.g. Vega) have
changed from a serial/USB cable to Ethernet. This opens
the possibility of having more than one camera visible on
the Ethernet network. If you have more than one camera,
select your camera from the popup button. This selection
will be used throughout the software where interaction
with the Polaris camera is required. You may need to
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For most image views:

Craosshairs colour:

Annotation highlight colour:

For 2D image views only:

Slice increment size:

Annotation visibility threshold:

Imaging convention:

Annotation name font size:

For 3D image views only:

Background colour:

Annotation name font size:

For bullseye views only:

Preferred bullseye view:

Colour:

Font size:

EMG Pod amplifier:

: O

14

12

: O

18

1.0

mm

L=R, R=L (Radiology)
L=L, R=R (Neurology)

S points

—

S points

Tool centric
Target centric

S points.

Preferences

For waveform views only:
Background colour:

Grid colour:

100

Axes and |abel colour:

EMG

Monochrome: -
© Custom colours: |l | (HN| [T BN BN
|| B ..

Only first two used for EMG Pod.

Other:

Play sound when creating landmarks, samples, etc.

Periodically check for new versions over the Internet

No information is uploaded during this check, only a small
version description file is download from Rogue Research.

SimNIBS executable: M simnibs_python <

This must point to the "simnibs_python” executable, which can
be at different locations depending on the version of SImNIBS.

There are three models of the EMG Pod amplifier, none of which can be automatically detected. You must select the model you have. It is vital to

cheose correctly, otherwise all EMG Pod data will have an incorrect scaling.

Model 1 & 2 (serial number SENS001001 or SENS002001, grey colour enclosure)
© Model 3 (serial number SENS003001, almond colour enclosure)

Restore Factory Defaults

Default properties for new targets:
2D Size: 5.0 mm

3D Size: 5.0 mm

Point Shape: Sphere
Direction Shape: Brainsight (2]
Colour: | [

Default properties for new samples:
2D Size: 5.0 mm

3D Size: 5.0 mm

Point Shape: Octahedron
Direction Shape: Arrow
Colour: | N

Speech recognition:
“Sample” command: Sample
"Next” command: Next
“Previous” command: Previous

“Begin Countdown" command: start
The phrases here are the ones that will be listened for in windows

that support speech recognition. Different phrases may work
better than others, depending on your accent and dialect.

Default EMG Pod Sampling Options:

Baseline: 50 ms (20-100)

Trial: 180 ms (50-1200)

Fig. 3-12

Preferences Screen



come back to this screen after you have assembled and
turned on your Vega

SETTING YOUR PREFERENCES

When you first install Brainsight, it should work "right
out of the box". There are many options that allow you

to customize certain aspects of the software. This section
will describe these options. Some of these options require
an understanding of the software's functionality that is
described later in the manual. It is a good idea to read
through this as a list first with the understanding that
many of these options will become clearer once you

have familiarized yourself with the different aspects of
Brainsight.

Launch Brainsight, and select Brainsight->Preferences
(see Fig. 3-12).

Crosshairs colour: Refers to the colour of the crosshairs
that indicate the location of the cursor. Click on the
colour to open the colour picker to pick a colour.

3D Background colour: When Brainsight renders a 3D
scene, the surrounding space (background) requires a
colour. Change it by clicking on the colour to open a
colour picker to choose your colour.

Slice increment size: When viewing a 2D plane it is
possible to go from one slice to the other using the arrow
keys or the mouse's scroll wheel. Each keypress of the
arrow or movement of the scroll wheel will move the
cursor the distance set by this preference. Change it by
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typing a new number in the box.

2D View annotation visibility threshold: When a marker
location intersects a 2D imaging plane, the annotation
is drawn on the plane. The threshold value determines
how close to the plane the marker needs to be to be
considered on the plane.

Imaging convention: When viewing 2D transverse and
coronal slices, there is an ambiguity regarding which side
of the image is the subject's left or right (this ambiguity
dates back to when X-rays were viewed as translucent
films placed on a light box). There are two conven-
tions, often referred to as Radiology and Neurology for
historical reasons. Radiology is the convention where
the subject’s right is displayed on the left of the screen
and vice-versa. Neurology refers to the convention of the
subject's right being on the right of the screen (think of
it as looking at the subject's face, or the subject's back,
or looking with the subject). Brainsight always displays
an R symbol for the subject’s right side (on the left

when in Radiology convention, and on the right when in
Neurology convention), so you will always know which
convention you are using.

Default properties for new targets: If you are using
Brainsight along with TMS, you may define targets for
stimulation, and how they are to appear on the screen.
When a new target is created, some default values are
needed, and they are defined here. The 2D size represents
the size of the glyph when drawn on 2D planes (e.g.
transverse), while the 3D size determines the size when

drawn in a 3D view (they are different because the nature
of the displays often require different values for effective
display). The point shape describes the shape of the glyph
that indicates the location of the target. The Direction
shape determines the shape of the glyph that indicates
orientation (when the target is a trajectory, rather than

a simple marker). The colour is the colour to use when
drawing the glyphs when the marker is not highlighted.
Highlighted markers are always drawn in red to differen-
tiate them from the others.

Targets are points that are set prior to a TMS session.
Samples are recordings of the location and orientation
of the coil during a TMS session. The default values for
their appearance can be set here. The attributes are the
same as for targets, so refer to the target preferences for
a description of the individual attributes.

EMG Pod amplifier: Brainsight currently supports two
models of EMG amplifier. Model 2 (in small grey
enclosures) and Model 3 (in almond colored enclosures).
These amplifiers have different, hard-wired gain settings.
Make sure you select the correct ones here to ensure that
the recorded EMG data is correctly scaled.

Periodically check for new versions of Brainsight over the
internet: Refers to a function that communicates with
our server each time it is launched to see if there are any
updates available. If your computer is connected to the
internet, enable this feature to ensure you are informed
when an update is available.
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Chapter 4: Cap and Assembly Manager

When you perform a NIRS acquisition, optodes

are placed on the head of your subject. In many
instances, the optodes are held on the head using
a standard cap. Brainsight includes tools to define
and save your NIRS caps and how the optodes on
your NIRS are attached to the cap for use during
the NIRS session. This saves time at the start of the
NIRS session and simplifies the process of mapping
the location of the optodes to the subject specific
MR images by providing a reasonable estimate on
where the optodes will end up on the head. This
chapter will explain how to use the cap and assem-
bly managers to define your caps and assemblies.

INTRODUCTION

When you purchase a Brainsight NIRS system, it will
come with one or more caps and one or more sets of
fibres. For the purposes of this user manual, a cap is
defined as an apparatus that is worn on the head with
the purpose of rigidly holding one or more NIRS optodes
and/or EEG electrodes on the head. The caps may be
similar to EEG caps (where full head coverage is desired)
or smaller patches that are fixed to the head in one

way or another. A cap definition in Brainsight consists
of a name for the cap itself, a list of the names of each
receptacle (referred to simply as holes) onto which
optodes and electrodes may be fixed and optionally, the
location of the holes within the cap in a standardized
coordinate system (e.g. MNI coordinates). Using EEG as
an analogy, a cap might have holes in it that are labeled
according to anatomical locations using a standard grid
system (T1, FP2 etc...). These locations are cap specific
and do not assume anything is attached in any given
receptacle; it is the list of all possible places where an
optode or electrode may be attached.

When a cap is to be used, optodes and/or electrodes must
be attached to the cap at one or more of the receptacles.
This list of cap holes and associated optodes is called

a connection list. It defines what specific optode (be it a
detector or source) from the NIRS device is fixed to which
hole on the cap. One can use this list to physically insert
the optodes into the receptacles in the cap prior to a scan
(and may be stored this way for re-use for subsequent
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scans when the configuration does not need to change).
This enables Brainsight to associate the data acquired

by each source-detector pair with a specific region of

the brain. This cap-connection List association is called
an assembly. A cap may be associated with multiple
connection lists and thus have multiple assemblies, but a
connection List can only be associated with a single cap.
Thus an assembly is a unique pair of a cap and connec-
tion List.

The data that is being recorded in NIRS is the light

collected by the detectors. In theory, each detector may
be collecting light from every source optode on the head.
— 1 @51 S1-D1
_ Each source may have 2 or more separate wavelengths of
F@ . @ D1 52-D1
S2-D2 light, so the number of potential sources of light that any
—® S2
\ L o S3-D2 given detector may be recording is the number of source
}\ | o < $3-D3 optodes times the number of wavelengths per source.
] P gj’gi For a 32 channel system, each detector may record data
I @ / | @ s4 A __ ) from 16 source optodes. Assuming two wavelengths
Connection \__. D4 s;:i?fits'?n per optode (32 light sources) and 32 detectors, you can
List create 32x32, or 1024 data streams. This can quickly
Cap become difficult to manage. While it is theoretically
Assembly possible to for a detector to collect light from all sources,
in practice, only sources within a reasonable distance
Fig. 4-1 from the detectors will contribute enough of light worth

recording, so each detector can be associated with
Illustration of the relationship between a cap and an assembly. sources close enough to matter. We call these association

pairs.

Brainsight includes software tools to define your collec-
tion of caps, and tools to use caps to generate connection
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lists and Lists of association pairs. A cap, connection List
and association pair list is referred to as an assembly. The
tools in Brainsight to create and manage there are the

[ NON ) Cap Layouts

A ‘cap layout' describes the geometry of an EEG/NIRS cap. Specifically: how many holes, a name for each, and optionally where

Cap managel” al’ld assembLy mal’lager, they are located (on the MNI-152 template). These layouts are described once in this window then used again later in the
application.
Cap layouts: Cap holes:
USING BRAINSIGHT WITH DIFFERENT NIRS HARWARE
MName Name MMNI x {mm}) MNI y {mm}) MNI z {mm})
While the Brainsight navigator is used often with the :I:z 10:2? :355781 g:g;
Brainsight NIRS hardware, you can use it with different 8 Ea STl L 9 8476 -5492  -5168
TemplatelCBM_space-ICBM.txt P8 84.70 4958 108
NIRS hardware as well. You can define cap layouts and CAPFAB560202.txt AF7 £272 6645 1468
assembly lists for any NIRS system, use the navigation o ni-20T8S CE3 6357 5056 6460
y y Y / g EEG 1010 Jan23 s o5 P 720
system to place the cap and record the optodes and even cz 164 12,58 08.85
. . . . . . . CPz 1.81 -61.14 95.63
import the NIRS data into Brainsight for visualization. Fc3 5679 19.64 £2.59
F2 29.67 58.70 59.03
One difference between the Brainsight and other P2 3242 -84.58 73.66
X TP10 78.25 -56.39 -55.10
hardware is our use of block#s to define up to 4 modules AF4 35,25 77.92 18.80
: : CP& 82.50 -47.31 28.36
that may be present in the system. When defining o Coras w740 5028
assembly lists for other hardware, simply use Block 1 for cPa 6767 -49.15 64.25
FC1 -32.87 23.72 78.10
all source and detector channels. P3 -54.21 -82.36 54.09
Cc3 -62.91 -16.11 60.46
USING THE CAP MANAGER Fp2 29.41 86.84 -10.87
FT9 -75.30 9.78 -54.98
: : FCc2 36.13 25.05 7760
When you obtain a cap, either from Rogue Research or fon 120 2696 o187
other source, you need to enter the information associ- F& 63.31 48.93 .85
) ) o ) PG 7017 -79.23 241
ated with the cap into your Brainsight system in order to p7 -69.27 7767 -5.60
be able to use it with a su bJECt. Remove New... @ Distance: Remove Add

Open the cap manager by clicking Window->Cap Manager.
This will open the cap manager widow (Fig. 4-2). To
create a new cap from scratch, click on New->New Cap. F|g 4-7
To create a new cap based on a pre-existing cap, select Cap Manager
the cap to use as a starting point in the list (e.g. different

caps with similar geometry), then click New->Cloned cap.
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Finally, to edit an existing cap, simply select it in the list

to highlight it.

» To create a receptacle, click Add, and a new entry

will be created. The name field will automatically

be highlighted. Enter a name for the receptacle.

For whole head caps, this is usually an anatomical
location (e.qg. EEG caps), while for smaller patches,

these are usually a node identifier (e.g. row and

column name). These names are for your reference,

S0 you can choose them as you wish. In addition

to the name, you can also enter the 3D location of
the receptacle in the MNI coordinate system (if you
have this information). This location will be used to
estimate the location of the receptacle when placed
on the subject's head. If available, enter the X, Y & Z

values.

* Repeat the previous step for every receptacle on the

cap.

* You can select any receptacle on the list and edit the

information, or delete it altogether by selecting it
and clicking Remove.

e Once you are finished, you can close the window.

MANAGING ASSEMBLIES

A assembly list is a way to define, prior to the subject
being there, a specific configuration of a cap and NIRS
optodes (and optionally EEG electrodes). It represents
a list of what optodes are to be connected to what

Brainsight’ WP  USER MANUALvV2.5

receptacles in the cap, as well as which source-detector

pairs will be recorded. By creating these templates in
advance, you can eliminate repetition by having to enter
the same information each time you want to record some
NIRS data and reduces the setup time once the subject is
present for the scan.

When using this assembly during a scan, Brainsight
will only activate the sources that are included in this
connection List.

To create a new, or edit an existing assembly:

Open the Assembly list manager window by clicking
Window->Assembly Lists.

Assembly Lists

An ‘assembly list’ is based on a ‘cap layout’ and specifies the connections between the cap holes and the hardware device. Specifically, for EEG, the association
between the cap and the EEG devices' channel number. For NIRS, the association between the cap hole and the bay number and source/detector number. Additionally,

for NIRS, it describes which source-detector pairs are of interest.

Assembly lists: Connection list:

Name N.. ~ Usage

Assembly List 1 421 none
prodi
A62 none
[N] none
L2 NIRS Detector
L3 NIRS Detector
L4 NIRS Detector
L5 NIRS Detector
LA NIRS Source
LA12 NIRS Source
LA13 NIRS Source
LA14 NIRS Source
LA15 none
LA22 NIRS Detector
LA23 NIRS Detector
LA24 NIRS Detector
LA25 NIRS Detector
Usage:

Based on: CAPFAB560202.txt

Remove New.. @ ©

Export...

PO DD NDNDDONNDNNNO

Bay #

[N NN NN

= Y - N

Measurement pairs:

Channel # Use Name Dist... ~

<KD OO OO

AL NDWA®SN

<O O OO
0 N o O

NIRS Bay #:

Channel #:

Fig. 4-3

Assembly Manager



* To create a new assembly from scratch, click
New->[cap], where cap is the cap you want to use in
the assembly.

e The connection Llist will populate itself using the the
cap holes. For each cap hole that you wish to assign
something to, click on the Usage popup entry field (it
is set to none by default) and select either NIRS for a
NIRS optode, or EEG for an EEG electrode.

e Ifthe entry is a NIRS optode, select the NIRS block#
in the block# popup field to assign an optical
module number (1-4). Next, select the source or
detector number, by clicking the Optode popup field,
and selecting the appropriate source or detector
number. Remember to use block# 1 for NIRS
systems other than the Brainsight NIRS device.

e |fitis an EEG electrode, select the electrode number
that corresponds to the amplifier channel number.

e Repeat the previous steps for each optode and/or
electrode. Recall that you do not need to use all the
receptacles or optodes and electrodes. You need only
define the ones you wish to use when applying this
assembly.

VISUALLY CREATING AN ASSEMBLY FOR AN
EEG-STYLE CAP

The process of determining the optimal locations for the
placement of optodes on the head is one of the most
complicated yet important steps in successful NIRS
acquisitions. While an assembly is what we call the List of

cap locations and associated channels on the hardware,
the overall layout of optodes on the head is often referred
to as a montage (similar to EEG). The main goals of the
montage are to cover the region of the brain you wish to
record from with a set of optodes that are spaced equally
apart (e.g. 30mm). Brainsight can be used to display the
assembly as the assembly is built to make it easier to
intuitively arrive at the best montage for yuor particular
application.

This section will cover the steps to crate a montage/
assembly list using the Brainsight EEG-style cap with the
hexagonal type array of optode holders. Before proceed-
ing, it is advisable to familiarize yourself with several of
the “Prepare" steps following this chapter. Specifically,
you need to be familiar with creating a Brainsight project
based on the ICBM brain and manipulating the display of
2D and 3D images.

If you have not already done so, download the cap layout
for the cap you intend to use and add them in the cap
manager. Contact Rogue Research if you do not have
any cap layout files for the caps you possess. Note that
we have cap layouts for several sized caps, however the
hexagonal-style caps have essentially the same layout
for all caps except for minor variations along the midline
where on the larger caps, one might find two adjacent
receptacles (on either side of the midline) and on smaller
caps, they may have been merged into one if they were
too close together. In these cases, instead of RA1 and
LA (for example), the merged receptacle would be

labeled AlL. For the purposes of planning layout, any of
the same class of cap can be used (note the cap size, e.g.
58cm) and the assembly can be re-applied to the other
homologous cap sizes.

Overall, the procedure will be to load the ICBM brain and
apply a blank cap layout to display the locations of all the
receptacles and then to interactively build an assembly
while viewing it on the images as you go until you ave
completed the assembly. The process may seem cumber-
some at first, but becomes easy once you have acquired
some experience.

Launch Brainsight and create a new project from
template brain.

 Click on Sessions in the project window and then
click New->Offline Session... from the New popup
button.

¢ Click on the Electrodes tab.

* Arrange the screen layout to something similar
to Fig. 4-4. Specifically, select the 2x1 layout and
display the scalp in one view, and the curvilinear
brain in the other. You are free to change the layout
however this layout is likely the most useful.

e Select Window->Assembly List to open the assembly

list manager.

* In the Electrodes step window, click Add From...
and select a cap that will be the template for your
layout (e.g. CAPFAB560202) from the list, set the
coordinate system to “World/MNI" and Snap to: Skin

Chapter 4 > Cap and Assembly Manager



@ Brainsight File Edit Wind Debug  Help

@ Previous Step | Next Step

Electrodes

I this step, you can digitize the location of electrodes/optodes
on the subject's head.

Electrodes: Clear Al
Show  Name Type  Aca
v LA EEG ©
v Las EEG O
v P23 EEG ¢
v RP2a EEG O
v RA4 EEG O
v EEG O
v RP14 EEG O
v Lp3a EEG ¢
v P33 EEG
v R3 EEG O
v pas EEG ©
v o EEG O
v o oRelt EEG ¢
v ooun EEG O
P oS

New  Add From.

Snapto: Nothing ¢
Positioning an electrode wil
move it to tha nearest skin point,

Distance:

Export To File. Export To Cap Layout.

Use 10Box Switch
Alow to high transition takes a sample.
Note: no tigger box hardware found.
Use Speech Recognition

You can speak the following phrases:
"Sampler, "Next”, and "Previous”

Brainsight WL  USER MANUALV2.5
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KX X X X X X X X X X X X XX

m

3 B

Assembly Lists

An"assembly lst" i based on a cap layout’ and specifies

holes and Specifcally, for EEG, the

he cap and channel number. For NIRS,
detoctor number. Additionally, for NIRS, it describes which source-dotector p

= Assembly lsts: Connection st

Name Name Ussge  Bay#

RAS4 NRS 3 none

NIRS Assembly List Export.txt ) NRS % none
Lo12 NRS < none
Laaa NRS 9 none
RPa NRS < none
Lan NRS < none
RA13 NRS 1
Lp23 NRS < none
P53 NRS < none
e NRS < none
RP24 NRS < none
Lp22 NRS o none
RS NRS < none
L33 NRS < none
L2 NRS < none
LAe3 NRS < none
RA22 NRS o none
RA12 NRS 1
RP43 NRS < none
La NRS < none
Usage:

Based on: CAPFAB560202.txt
Remove  New.. @ ©

Export. Clone

Fig. 4-4

ben
s aro of nterost.

the cap hole and the bay number and source/

Measurement pairs:

Optode#  EEGCh#  Use  Name

P e e e R R SR R R I TR Y
BOOOOOOOO0O0000000000

NIRS Bay #:
NIRS Optode #:
EEG Ch #:

Suggested layout if images and windows to interactively

built an assembly list.

S Q roch @ » MonMar6 12:25PM



Cap Layout: CAPFAB560202.txt (-}
Summary: 91 cap holes total.

91 with MNI coordinates specified.
0 without MNI coordinates specified.

Coordinate System: ~ World / MNI

Any cap hole that has associated MNI coordinates will
be mapped to this subject’s coordinate system via the
chosen coordinate system. If you chose ‘Brainsight’, it
is assumed your anatomical dataset itself is in MNI
space.

Snap to:  Skin

If you also select a reconstruction, all cap holes will be
moved to the nearest point on it.

Cancel

Fig. 4-5

Apply cap to head configuration

(see Fig. 4-5). You should see the optode receptacles
appear on the scalp of the skin and float over the
curvilinear brain as shown in Fig. 4-4.

* Create a new blank assembly by clicking the New
popup button and selecting the same cap layout as
you used in the previous step.

e Looking at the images, decide where to place the
first source and note the receptacle label. Select that
receptacle in the assembly list and assign the first
source (e.g. Bay 1, S1) to it.

* Looking at the images, decide on the receptacle to
place the first source (ideally, a receptacle immedi-
ately adjacent to the source you just assigned).

Select that receptacle in the assembly list and
assign a detector (e.g. Bay 1, D1) to it. Notice that
the possible pair (B1S1-B1D1) appears in the
Measurement Pairs list and the distance between
the two is shown. We expect that distance to be
around (+/- a few mm) 30mm (or slightly more for
larger heads). Note these distances are on the MNI
head and will be slightly different when applied to
different sized heads. Enable this pair using the Use

checkbox.

o

CVIENE

Fig. 4-6

First source-detector pair displayed on the images

Layout: == 2x1

v Skin & Electrodes

» Notice that nothing has changed in the image
views. You can display an update of the progress by
applying the partially built assembly. In the image
window, select Add...->From Assembly List.... Instead
of the cap layout selected at the start, select the
assembly list. B esure to keep the Coordinate System
as MNI and the Snap To: as Skin. Notice that the
source-detector pair is displayed on the images (Fig.
4-6).

A

v Curvilinear Brain & Electrodes
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» Continue adding sources and detectors to the
assembly list and repeating the Add From Assembly
List... every time you want an updated view of your
progress.

e Once complete, close the Assembly manager
window and the offline session. Layout: | == 2x1

« You can re-apply the assembly list to other cap 9 J L Skin & Blectrodes

sizes by opening the Assembly list manager again, B
selecting the assembly and clicking clone. Note that
you can change the underlying cap layout of the
cloned assembly by clicking the arrow beneath the
cap layout listed under "Based On". If any of the cap
nodes used in the assembly are missing from the
new cap, you will need to edit the assembly list to
correct it. This will occur when changing cap sizes
where adjacent receptacles are merged (or vice
versa where a single mid-Lline receptacle is split into
two, one on each side of the midline).

DETERMINING 3D COORDINATES OF CAP HOLES
USING THE POSITION SENSOR

If you have a custom cap and wish to digitize it to add it to
the cap manager (to be used in creating assemblies), see
“Using a single subject to create a NIRS cap definition” on
page 98.

Fig. 4-7

Simple assembly list montage over the motor strip

Brainsighf‘ USER MANUALv2.5
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Chapter 5: Loading Anatomical Images

One of the unique features of Brainsight is the
ability to bring the NIRS data directly into the
subject-specific MR images. This makes it easier

to ensure that the optodes are well placed on the
scalp to image the desired brain regions and to use
this data to perform more sophisticated analysis
and display of the results. If subject specific
anatomical images are not available, you retain
the option of loading a relevant model head (e.qg.
MNI brain) with a slight loss on accuracy. This
chapter will cover the first step required to prepare
a subject specific project file so it will be ready for a
NIRS acquisition: loading anatomical images. The
next steps, will be covered in the next chapters.

Brainsight supports the use of your subject’s
specific MRI (recommended), or in the cases
where the subjects MR images are not available, a
template Brain (MNI 152 average brain).

INTRODUCTION

When Brainsight is launched and you click “I agree” to
the licence statement, a new project assistant window will
appear. You can either open an existing project, create a
new empty project (empty in that there are no pre-loaded
template images) or create a new project pre-loaded

with the MNI head images. You can by-pass the assistant
window at any time by selecting the same options from
the file menu.

You can use the buttons below as a shortcut to
commen actions. Otherwise, choose something
from the menu bar.

Open Existing Project...

MNew Empty Project

New MNI| Head Project

T —
Fig. 5-1

New Project Assistant Window

Chapter 5 > Prepare-Loading Anatomical Images



Untitled 2

ece
& & a4 ¢ C &

Anatomical | Atlas Spaces Overlays ROls Reconstructions Landmarks Targets Sessions

A project must contain exactly one anatemical data set. Use the popup button to locate the data set on
disk. A preview of the data set and its metadata is shown below.

File: | Click here to choose an anatomical dataset ~

Name: Sex:

Scan date: Scan type:

Image size:

Fig. 5-2
Click on the file selector box (highlighted in green)
and select “Choose..." from the popup menu.

OPENING A PREVIOUSLY SAVED PROJECT

Click Open Existing Project... in the New Project Assistant
Window, or select File->Open Project.... When the file
selector window opens, navigate to, and select the desired
project to open. If the project was recently opened in
Brainsight, you can use a shortcut by selecting the project
file directly from the Open Recent Projects menu.

Brainsight’ WL  USER MANUALV2.5

CREATING A NEW PROJECT USING
SUBJECT-SPECIFIC IMAGES

Click New Empty Project in the New Project Assistant
window, or select File->New Empty Project. A new, untitled
project window will appear.

* Click the file chooser (the section highlighted in
green in Fig. 5-2) and select “Choose...", from the
popup button. A file selector dialog will appear. Note
that you do not need to identify the file format as
Brainsight will figure this out automatically. Do the
following for each supported file format:

e MINC: Select the MINC file by either clicking on
the file and clicking Open, or by double-clicking
the file.

e Analyze (and hdr/img type NIfTI files): These
files come in pairs. The header (using the .hdr
extension), and the image data file (with a .img
extension). Select either file by either clicking
on one of them and clicking Open, or by double-
clicking the file. The image file will be opened
automatically.

o NIfTI files (using the .nii extension): Select the
NIfTI file by either clicking on the file and clicking
Open, or by double-clicking the file.

DICOM CD: If your DICOM images came on a
DICOM CD, use the free application “Osirix"
(http:// http://www.osirix-viewer.com/) to read
the CD and extract the desired scan. Follow the

Osirix instructions for more details, or follow the
instructions in ).

* DICOM files: AlL the files for the data set must be
in the same folder prior to opening the images.
Select any slice of the volume and click Open.
Brainsight will search the folder for remaining
slices from the scan and load them.

* PAR/REC: These files come in pairs. The header
(using the .par extension), and the image data
file (with a .rec extension). Select either file by
either clicking on the file and clicking Open, or
by double-clicking the file. The image file will be
opened automatically.

BrainVoyager VMR (versions 1-4): BrainVoyager
typically performs several image processing steps
to convert the native space images into normal-
ized (MNI) space and stores intermediate images.
Use the AC-PC aligned images (but not scaled) by
selecting the appropriate vmr file.

Note about DICOM CDs. It is common to receive DICOM
files on a CD-ROM formatted in a common DICOM
standard. The CD often contains multiple scans and it

is difficult to extract the files associated with the desired
scan. We recommend using a free application called
OsiriX to read the DICOM CD. The software will read the
CD and display a list of scans on the CD (it may take a few
minutes to scan the disk and build the catalogue. Simply
select the scan from the list, click the “Export” button and
select the destination for the scan on your hard disk.



Once the images load, a thumbnail of the scan will

appear on the project window along with some details
extracted from the header (Fig. 5-3). You can proceed to
the next step, or view the metadata in the header as well
as the image volume by clicking the Show Image & Details
button, which will open a viewer window (Fig. 5-4). The
last section in this chapter will describe the image view
window in detail. The example window is taken from

a later step in the data processing workflow (the skin
segmentation step) as it shows tools that are normally
found throughout the software, with the exception of the
anatomical detail view (due to its simplicity).

Fig. 5-3
Project window with the anatomical
MR scan loaded.

®eno Untitled

gl & e & O & @

'Anmnm.ml Atlas Spaces Overlays ROls Reconstructions Landmarks Targets Sessions

A project must contain exactly one anatomical data set. Use the popup button to locate the data set
on disk. A preview of the data set and its metadata is shown below.

File: g roch_mri_corrected.mnc

Name: roch,freq_test Sex: Male
Scan date: 99-08-23 5:26 PM Scan type: MRI

Image size: 1.0 x 1.0 x 1.0 mm
180 x 256 x 256 voxels

(_ Show Image & Details )

Fig. 5-4
Anatomical Image Detail View

In addition to showing the usual tri-planar images, the files
header information is also kept and shown in detail.

Layout: 3x1 B

()

el -

Image metadata:

Mon Aug 23 17:51:35 1999>>> dicomserver

Chapter 5 > Prepare-Loading Anatomical Images



F | g . 5 - 5 800 Local DICOM Database

g 2 @ B ue = gE e
Import CD-Rom Query Export Anonymize Send iPod 2D-3D Viewer 4D Viewer Burn Albums & Sources  Report Delete Search by All Fields

Local Database / No album selected / Result = 12 studies (1,994 images) pie :( et

Typical steps for importing DICOM images from a DICOM CD

T
<10mn O<inr O<énr

in Osiri — e E——r T —r
using Osirix. D i 30 5 srie ; P
» (FICKCRE (L series) 00962330 72y 009623..8317027 head general MR [ﬂ
e -
Vb AT RS (1 series) 4029308 52y 17441743308252 RMCRAN - ... - CRANIO MR v
—_— G

A: Launch Osirix and insert the DICOM CD. Wait for the CD to ——— p—r o3 R
be read, or press the CD button at the top of the screen to have p
Osirix scan and Load the imaged from the CD (or drag the CD

icon from the desktop onto the Osirix window). It may take a ey o xs e ey
few minutes to scan the CD and load the images.

image 11 image 12 image 13 image 14 image 15
800 Local DICOM Database 1194 -7.04 -3.95 005 404

ge@8 2@ 8 WO 3 JF o,

Import CD-Rom Query Export Anonymize Send iPod 2D-3D Viewer 4DViewer Burn Albums &Sources Report Delete Search by All Fields

Local Database / No album selected / Result = 12 studies (1,994 images) e
Patient name | Report Patient ID Age Accession Number  Study Description Modality Image 16 Image 18 Image 20
i IRAIN AX.9 POST SX MR e 16.05 24.02
b rxs, ROGUE RESEARCH (3 series) DOG 1 lysm K9 BRAIN MR ﬂ;
».{\KWROQUE TEST (4 series) 11 8y K9 SKULL POST MORTEM MR f‘l-
> NS L evendi(1 series) 01171603 30y 011716...8213001 head general MR 3
K27 502030 6 series) L Se | headgenen e
> [ best 75 (1 series) 00962330 72y 009623...8317027 head general MR
PR VIGnspet (1 series) ossaszs | 21y 210 cRanio e . . L.
TR RS (1 seres) S2y  w7asi7arosss2 mMCRAN- .- CRAIO MR S B: Select the scan that you wish to use (make sure it is

—_— 2 - : 2 selected in the list view and that the thumbnail images from
the scan appear in the Lower Left view box) and click Export.

13 Images

OO0, Export
Select the location where to export the DICOM files:
(«T») [z2[=]m) [ Sample data =) [@search
] Deviree Name Date Modified Sl
£ roch B t Tuesday, May 12, 2009 9:17 AM m
g Frrs bspro) Wednesday, April 8, 2009 12:30 PM
A Applicati Tuesday, March 17, 2009 11:24 AM
St Tuesday, March 17, 2009 10:16 AM
B Deskeop Wednesday, March 11, 2009 7:04 PM
(B Rogue Friday, March 6, 2009 9:58 AM
DICOMDIR: [ Add DICOMDIR
Folder tree: (O Hierarchical
@Flat
Compression: () Don't modify the files
O Compress all DICOM files in JPEG
@ Decompress all DICOM files
New Folder Cancel Choose
|

C: Select “Flat Folder" and “Decompress all DICOM
files". Navigate to your image folder, and press Choose.
Osirix will extract and save the scan in a folder using the
subject's name and scan number.

+ Brain WL  USER MANUALvV2.5



CREATE A NEW PROJECT
USING THE MODEL HEAD IMAGE SET

When MR images are not available, it may be appropri-
ate to use a template head. Brainsight incorporates the
MNI 152 average brain for this purpose (http://www.bic.
mni.mcgill.ca/ServicesAtlases/ICBM152Lin). Be sure to
have downloaded and installed the “TMS support files"
(version 1.3 or newer) from our web site (the same way
you download Brainsight updates). The MNI 152 is a
template based on the average of 152 individual subject
MR images that were co-registered to the MNI coordinate
space and averaged.

To use the average brain template:

e Click New MNI Head Project from the New Project
Assistant window, or select File->New MNI Head
Project. The data set resides in a special place and
will be loaded automatically.

Note that the data summary pane shows the image
resolution and voxel count, but not the name (there is no
name stored in the MNI 152 average brain image file.

The MNI Head project already has a 3D skin, brain
surface and brain curvilinear reconstruction, so unless
you wish to create additional surfaces, you can skip to
“Chapter 11: Selecting Targets for Stimulation".

Fig. 5-6
Project window with model head selected
[ N Untitled
& B 28 ¢ 0 &

Anatomical Atlas Spaces Overlays ROls Reconstructions Landmarks Targets Sessions

A project must contain exactly one anatomical data set. This project is permanently configured to use
the MNI ICBM 152 average brain. A preview of the data set and its metadata is shown below.

File: <Using MN| ICBM 152 average brain>

Name: Sex:
Scan date: Scan type:
Image size: 1.0 x 1.0 x 1.0 mm

193 x 220 x 193 voxels

Show Image & Details

WHEN TO USE THE MODEL HEAD VS. SUBJECT-
SPECIFIC MRI?

Making the choice between using (and often paying

for) subject-specific images vs. a model head can have
significant impact on the accuracy and reliability of your
study. In general, using a model head is best reserved for
the following cases:

* The target will be based on a pilot study and by
observing an external response (not by interpreting
the anatomical images).

» Reproducibility is the main goal of using navigation
(reproducibility vs. specificity).

* Anatomical targeting accuracy of about Lmm is
sufficient.

Subject-Specific MR images should be considered in
cases where:

* Targets are based on subject-specific anatomy.
 Targets are based on functional overlay (e.g. fMRI).

» No external measure of target correctness is
available.

Chapter 5 > Prepare-Loading Anatomical Images



THE IMAGE DISPLAY WINDOW F|g 5-7

The image display window, as the name implies, is the Typical image view window with the important

main method of displaying image data. The exact config- controls highlighted in green. View Configuration (HUD)

uration of the window depends on the context of the 3D 2D

display (i.e., what step in the process you are in). The Layout Control View Selector
relevant controls are shown in Fig. 5-7. Different

perspectives of the image data are displayed in individual

views, called (to no surprise) Image Views.

Layout Control INSPECION mmgp © LAAVMSK‘;;TZ:;EQ — ;WMSCNI .
Each display window starts in a default layout configura- Full Screen == - = 3 -

: : L Cursor ToO| ==—=3p- & s

tion. In the example of Fig. 5-7, itis a 2x2 layout. The 3D Ruler TOOL s =

layout can be changed using the layout control popup 3D Crop Box me==3p- 3

menu.

View Configuration (HUD) Image CoNntrast -
Configure each image view (if desired) by clicking on

the HUD button (We call it a HUD, for Heads Up Display

because the window floats over the image view when |
invoked). When viewing a 2D image, you can change A
the zoom (note that the zoom applies to all 2D views); ) ‘
while viewing a 3D image, you can also change the view's
orientation. In a graph view (e.g. EMG), a zoom controller
allows you to set the vertical and horizontal scale.

Note: Many image manipulations are performed without
needing to invoke the HUD. For example, option-click-
dragging the image performs panning, while option-
scroll wheel zooms the image. Zooming a 2D image
view will apply to all 2D images, while zooming in a 3D
or graph view only applies to that view. Panning always

Crosshairs Offset: 0.00 mm

applies to the single view only.
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View selector

You can change what is being displayed by clicking on the
view selector. A series of common views and a customize
option are listed, where you can select exactly what you
wish to view from an array of options.

Inspector

Invoking the inspector opens a control window that
allows you to change certain context sensitive window
settings and the appearance of ROI (Fig. 5-10A) and
overlay image data (Fig. 5-10B). From this window, you
can also choose the peel depth of curvilinear reconstruc-
tions (Fig. 5-100C).

Full Screen Control

This button toggles the view window in/out of full screen
mode. You can use full screen mode if you want to
maximize the amount of screen space used for image
display.

Cursor Tool
The new “smart" cursor tool replaces the multiple tools
found in Brainsight 1 with gesture interpretation to
determine your intent when clicking the mouse. When
clicking the mouse on the images, one of several things
may occur depending on the context of your motion:
« Single-clicking (without motion) on the image
moves the cursor to that location (both for 2D and
3D views).

* Ina 3D view, clicking and dragging rotates the
image. Clicking inside the blue circle (it appears

when you click) rotates the objects in the direction
you click. Clicking and dragging outside the circle
rotates in a twist direction.

* Click-dragging with the option/alt (%) key down
pans the image.

* Option-scrolling (using the scroll-wheel, or track-
pad) zooms the image (both for 2D and 3D views)

* Click-dragging on a 3D object with the command
(38) key down will trace the cursor along the surface
of the 3D object.

3D Ruler Tool
You can measure the distance between two points in the

2D view, or create complex paths along a 3D surface (e.g.

skin) and view the length.

In the 2D view, clicking on the start point, then dragging
while holding the mouse button down will create a
straight line whose end-point will follow the mouse. You
can then move the start and/or end points by click-
dragging either one with the mouse.

In the 3D view, you can create straight or complex curves
on any 3D surface. Clicking between anchor points will
insert a point between them, while pressing the delete
key will delete the currently selected (or last) anchor
point.

3D Crop Box
This mode works in conjunction with a 3D object (e.g.
skin) displayed in a 3D view. When invoked, you can click

on a 3D surface to activate the box (Fig. 5-11). You then
move the walls of the box in and out by click-dragging
the spherical handles to set a clipping plane location.
Letting go of the handle updates the clipping of the
object according to the clipping box. Once done, turn the
box off by selecting the smart cursor again.

Chapter 5 > Prepare-Loading Anatomical Images
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Fig. 5-8
A: 3D ruler tool in straight-Line mode: Shift-click-dragging
along a surface creates a curved ruler along the surface.

Note the curve appears as a straight line from above,
but follows the surface when viewed from another angle.
The length is displayed at the bottom of the view, and

anchor points are automatically placed at 1cm intervals
for reference.

Other functions:

» Pressing delete will delete the
last, or currently selected anchor.
If a middle anchor is deleted, the
previous and next anchors will
automatically be joined.

e Clicking between two anchors will
create a new anchor between the
other two.

76.2 mm * Click-dragging any anchor will move
that anchor along the surface

Brainsight“ USER MANUAL v2.5

B: Spline mode:

Click on the surface to drop anchors at the location of
each click to create complex curved splines. Each spline
can be repositioned by click-dragging it.
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Fig. 5-9

Custom View control window:

You can customize what is displayed in any 3D Image View using
this window (accessed by selecting customize... in the view
selector popup menu button):

3D Planes: Allows you to view the brain through one or
multiple 3D planes.

Reconstructions: Allows you to select one or more 3D
reconstructions generated from the 3D reconstruction step.

Accessories (in an Online Session): Allows you at add and track
3D representations of various objects, including the cursor, coil,
trackers and the Polaris field of view.

oCe

View Selector - Custom View

Name: ‘ Custom View

3D Planes:
Multi-planar reformatting {(MPR)

Sagittal Coronal Transverse
) Obligue
I Inline [ Inline 90 [ Perpendicular
Reconstructions:
Show ‘ Name ~
[m] Curvilinear Brain
O skin
Accessories:
Show ‘ Name ~
J  calibration Block
[m] Coil Tracker
O Large Coil Tracker
[m] Painter
O Polaris camera
] Polaris field of view
(]} Subject Tracker
(] Tool Tracker

Brainsight WEEE  USER MANUAL V2.5

Fig. 5-10
Inspector tool:

When creating overlays, curvilinear surfaces, ROIs and motor
maps, it is often convenient to change certain properties at
different times. For example, you may wish to change he
curvilinear peel while picking a target, or changing the overlay
opacity. Rather than having to go back to the relevant steps to
change these, the inspector button allows you to bring up a
window that allows you to access and change many of these
settings at any time, in any step. Clicking on the Inspector button
(the blue circle with the "i" in the middle) calls up the inspector
window.

A: Curvilinear surface inspector

4 Inspector

Curvilinear
Curvilinear Brain

Peel depth Depth

6 mm

B: Overlay inspector

© Inspector

Show  Name Value

m  fmri_resampled

Opacity: r
O T e
Threshold: —L |
8]
5.0 10.7
Copy Legend to Clipboard

P

C: Region of Interest Inspector

(motor maps are described in TMS manual)

8eoo ' Inspector

= S ELE

Show | Name

i  Region Paint 1

Opacity:




B [ Copy of Sagittal

H 8 [ Copy of Sagittal

B [ Copy of Sagittal

H B | Copy of Sagittal
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Fig. 5-11
Using the clipping box to clip an object (e.g. skin).

A: Move the walls of the box by dragging the
spherical handles (click-dragging).

B: The upper wall was dragged down into the head.

C: The head is cropped according to the bounding
crop box.

D: The crop tool is deactivated (be selecting the smart
cursor tool) leaving the cropped object. Note that the
box only applies to the object selected. Other objects
inside the skin would remain whole unless another
crop box is invoked and changed for it.



For many years, neuroscientists have used a
common coordinate grid (often referred to as
“stereotaxic space") to localize their regions of
interest (e.g. anatomical areas, or functional
regions) so that data from multiple subjects could
be combined or compared on a standard template.
This is accomplished by mathematically aligning
the coordinate grid of each brain using common
anatomical references and using the brain's size to
scale the grid accordingly. The result is the ability
to associate homologous anatomical regions

of any brain to a common coordinate. The first
stereotaxic coordinate system to gain mainstream
acceptance was the Talairach and Tournoux atlas.
They created an atlas from a single human brain
specimen by cutting the brain into regularly spaced
slices (and fixing them to slides), labelling the
slices for various anatomical regions and superim-
posing a coordinate grid on them. Using coordinate
space mapping techniques, any individual brain
can be mapped to that common grid along with

any data recorded associated with that brain. More
recently, an improved version of the Talairach
brain, the MNI brain, was developed based on a
model brain composed of an average of many
individual brains mapped to that common space
(instead of an individual brain). In many papers, it
is common to report findings in “Talairach space”or
“MNI space” to allow others to easily use these
findings. The differences between Talairach and
MNI space is beyond the scope of this manual.
Several reports exist in the literature that compare
the two as well as the various methods that are
commonly used to calculate these registrations
(@and how they are interrelated).

Brainsight provides tools to co-register your
subject’s brain images to the MNI and Talairach
coordinate spaces. This step is only required if you
wish to use MNI or Talairach coordinates to define
targets, or to export sampled coil coordinates

in MNI or Talairach space.

Chapter 6: Prepare: MNI/Talairach Registration

Fig. 6-1

MNI/Talairach Atlas Registration Manager

800 Untitled

An atlas registration (ex: MNI/Talairach) lets one describe the location of brain structures
the si E i ual brains.

independent from differences in the size and shape of individual brai

Atlas spaces:
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New... Remove View
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INTRODUCTION

This step is only required if you are using subject specific
MR images. This step will allow Brainsight to map the
initial 3D coordinates of any NIRS cap (which are stored
in MNI space) to be mapped to the subject's scalp as seen
on the MR images.

The relationship between the native MR images and
Talairach space can be represented in many ways,
depending on the type of transformation. Currently,
Brainsight supports a linear transformation (translation,
rotation and scaling), which can be represented by a
single 4x4 matrix. You can either use a pre-existing
transform from another program (e.g. MINC tools or
SPM), or perform the procedure manually here. If you
have a pre-exiting transform, then it is advisable to use it
here instead of the manual tool to maintain consistency
between the coordinates obtained using your favourite

Chapter 6 > Prepare-MNI Registration
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analysis software and Brainsight. Use the Brainsight
tools only if you do not already have a registration matrix
derived from your preferred software.

Note: As updates to Brainsight are released, transforma-
tions from a wider variety of software programs will be
added. Please let us know which ones are important to
you. Itis important to understand the utility as well as to
temper expectations of the overall accuracy of employing
a linear transformation for the mapping. In practical
terms, one should not expect better than a few mm in
mapping accuracy.

You can perform more than one registration, and select
or change which one to apply at any time. If you have
already performed this step using another software
application (e.g. SPM or MINC tools), then you can save

e00 Unitied - Ml (AC-FC-bo)

i

Fig. 6-2

Initial Manual MNI Registration Window.
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time and maintain consistency by using that matrix as
described in "Loading a pre-existing matrix", otherwise,
perform the manual registration.

MANUAL MNI REGISTRATION

In addition to supporting registration from SPM and
MINC tools, Brainsight includes a manual registration
tool. The manual registration tool will require you to
perform a few steps to enable the software to calculate a

[-NaNa)
=y

AC/PC| Box

linear transformation to map between the subject's native
MRI to the reference Brain (MNI Brain). In the first step,
you will identify two well-established brain structures,
the anterior and posterior commisure (AC & PC). This will
be used to rotate the brain image to align it along the

AC-PC plane (correcting for tilt and twist rotations). The
second step will be to tell the software the overall size of

Fig. 6-3

MNI registration step with AC & PC identified.

Untitled - Manual (AC-PC-box)

click the “Set PC” button. Once both are well positioned, go to the next step,

Layout: | 3x1 1)

Move the crosshairs to the centre of the anterior commissure (AC), then click the “Set AC" button. Next, move the crosshairs to the centre of the pesterior commissure (PC) and
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the brain by moving the walls of a box to the edges of the
brain in the lateral, vertical and anterior-posterior (AP)
directions. These distances are compared to the width

of the reference brain to calculate the correct scaling
factors in the 3 directions. This information is enough to
calculate a basic linear fit.

Select Manual (AC-PC-box) from the New... popup menu,
the MNI registration task manager will appear (Fig. 6-2).

Move the cursor to the centre of the anterior
commisure (AC) and click Set AC.

* Move the cursor to the centre of the posterior
commisure (PC) and click on Set PC.

Adjust either (if needed) by moving the cursor to the
desired location and clicking either Set AC or Set PC
again (Fig. 6-3).

e Click on Next Step.

e Correct for head tilt (if any) by moving the Alignment
slider while observing the coronal image. Set the
alignment so that the vertical green line follows the
midline between hemispheres.

 Set the size of the bounding box to the outer Llimits
of the brain on the AC-PC axis. Pay special attention
to the coronal view for setting the left/right and
superior/inferior limits and the transverse for the

anterior/posterior limits (see Fig. 6-4). Note that the
sagittal view is not helpful because the outer perim-
eter of the brain is surrounded by the sagittal sinus.

The sagittal image should be ignored.

* Click Update. In a moment, the registration will be
calculated and the ICBM 152 average brain will be
warped and overlaid on the MR images. Examine
the quality of the fit visually by:

e Drag the lower threshold control to the right a
bit to remove the background colour and better

Fig. 6-4
MNI registration step with set brain boundaries. Focus your
attention on the upper, lower and lateral bounds of the coronal

slice, and the anterior and posterior bounds of the transverse
slice.
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see the outer perimeter of the model brain )
(displayed using the JET colour scale)

» Change the opacity back and forth repeatedly to
better evaluate the fit. By swinging the opacity
back and forth, you can flip between the original
brain and the reference brain and gain an
appreciation of the fit.

e You can interactively adjust the bounding box and
click Update to adjust the fit until a reasonable fit is
obtained.

e Click Finish to complete the task.

Note: The registration procedure is meant to calculate
the native to MNI space calculation. Both the MNI and
Talairach coordinates can be used.

LOADING A PRE-EXISTING MATRIX

If you have the file containing the registration matrix
(MINC tools), choose From .xfm... from the New popup
menu button, and select the file, otherwise choose From
Matrix. Note that a window displaying anatomical images
with the ICBM 152 average brain (warped using the
loaded matrix) will appear (Fig. 6-5). The actual matrix is
also displayed on the top left of the window.

If the overlay does not match the anatomical data
(particularly if it does not agree with how it looked in
your other software), then you may need to manipulate
the matrix. Currently, you can invert and/or transpose

Brain L NRS ]
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the matrix (by clicking the Invert or Transpose buttons)

or edit the matrix manually by typing in the numbers
directly.

A NOTE ABOUT MNI AND TALAIRACH SPACE

When using "normalized" space coordinates, it can be
very easy to get confused. In the “old days", Talairach was
the coordinate space used. More recently, a modernized
version of the normalized space was developed by the
International Consortium of Brain Mapping (ICBM) to

try to develop a brain more representative of the overall

eNno Untitled - Matrix

population (Talairach was based on a single individual
brain). This group developed the "MNI" brain, which was
created by co-registering multiple brains (imaged using
MRI) into a common Talairach-Llike space.

In Brainsight, the entered registration, be it by matrix or
performed manually is assumed to be to the MNI space.
We have implemented the formula proposed by Fox et.
al. (ADD REF!) to convert from MNI to Talairach space for
compatibility reasons.

Name:  Matrix

Layout: [ 2x2 e

Registration Matrix:
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Fig. 6-5
Verification screen for MNI registra-

tion. Registration matrix is shown at
the top Lleft.




Chapter 7: Prepare: Image Overlays

In addition to using MNI or Talairach coordinates,

Fig. 7-1

Overlay manager.

you can load functional or other anatomical data,
(e.g.a T2 MRI) to overlay them on the anatomical

MRI. You can also overlay an Atlas and warp it el stitie
from it's MNI reference space to the native shape of
the subject. R P e D
Overlays:
Name Scan date: -
Scan type: -
Image size: -
A

Click on Configure Overlays... to add or edit overlays.

ADDING FUNCTIONAL OR ANATOMICAL OVERLAYS

Overlays are simply volumetric data sets that have some
intrinsic meaning to you. In the case of functional or
anatomical data, the data should be in the native space
of the subject.

* To add a new overlay, click Add.... Select the image
file (using the same rules for the different file
formats as was applied for the anatomical image
data as described in Chapter 5.

e The file needs to have been co-registered using
another software program (and either re-sampled,
or the registration matrix exported to be entered
here). Select the registration method used:

e |f the data set was re-sampled to match the

Chapter 7 > Prepare-Image Overlays



2

Brain

anatomical, select "none" as the registration.

* If the method stored the registration to the
anatomical images in the header (as is sometimes
done with MINC and NIfTl), select “from headers".

e |f @ matrix is used, select "Matrix..." and enter the
matrix manually, or by loading a supported matrix
file format (only MINC xfm files at the moment).
When entering a manual matrix, take special care
to ensure that the matrix is correct by observ-
ing the orientation and fit of the overlay on the
anatomical images.

 For BrainVoyager images, select the .vmp (versions
1-6) file which has been co-registered to the
anatomical images, and select “from header” as
the registration. As with BrainVoyager anatomical
images, use the AC-PC aligned (but not scaled to
MNI space) images.

» For an atlas file, use From current MNI registration
(see next section)

Set the threshold of the images. The checkboxes at
either end of the Threshold slider allow you to either
show or hide the data beyond your set threshold. If
shown, what is either above or below your threshold
level (depending which checkbox is unchecked) will
be shown as a solid colour from the extreme ends of
your LUT (e.g. blue would represent all data below
the chosen threshold, and red would represent all
data above a chosen threshold). Note that Brainsight
does not support showing both positive and negative

WL  USER MANUALV2.5

Fig. 7-2

Overlay window
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changes in response at the same time (yet). You can * In this version of Brainsight 2, the atlas must have between adjacent atlas regions).
work around this limitation by loading the overlay 256 indexed regions or less. This will be improved
twice and setting the thresholds to display the upon in a future release.

positive on one, and the negative on the other.

¢ Select "Using atlas space” as the registration method.
This is disabled if you did not perform an MNI

To load an atlas as an overlay: registration. If you performed more than one atlas
 Select the desired lookup table (LUT) using the LUT « Click add... and select the atlas file using the file registration, select it from the popup menu under
popup menu button. selection dialog that is shown. the registration method popup menu.

 Set the desired opacity of the overlay using the
opacity slider.

* Once loaded, select "Atlas” as the LUT (it is an

indexed colour table to maximize the contrast Fig. 7-3
You can load multiple overlays, and select which ones
you want to be visible by default by enabling/disabling Overlay window with atlas

®NO Untitled - Overlays

the visible checkbox next to each entry. You can also

o o e e i the e ey (T o
change the order of overlays by dragging the images in % Bl
the Llist around to set the desired order. When finished,
close the overlay window by clicking on the close button Q
=2

at the top left of the window.

LOADING AN MNI ATLAS FOR OVERLAY

You can load and overlay an Atlas however there are a
few requirements: (dd ) (Remove)

File: @ brodmann.mnc

Opacity: e Qe

* You need to perform an MNI registration (see

Chapter 6) so the software knows how to transform
space to/from MNI space.

* The Atlas file needs to have defined the transforma-
tion from the image voxels (voxel space) to the MNI
space, stored either in the header or as a separate
transformation file. Atlases in MINC format usually
have this embedded so they should work. Other
formats (e.g. NIfTI) will need to be validated first.

™ Show anatomical data Overlay value: -0.0

& Value

Tue Jan 13 18:42:00 2004> >> /data4/ramseydatools MItools/ MINC/compiled minc-1.0-linux-rh?.1/bin/ rawtominc -zyx -float -ofloat -xste... ()
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e Select MNI or Talairach to identity the base coordi-
nate system for the atlas.

« \Verify that the Atlas overlays correctly on the
anatomical images. Note that Talairach atlases may
have a poorer registration quality as it undergoes
an additional transformation from Talairach to MNI
space before being transformed from MNI to the
subject's native space.

4 Brainsight“ USER MANUAL v2.5



INTRODUCTION

In previous versions of Brainsight, the 3D
segmentation tool combined two steps of

building 3D representations of objects

“painted” from the MR data: Region painting

and 3D reconstruction. Brainsight 2 breaks up
these two steps to make better use of the voxel
painting tool (ROI, or region of interest painting
tool) for other purposes. For example, one might
use the ROI tool to identify particular regions as
seen on an atlas to highlight them in the 2D views.
Once the region has been painted, it can be treated
as any overlay and displayed in any of the planes.
It can also be exported as a NIfTI file for use in
other analysis and display software.

Chapter 8: Prepare: Region of Interest (ROI) Painting

Region painting refers to the process of segmenting the
region you are interested in (e.g. the skull, or a particular
brain structure) from the surrounding data by labelling it
somehow (e.g. painting image voxels) as illustrated in Fig.
8-1 A. 3D reconstruction method can take this labelled
data and create a 3D surface (3D mesh) to be displayed
and manipulated as a discrete object (Fig. 8-1 B).

Fig. 8-1

A: Example of a painted Region of Interest (ROI).

CXaYe)

B: Example of a 3D
surface representation

of the edge of the ROI
using the “Surface from
ROI" described in the next
chapter.

Chapter 8 > Prepare-Region of Interest Painting



Brainsight 2 currently supports region growing (we call
it a threshold/seed operation) and manual painting to
create and edit ROls. The threshold/seed tool is useful if
your structure of interest contains a distinct region that
can be isolated by selecting an intensity range. Think

of the seed tool as a persistent flood fill (often called a
paint bucket) tool, which spreads “paint" to all connected
voxels that fall within the threshold intensity range. You
typically set an intensity range for your structure then
drop a seed in the structure. The seed will initiate a fill
operation (region growing) at the seed location. You then
go to the next slice, and the seed will follow you to that
slice, and initiate a fill again. The seed is smart enough to
search a small area for the threshold if it lands on a new
slice outside of the threshold area (this can happen if the
shape of the structure changes from slice to slice).

The manual painting tools can be used to delineate areas
that are not strictly intensity based, or where the seed/
threshold either missed a spot, or filled into an unwanted
area (despite being within the threshold bounds).

For example, the skin reconstruction can usually be
performed automatically because there is a large differ-
ence in intensity between the skin and surrounding air.
The brain can also be isolated (mostly) except in regions
where there might be structures with similar intensity
ranges that exit the brain cavity into other areas (e.g.
optic nerves). In these cases, you would let the seed(s)
apply to the slice, and use the paint/erase tools to edit
the results to conform to the structures.

Brainsight" USER MANUAL v2.5

CREATING AN ROI

This section will cover creating an ROl and explain the
use of the tools as they are needed. To create an RO,

select the ROls tab at the top of the project window then
click New ROI from Region Paint. The region paint window
will appear (Fig. 8-3). The window will have a layout with
4 image view panes. The larger view is the painting view,
while the other 3 are for location reference. Clicking in
the 3 smaller views will move the cursor. Clicking in the
paint view will perform an operation that depends on the
currently active tool.

If your structure can be isolated by a range of image
intensities, then:

1. Set the orientation in which to paint by selecting it
from the orientation popup menu of the painting
view. You can change orientations anytime and
continue painting in the other slice (although that
can get confusing).

2. Optionally, click on Smooth data set to apply a
5mm Gaussian smoothing kernel to paint from a
smoothed version of the data. This will reduce sharp
edges but will also blur out small structures.

3. Use the threshold sliders to set a range of intensi-
ties that help isolate your structure of interest. The
voxels that fall within the upper and lower threshold
bounds are referred to as the isolated voxels, and are

Fig. 8-2

ROI manager. Note that the volume is shown for each ROI.

An ROI (Region of Interest) is an area segmented from a data set that identifies a specific region of
the brain. New ROIs can be created using the “New ROI from Region Paint" button.

ROIs (Regions of Interest): Q

Name Volume (mm’)

Region Paint 1
Region Paint 2 161175.0

( Export... ) C Remove _) (_ View )




displayed in purple (you can change that colour by
clicking on the colour indicator box and selecting a
new colour using the colour picker, and the opacity
using the opacity slider). See Fig. 8-3.

Select Seed (among the painting tools as shown
in Fig. 8-5) and click in the region of interest. The
result will Look Like Fig. 8-4 B.

If the structure of interest consists of multiple
disconnected regions that are isolated using the
threshold values, add seeds to those regions by
clicking in them.

If a region that is not isolated by the threshold
values exists, you can use the Pencil and Fill Region
tools to include it manually. Select Pencil, and

draw the border of the region (Fig. 8-4 C). Select
Fill Region and click in the middle of the region to
fill the region (Fig. 8-4 D). Note that you can avoid
clicking back and forth between the Pencil and Fill
tools by remaining in the Pencil tool, and flood fill
by option-clicking where you want to fill.

To exclude a region that was mistakenly included,
select Eraser, and use it to delineate the “offending”
part from the rest of the painted region, then use
the Erase Region tool to clear the region by clicking
on the isolated paint region. Note that as with the
Pencil and Fill tools, you can remain in the Eraser
tool, and option-click the region to apply the Erase
Region to it.

Painting Tools

Painting View

Isolation Controls —

Paint Attributes —

Slice Navigation —{ ¢
ROI Statistics —

Fig. 8-3

Region paint tool. The area in purple
isreferred to as the isolated region. It
represents the voxels in the displayed
slice that fall within the threshold
range set using the threshold sliders
which are part of the isolation
controls. The painted region is shown
in orange (in this example) and is
generated by a seed being dropped in
a thresholded region.

Fig. 8-4

Region painting Tool, using seed/
threshold and line pencil/fill regio
methods. eraser/clear region work
the same way as the pencil and fill
except they erase painted voxels.
Note that the fill and clear region
tools use the painted voxels to
define the boundaries, NOT the
thresholed voxels.

Chapter 8 > Prepare-Region of Interest Painting



8. Once the region has been painted, proceed to the
next slice by clicking Next Slice or Previous Slice.

9. Notice that any seed in the last slice is propagated to
the new current slice and applied to paint the slice.
Add seeds as needed and manually add/remove
painted regions as in the previous steps.

10. Ifyou find that after several slices that you have too
many seeds (e.qg. disconnected structures in previous
slices are now joined, or the seeds have migrated to
unwanted regions), click Remove All Seeds to clear
the seeds, and then click Erase All Paint in Slice to
clear the slice and start fresh.

11. Once you have painted the entire region, close the
window. This is probably a good time to save your
project.

Note that during this process, you will almost certainly
click on something you did not want to, losing the work
you just did. To Undo the last operation, simply select
Edit->Undo (Cmd-Z). You can backtrack several operations
if needed.

EXPORTING AN ROI

Once you have created an ROI, you may find it useful

to export it into a volumetric image file for use in other
applications. For example, you might find the drawing
tools to be useful in generating regions of interest for
ROI-based analysis (e.g. for probabilistic tactography).
Once the ROl is complete, click Export.... Once the save
file dialog appears, navigate to the desired folder, enter a

Brainsight“ USER MANUAL v2.5

Fig. 8-5

Close-up of ROI tool listings.
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~¢——————— Cursor Tool

—— Pencll

~—— Fill Region

————— FEraser

~—— Erase Region
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file name (the name of the ROl is used as a default name)
and click Save. The file will be saved as a NIfTI (.nii) file.
using the anatomical data set as the template for the
voxel size and image orientation.

Conceptually, the Pencil/Eraser and Fill Region/
Erase Region tools are opposites of each other. The
Pencil and Fill region delineate voxels while the
Eraser and Erase Region clear voxels.



Chapter 9: Prepare: 3D Reconstruction

3D reconstruction is the operation of creating

a 3D surface for the purposes of display. These

3D objects can be painted with a solid colour or
texture consisting of the image voxels intersect-
ing the surface (see curvilinear reconstruction).
Brainsight currently supports several reconstruc-
tion methods: The automatic skin, automatic
curvilinear, and reconstructions derived from
overlay data sets and ROIs. 3D surfaces generated
from 3rd party software can also be imported and
visualized.

Fig. 9-1

3D reconstruction manager.

®00 Untitled

A Reconstruction is a 3D rendering of a data set. Examples are a skin segmentation and a curvilinear
reconstruction. New Reconstructions can be created using the *New.." popdown menu.

e
Reconstructions: ICY )

Name

New... ( Export.. ) ( Remove ) ( View

4,

3D reconstructions are performed for many purposes.
First, a skin reconstruction is performed to simplify the
identification of anatomical landmarks for the subject-
image registration (Chapter 16). Second, a 3D brain
reconstruction is performed to simplify target selection
and provide a more intuitive view of the brain (and scalp)
while placing the coil during a TMS session. Finally,
reconstructions from regions of interests or ROIs can
create 3D representations (e.g. functional activations,
specific anatomical structures) of information that may be
relevant to your particular protocol.

PERFORMING A SKIN RECONSTRUCTION

e From the reconstruction manager pane of the project

Chapter 9 > Prepare-3D Reconstruction
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window (Fig. 9-1), click on New... and select Skin. An
image view window will open.

* |fneeded,setthebounding boxtoencompassthewhole
head by dragging the boundaries with the mouse.
Note to earlier Brainsight users, this is in contrast
to previous versions where you were instructed to
exclude the scalp. Include the scalp as the software
uses it to evaluate the subject-image registration
(Chapter 16) and you will crop it later using the 3D
Crop tool (see “3D Crop Box" on page 42). You
might leave part of the bottom out to have a “clean
cut" bottom if the intensity of the MR image drops off.
Otherwise, the head may look "ghoulish”, although
this is an aesthetic recommendation (see Fig. 9-2).

 Set the colour to your desired setting by clicking on
the colour box, and selecting the colour using the
palette that appears.

If needed, adjust the threshold to isolate the head
vs. the surrounding air (and MR noise) as much as
possible.

Click Compute Skin. The skin object will appear in
the top left view shortly (Fig. 9-3).

If the results are not satisfactory, adjust the thresh-
old and recompute the skin again.

Once the desired skin has been created, close the

Brain WL  USER MANUALvV2.5

Fig. 9-2
Skin segmentation step with head properly cropped.
®00 Untitled - Skin
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Fig. 9-3
Completed skin.
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Skin/Air threshold:

("Guess Threshold )

window by clicking the close button (top Lleft button)

CREATING A CURVILINEAR RECONSTRUCTION
OF THE FULL BRAIN

Many software programs represent a 3D brain as a
surface mesh much in the same way we generate the

3D skin (see Fig. 9-1 on page 59). While this often
provides a good representation of the brain surface, it

has drawbacks in the context or TMS. First, TMS does not
only stimulate the brain surface, but potentially the entire
thickness (approximately) of the cortical ribbon. Second,
if you want to use fMRI as a target, it is important to be
able to visualize the location within the brain where the
activation is recorded (many surface based models project
the fMRI to the cortical surface, effectively moving the
target).

The curvilinear reconstruction is designed to provide you
with a 3D representation of the entire cortical ribbon, by
creating a representation that can be interactively peeled
to different depths, much Llike peeling the layers of an
onion.

To create a curvilinear reconstruction:
¢ Click New... and select Full Brain Curvilinear.

e The default settings are typical values. You can
change them if you wish. Note that in contrast with
Brainsight 1, the settings here are a bit different.
Instead of start/stop depths and spacing, simply



enter the end depth and spacing. (The start is
now assumed to be 0 mm). Typical values are a

stop depth of 16mm with a slice spacing of 2mm,
however you are free to change them to your
preference.

* Click Compute Curvilinear to generate the curvilinear
surface. The process can take up to one minute
depending on your computer.

e Once the brain has been generated, rotate it to
examine the brain surface, and use the peel slider to
peel the surface to different depths.

* |fyou previously loaded an fMRI overlay, you will also

Fig. 9-4
Curvilinear surface “peeled” to reveal fMRI peak.

@®no roject for 2.1.1 - Curvilinear Brain

Name: | Curvilinear Brain

Layout: | 1x1 B
(@) () (Curvilnear Brain 5]

et st ———— [
£

12.0 mm

Slice spacing: (2.0 | mm

End depth: [16.0  mm

CH

see it overlaid. Change the depth again to see where
the peak occurs (Fig. 9-4).

* Close the window by clicking on the close button at
the top left of the window.

Fig. 9-5
Adjusting the crop box to help the automatic

curvilinear algorithm

IF THE RECONSTRUCTION DOES NOT WORK:

The automatic curvilinear reconstruction is designed

to work without requiring any user input. Occasionally
though, the algorithm will fail. Without going deep into
the implementation of the algorithms, one of the causes
of failure is an error in determining the approximate
centre of the brain (which is the starting point for the
algorithm). This can be corrected by adjusting the bound-
ing box to delineate the brain from the rest of the head.

800 Unititled - Curvilinear Brain

Name: |Curvilinear Brain

Layout: [2x2 18]

Slice spacing: 2.0  mm | ) Curvilinear Brain

e

End depth: 160 mm

Peel index: [

0.0 mm

o= [@ )

(Compute Curvilinear ) 2
ik “Compute
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®no Untitled - Region Paint 1

This is particularly helpful in cases where the image ‘
acquisition is in the sagittal plane with large field of views e

Isolation colour: | I

(so there is a Lot of neck in the field of view). To adjust the
starting point:

* Move the edges of the box until the brain is de-
lineated (Fig. 9-5)

e (lick Compute Surface again and view the results

* |f this does not help, you can create a curvilinear
from an ROI; see the next section

CREATING A CURVILINEAR SURFACE FROM AN ROI
(FOR SMALLER STRUCTURES)

In most cases, the automatic curvilinear surface will meet
your needs. In some cases however, it may be desirable

to perform a curvilinear surface on a subset of the brain
(e.g. cerebellum) or when the automatic curvilinear

reconstruction failed. In these cases, you can create a Fig. 9-6
curvilinear reconstruction based on a region of interest. g.

ROl of a the Cerebellum (top) and the curvilinear
surfaces derived from it (below) using various smooth-
ness values.

For example, you can use the region of interest tool to
paint the cerebellum.

To create a curvilinear surface based on an ROl

e Use the ROI tool to segment your structure (see
Chapter 8).

e Click New... and select Curvilinear from ROI.

e Select the ROl to generate the 3D surface from (if

you have multiple ROIs) and set the step size and
end depth. For smaller structures, a step size of 1mm

+ Brain WL  USER MANUALvV2.5



and end-depth of 10mm might be more appropriate
than the defaults values.

e Click Compute Curvilinear, wait for the process to
complete, and view the results in the 3D view.

« If the surface appears too spherical (see left of Fig.
9-6), then the smoothing setting was likely too
high. Lower it by dragging the smoothness slider
to the left a couple of notches, then click Compute
Curvilinear. After a moment, the change will appear
in the 3D view.

e If the surface was too rough (middle of Fig. 9-6) then
increase the smoothing by a notch or two by moving
the smoothness slider to the right and click Compute

Curvilinear again.

e The expected result is shown on the right of Fig. 9-6.

CREATING A 3D SURFACE FROM AN OVERLAY

To create a 3D representation based on an overlay data
set:

* Click New..., then select Surface from Overlay to open
the surface creation window.

 Select the overlay to generate the 3D surface from (if
you have multiple overlays).

e Set the lower and upper thresholds to the desired
value to delineate the desired intensity range.

* Click Compute Surface, wait for the process to
complete, and view the results in the 3D view.

Fig. 9-7
Screenshot of the surface from
overlay function.

T
Name: | Surface Layout: | nu 2x2

Data set: fmri_resampled.mnc © ~ Surface

Colour: |
Opacity:
Smeothness:

Pieces: Keep only largest piece

&8s

Blending: Blend in overlays

Threshold:

Untitled - Surface

v J Coronal

Choose a data set to base the reconstruction on.
Adjust the bounding box so it encloses the
desired part of the volume. Adjust the threshold
slider so that the desired region is purple, then
click *Compute Surface” and wait. View the
resulting surface in the 3D view. If the resuits are
not satisfactory, readjust the various settings and
click "Compute Surface” again.

~ J Sagittal

~ | Transverse
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* Verify that the surface is acceptable. Change the
threshold or smoothness parameter if needed and
click Compute Surface to update it.

* |f the overlay is noisy and you obtain a Lot of small
objects and only expect (want) the largest one,
enable Keep only largest piece and click compute
again.

* The colour can be selected by clicking the colour
button and then the colour from the resulting colour
picker window. Enabling Blend in overlays will have
any overlays turned on be painted on the surface.

If you cannot isolate your structure solely using an intensity

range, cancel this process by closing the window (do not save the
surface) and use the ROl tool to delineate your structure and see

the next section on creating a surface from ROI.

CREATING A 3D SURFACE FROM AN ROI
Creating a surface from an ROl is simpler than creating a
surface from overlay.

e Click New... and select Surface from ROI to open the

surface creation window.

o Select the ROl to generate the 3D surface from (if
you have multiple RQOls).

¢ Click Compute Surface, wait for the process to
complete, and view the results in the 3D view.

o \erify that the surface is acceptable. Change the
smoothness parameter if needed and click Compute
Surface to update it.

Brain WEEE  USER MANUAL V2.5

Fig. 9-8

Surface created from an ROI.

®00
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IMPORTING 3D SURFACES FROM OTHER SOFTWARE

Brainsight can import surfaces saved in AutoCad (dxf), eno L For 21 Manual -
polygon (.ply) and stereolithography (.stl) format. It is e @gz
important that the coordinate system of the mesh be in jﬂ;ﬁ;m=0

the anatomical image's Brainsight coordinate system. M AN

Otherwise, the location of the objects will be incorrect. To 3

import a surface:

Compute Surface

e Click New... and select Import from File...

» Select your surface file from the file selection dialog
and click Open.

Brainsight 1.7 users can take advantage of this by using
the STL export feature in 1.7 to export a surface and

import it into Brainsight 2.

EXPORTING 3D SURFACES

Although this function was mainly created for our veteri-

heve e 5) (B8 | @ fIQ % | (Coomven® vy oo /18] (D) »

nary neurosurgical application, it might be useful to note Fig~ 9-9

that any 3D surface created (except curvilinear surfaces) Above: Surface created by an ROI.
can be exported as AutoCad™ drawing interchange
format (dxf), Polygon (ply) as well as in stereolithography
(stl) file formats. 2

Right: Same surface imported into a CAD application.

To export a 3D surface:

e Select it from the List surface of 3D surfaces shown
in the reconstruction manager window.

e (lick Export...

e Select the file format to use from the format popup
menu, enter a file name, navigate to the desired el

folder, and press Save.

Chapter 9 > Prepare-3D Reconstruction
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As explained earlier, the subject is co-registered
to the images at the start of a TMS session. This is
accomplished by identifying a series of anatomical
landmarks on the images and on the subject. This
chapter describes how to identify them on the
images.

Chapter 10: Prepare: Selecting Anatomical Landmarks

Good anatomical landmarks must abide by a few rules.
First, they must be non-ambiguous, so a point in the
middle of the forehead, for example, would not be good.
They also have to be in the same location during the TMS
session (with respect to the brain) as they were during the
scan. That means they have to be rigid, so the chin would
not be good. We recommend the following points as good
landmarks:

e Bridge and tip of the nose.
* The notch above the tragus of the ears.

e The outer canti of the eyes (if one of the above points
are missing).

We do not recommend the tragus itself because earplugs
may deflect it during the scan. To record the landmarks:

 Click Landmarks in the project window. The

Fig. 10-1

Landmarks manager

800 Untitled

Registration landmarks are special points that are easily locatable both on a subject’s actual head and
the corresponding anatomical data set. They are needed so that the Polaris camera can be used.

Registration Landmarks:
Name
Nasion

Configure Landmarks...
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landmarks manager pane will display any

landmarks created earlier, otherwise it will show an F|g 10-2
empty list (Fig. 10-1). Landmark entry window.

* Click Configure Landmarks... to open the landmarks ®Nno i o e e e
window (F\g 10‘2) :;:Iieu" = News) tayout: (22 [%)

-

Remove ) (| [+] [ Skin & All Landmarks = Sagittal & All Landmarks

* Rotate the 3D skin until you have a good view of

the nose, particularly the nasion (top of the bridge). P S
Click on it in the 3D view to move the cursor to
that location. Note that a translucent green sphere ;f
identifies the cursor location in the 3D view. =

e QObserve the location in the transverse, sagittal and
coronal views. Adjust the location by clicking in the
3D or any of the 2D slices until you are satisfied with

the location.

Name: | Nasion

¢ Click New to record the name.

2D Size: 5.0 | mm v J Coronal & All Landmarks » J| Transverse & All Landmarks

3D Size: 5.0 mm

Note that the name field is highlighted so you can

] ) Colour: ||
enter text that will overwrite the default name. Type Shape: (Sphere %)
in “Bmdge of NOSEH, or "Nasion". ( Move Landmark to Crosshairs Origin )
* If desired, you can change the colour, size or shape
of the recorded landmark. For clarity, we recommend
leaving it as is unless you have a reason to change it.
* Move the mouse to the tip of the nose, and perform el oo
. - M of the nose 2) the nasion 3) the
the same steps as for the nasion. Call it "Tip of Nose ’ 2 Bt T i
L ) = crosshairs  to  the correct
(the reason we use explicit, long winded names as location and elick ‘New”.

opposed to TN or BN will be apparent later).

Repeat for the left and right ears. Refer to Fig. 10-3
for examples of the landmarks.
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* |f one of the landmarks illustrated in Fig. 10-3 are
missing, consider adding the outer canti of the eyes.
They are relatively unambiguous and rigid (Fig.
10-4).

¢ Once all the landmarks have been recorded, close
the window.

Fig. 10-3
Examples of reliable lLandmarks.

Pay particular attention to the notch above the tragus.

Ear (notch above the tragus)
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Fig. 10-4
Extra landmark: Outer canti
of the eyes.
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Chapter 11: Selecting Targets for Stimulation

The targeting step is optional in NIRS, and has
more roots in our neuronavigation for TMS than
for NIRS. Nevertheless, there may be occasions
where defining a specific point or array of points

on the cortex or scalp may be useful in judging the
best Locations for optode placement. In addition,
you may be performing a combined NIRS and

TMS experiment. For both these possibilities, this
chapter describes how to define targets based on
anatomy, image overlays of MNI coordinates and

to use the grid tool to simulate the placement of a
patch to hold an array of optodes. This array can be
used as targets for optode placement at the start of
the NIRS session to ensure that the optode patch is
placed correctly.

To start the process, click Targets in the project window to
bring up the target manager pane (Fig. 11-2) and then
click Configure Targets... to open the targeting window.

Fig. 11-1

Targets manager.

®00 Untitled

Targets identify locations (and opticnally approach angles) within the brain that are to be stimulated
later during a TMS session.

Targets:

Name [ Type

Configure Targets. .

Fig. 11-2 shows a typical targeting window. In addition
to the typical image views and list of targets on the left,
there are additional controls on the right. The image
views can be set to the traditional transverse, coronal,
and sagittal views, as well as to oblique, inline, and
inline-90 views. Finally, the 3D curvilinear surface (if you
created one) is shown. As with all view windows, you can
change these views as you like. The angle adjustment
tool enables you to change the “approach” angles of

the cursor, which is particularly helpful when defining
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Target Positioning
Tool

® L ] Untitled - Targets
Nom New. @
0 o 8 « Curviinear Brain& Targets @
Toine & Targets [-Y e o0 & Toroets 8 v Skin& Targets 8

Name.

20 size: m

3D size: mm

Colour: NN

Kind:

Shape.

Crosshairs:  Mini TMS Coil 2]

AP Lat Twist

Angle
| Adjustment
Tool

60 | 339 1404

Reference

Surface

Opt
p—

Nudge Origin:

+ J

|__ Nudge

Coordinate System
NifTiScanner @

Crosshairs Origin:

X: -6635  mm
Y 1312 mm
I Crosshairs Offset: 000 z: 6805 mm

Tool

L Coordinates

3D Crosshairs Selector Offset Slider

Fig. 11-2

Typical targeting window.
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trajectory targets.

The targeting window introduces a few new tools (in
addition to those described in Fig. 5-7). First, a new type
of cursor tool, the target positioning tool, is used to adjust
a target location. Second, the Angle adjustment tool
provides a series of slider controls to alter the approach
angles to a target. The Optimize traj. using is a tool to
automatically optimize the coil orientation such that the
orientation trajectory is normal to the selected reference
surface. For example, if you select Skin as the reference
surface, when you click on the brain to pick a stimulation
target, the angles (as displayed in the image views and

in the angle adjustment sliders) will automatically be
calculated to have the coil sit flat on the skin at the exit
point. This optimization occurs each time you click in an
image view. Note it does not do so when you enter coordi-

Fig. 11-3

The different ways to represent the 3D cursor

b

Sphere

nates or use the nudge tool. In this case, click Optimize
Now to invoke the optimizer. You can always override the
optimizer with the angle sliders. The nudge tool allows
you to move the crosshairs up/down along the current
trajectory in small increments. When used in conjunction
with the target positioning tool, you can easily nudge any
target up or down along its trajectory. The offset slider
allows you to temporarily project the location of the
crosshairs from the current location by moving the origin
up and down along the current trajectory. In contrast to
the nudge tool, the offset slider always keeps track of the
original location of the crosshairs and the movement is
relative to that original location. Note how the crosshairs
shows the original location as a a solid line, and the
projected location as a dashed line. If you wish to make

fUS Outline

Stick

Small
TMS Coil

Cone

the projected location the new origin, click Move Target to
crosshairs offset. The 3D representation of the crosshairs
can be changed to be of several preset shapes (Fig. 11-3)
by clicking on the Crosshairs popup menu and selecting
one of the shapes. Selecting the Other... item in that
popup menu allows you to load and use a CAD file as the
3D crosshairs shape. The same file formats as described
in the 3D reconstruction chapter (see "Importing 3D
Surfaces From Other Software" on page 65) can be

used here. The orientation of the object must match that
. Finally, the coordinates
entry tool allows you to select the desired coordinate
system to view and set the location of the cursor using
Xyz coordinates.

described for the coil in
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There are three types of targets that can be recorded.
Marker targets (x, y, z only), trajectory targets (x, y, z and
orientation), or grids (both round and rectangular, and
based on markers or trajectories).

ANATOMICAL TARGETS (VISUALLY IDENTIFIED)

¢ Move the cursor to the desired location on the brain,
using whichever image views are most helpful.

» Note that when you click on the 3D brain (or 3D
skin), the orientation is set using the curvature of
the 3D object set by the Reference Surface popup
button to estimate a “reasonable” approach angle.
For example, select "Skin" as the reference surface
and when you click on the brain, the curvature of
the brain will be used as the initial angle estimate,
however the skin will be examined at that entry
point and the angles will be automatically tweaked
to ensure that the coil face will sit flat on the skin,
ensuring a good coil orientatoin for that target in the
brain. Use the angle adjustment slider controls to
tweak the approach angles if needed.

e Click New..., and select the type of target to create
(Marker or Trajectory).

e Enter a name for the target, and select the size,
colour, and shape to suit your needs.

* |f needed, tweak the location of the target by
selecting the Target Positioning tool, and moving the
cursor. As the cursor moves, the currently selected
(active) target will move with the cursor.

Brainsight" WP  USER MANUALvV2.5

MNI OR TALAIRACH BASED TARGETS

It is assumed that you performed the MNI registration
described in Chapter 6. If not, perform it now.

* Choose the desired coordinate system by clicking
on the popup menu button in the coordinates entry
area of the window, and selecting it from the List.

 Enter the coordinates of the target in the X, Y, and Z
entry fields.

o Verify visually (if possible) that the location appears
correct anatomically.

e If you wish to record a trajectory-based target, adjust
the approach angles using the angle sliders.

* Click New..., and select the type of target to create
(Marker or Trajectory).

COORDINATE BASED TARGET

If you have derived a target in either Brainsight's
coordinate space (see Fig. 18-3) or the anatomical MRI's
World coordinate space (e.g. scanner coordinates found
in DICOM images), you can move the cursor to that
location to create a target:

* Choose the desired coordinate system by clicking
on the popup menu button in the coordinates entry
area of the window, and selecting it from the list.

* Enter the coordinates of the target in the X, Y, and Z
entry fields.

* Verify visually (if possible) that the location appears

correct anatomically.

e |f you wish to record a trajectory-based target, adjust
the approach angles using the angle sliders.

e Click New..., and select the type of target to create
(Marker or Trajectory).

fMRI BASED TARGET

Functional based targets are similar to anatomical
targets in that you create the target by clicking on the
images and recording the location, however, the images
displayed include a functional overlay.

e Ifitis not already being displayed, display the
functional data by opening the inspector and enable
your overlay.

e Follow the steps outlined in the "Anatomical
Targets" section to create and adjust your target.

CREATING A GRID OF TARGETS

In certain protocols, the target may not be a discrete
point, but an array of points over a particular region (e.g.
for mapping a region). Brainsight can create a series of
points or trajectories called a grid. Two types of grids can
be created, rectangular and circular, representing the
method of distributing the nodes of the grid. Creating a
grid is similar to creating markers and trajectories. The
main difference is that you will select the location for the
centre of the grid rather than for the discrete target, and
lay out the grid based on that origin.



To create a grid:

e Select the Smart Cursor tool and move the cursor to
the location that will be the centre of the grid. Make
sure that the orientation of the cursor is normal to
the brain (or scalp) curvature (as seen in Fig. 11-2).
Remember to set the "twist" of the grid by adjusting
the twist slider. The orientation is indicated by the
little arrow at the base of the cursor (try zooming
into the 3D view closely).

e (lick New... and select either rectangular or circular
grid. A grid will appear at the location of the cursor.

e Set the 2D and 3D node sizes and the other node
attributes as you would for a singular marker or
trajectory. These attributes will apply to all the
nodes in the grid.

* |f needed, adjust the location of the grid as needed
by moving the cursor, using the Target Positioning
tool. The centre of the grid will move with the cursor.

Rectangular grid (Fig. 11-5):
¢ Set the number of rows and columns.

e Set the grid node spacing.

e Set the naming scheme. You can select indexed
where the topleft has index (0,0), Symmetrical where
the middle of the grid has index (0,0) with +ve and
-ve indexes, or Alpha/Numeric where the rows are
numeric and columns are letters as found in a
spreadsheet.

e The grid will initially be flat. You can wrap the grid

Fig. 11-4 :
Fig. 11-5
Rectangular grid controls.
Name R New... Rectangular grid.

+ ¥ Rect Grid Remove ese P

Rect Grid (0, 0) of

Rect Grid (0, 1) Go To -

Rect Grid (0, 2) =

Rect Grid (0, 3) Export... ]

il

Rect Grid (0, 4)
Rect Grid (1, 0)
Rect Grid (1, 1)
Rect Grid (1, 2)
Rect Grid (1, 3)
Rect Grid (1, 4)
Rect Grid (2, 0)
Rect Grid (2, 1)
Rect Grid (2, 2) oo Nons B

Snap To... i BT

Name: IRect Gn'd I

2D size: 50 mm

3D size: 50 mm

Colour: E

Kind: Marker

Shape: Sphere 8

Trajectory twist; == 0.0 °
Curvature:

Radius:
Grid size: 5 by 5
Grid spacing: 500 by 500 mm

Maming scheme: Indexed

First, pick the reconstruction you want to snap the grid nodes to (usually
the curvilinear reconstruction). Next, pick a surface to use to orient the
fes (usually the skin i

Move Target to Crosshairs Origin
Snap nodes to: ~ Curvilinear Brain

Optimize trajectory using:  Skin >

Fig.11-6

Effect of adjusting the curvature slider.
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to any 3D surface (e.g. curvilinear brain) using

the snap function. Once you have set the grid size,
spacing and location, click (Fig. 11-6) Snap To.... In
the sheet that appears, select the surface to wrap to
and the surface to use to for trajectory optimization
(see Fig. 11-6).

 After the grid has been placed, you can tweak
individual grid nodes in the same way as any
trajectory. To tweak a node, expand the node list by
clicking the disclosure triangle, then select the node
and use the same techniques described earlier to
tweak the node location or orientation.

You can move navigate the grid by selecting a node in the
list and clicking Go To, double-clicking the node in the
list, or by cliking the navigation arrows.

Circular grid (Fig. 11-8):
» Set the number of rings.

e Set the ring spacing.

e Set the space between the ring nodes by setting
the arc length.

The circular grid consists of concentric circles. Nodes
are placed at constant intervals around each circle. The
distribution method can be set to one of two modes (see
Fig. 11-9). Indexed mode will start around each ring
and travel 360°, creating nodes at arc length intervals
set by the arc length. Numbering will always be positive
and increase with ring number and for each node along
the ring. Symmetric node spacing defines quadrants as

Brainsight“ USER MANUAL v2.5

Fig. 11-7 Fig. 11-8
Circular grid controls. A: Circular grid placed on curvilinear brain surface.
Name - New... B: Circular grid placed on scalp.
« & Circ. Grid 1 Remove
Circ. Grid 1 (0, 0)
Circ. Grid 1(1, 0) Go To
Circ. Grid 1 (1, 1)
Circ. Grid 1 (1, 2) Export...

Circ. Grid 1 (1, 3)
Circ. Grid 1 (2, 0)
Circ. Grid 1 (2, 1)

Snap To...
Circ. Grid 1(2, 2)
Circ. Grid 1(2, 3)
Circ. Grid 1 (2, 4)
Circ. Grid 1 (2, 5) A
Circ. Grid 1(2, 6)
Circ. Grid 1 (2, 7) F|g 11_9
Name: | Cire. Grid 1 I Node distribution for indexed and symmetric grids.

2D size: 50 mm A Indexed grid. Note that in the indexed version, a discontinuity exists

3D size: 50 mm where the distance between the last node on the ring and the first one

Colour: | I is less than the arc length. B: Symmetric grid. Note that the nodes have

discontinuities where the disks meet the horizontal, and that the index
Kind: Marker . )
numbers are positive and negative.
Shape: Sphere
Trajectory twist; s 0.0 °
Curvature:
Radius:
Mode distribution: @ Indexed
Symmetrical

Arc length: 79  mm

Ring spacing: 5.00 mm

Number of rings: 5



shown in figure Fig. 11-9B. Distribution of the nodes
starts at the vertical axis (both at 0" & 180°) and arcs

in both directions away from the starting point placing
nodes at fixed intervals according to the arc length. Each
node will be named according to the name of the grid,
with the ring number (with +ve and —ve values, depend-
ing on the quadrant) and the index number along the
ring appended (both +ve and —ve values depending on
the quadrant).

CREATING A TARGET BASED ON A PREVIOUS SAMPLE

In some instances, you will want to define targets based
on the results of a pilot study. The typical steps would be:

* Prepare the project file for the subject except to
define a target, or to define a rough target to start.

e Perform the study (as described in the next chapter)
and record the coil location along withe the
response measure that will be the criteria for select-
ing the ultimate target(s) for future session(s).

o After the study, follow the steps in Chapter 18 to
review the study. In the review window, select the
sample that you wish to use as a new target, and
click Convert to target. Note that a copy of the
sample will appear in the target list. Close the
review window.

e Open a targeting window again. Select the new
target in the list, and click Go To. Note that the

target's origin is on the scalp, pointing into the
cortex.

We recommend that targets be based in the cortex,
rather than be on the scalp. To move the target into
the cortex:

Click on the nudge tool to nudge the target

Fig. 11-10
Why use cortical targets?

When using a scalp based target, you
are placing the coil and assuming that it
will be pointing towards your real target
in the cortex. Any error in orientation
will change the part of the cortex that is
actually stimulated.

@ Target used for positioning —— Trajectory used for positioning

. Desired cortex to stimulate ~— Actual trajectory

down the trajectory.

or
Move the offset slider to project the cursor down
the trajectory into the cortex, then click Move Target
to Crosshairs Offset. The target will move from the
original location to the new location.

@ Target used for positioning — Trajectory used for positioning

@ Desired cortex to stimulate ~  Actual trajectory

If you use a cortex based target
instead, then any small error in
orientation will have a smaller effect
on the actual cortex stimulated. This is
because the targeting tools will ensure
that regardless of the orientation of the
coil on the scalp, it will be pointing to
the right part of the cortex. The coil in
effect, will pivot around the target.
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Chapter 12: Perform: Initial Setup

Up to this point, you have spent several minutes or
more preparing for this part, performing the NIRS
session. This chapter will show how to perform the
initial setup required to prepare the system and
subject for the session. Many of the steps required
for the NIRS session will depend on the nature

of your experiment. For example, you may use

the MNI coordinates as the final location of the
optodes, or you may wish to use the position sensor
to digitize the optodes. In the latter case, you will
need to set up the position sensor and perform the
subject-image registration. In the former, you will
not need to. These options will be presented as they
become relevant. The next steps are presented in
the next chapters, whose names are prefixed with
“Perform:".

OVERVIEW

Before you can perform a NIRS experiment, you will need
to prepare the equipment.

PREPARE THE NIRS SYSTEM

NIRS Unit
* Move the unit close to the subject and ensure that
the optode fibres can reach the subject, and if the
support arm is used, that it can reach over the
subject's head without obstructing the subject's
freedom of movement.

* Make sure that the unit is connected to the mains
for power and a correctly configured network to
allow communication with the Brainsight control
computer. Review Chapter 3 for more details on how
to assemble and connect the hardware.

« If the position sensor will be used to digitize the
optode locations, make sure the Vicra camera is
placed in such a way as to have an unobstructed
view of the subject head tracker and the pointer
while in use (see fig XX).

e |f not already done so, connect the fibres to the
optical modules, and insert the optodes into the
receptacles of the cap or patch. Use the connection
list of the planned montage as a guide to the correct
placement for the optodes. Refer to Chapter 3 for
details on assembling the fibres and optical modules
and Chapter 4 for more information on connection

Chapter 12 > Perform-Initial Setup



Lists.

e Turn on the NIRS unit by ensuring that the unit is
plugged into appropriate mains, that the main switch
on the back of the unit is on and finally by pressing
the power button at the front of the unit.

e The machine will take a moment to boot. Once
booted, the Brainsight logo will appear on the front.

PREPARE THE BRAINSIGHT COMPUTER
* Move the Brainsight computer to a location that
allows easy access by the operator. It does not need
to be close to the NIRS device itself, it only needs to
be near a power outlet and reachable by the same
Ethernet network that the NIRS unit is connected to.

e Turn on the computer, launch Brainsight and ensure
that the computer is connected to the same network
that the NIRS device is.

PREPARE THE SUBJECT

Place the NIRS cap on the head

There are multiple options to hold the optodes on the
head, each method having advantages and disadvan-
tages. The key to obtaining good data is to pick the option
that best suits your needs.

If you are using the Brainsight cap (plastic ring and
elastomer straps):

The Brainsight cap consists of several components.

e Loosen the elastic strap at the rear of the cap and

Brainsight’ WL  USER MANUALV2.5

place the cap in the head.

 Take care to ensure that the rear section of the cap
strap goes below the transverse bone (under the
inion) and that the strap is not touching the ear.

* Gently tighten the strap. It takes some practice to
learn the correct amount of tension required to
secure the cap while not being overly uncomfortable.
The cap may feel ok at first but become uncomfort-
able after wearing it for several minutes. If this
occurs, Loosen the strap a bit.

 Attach the sagittal strap on the front centre rivet and
guide the strap along the midline of the head. Secure
the rear using the two straps, one to a rivet on each
side of the cap. Take care to use a hole on the rubber
strap that provides the desired tension in the sagittal
strap.

* Using your assembly list as a guide, add straps to the
cap by inserting them onto the appropriate rivet of
the sagittal strap. Use the hole labelled "0" on the
strap with the even numbers going to the subject’s
right and odd numbers to the left. Secure the other
end of the straps to the appropriate rivet on the cap
perimeter.

 Use the articulated arm (if available) to support the
fibre optic cables and bring the optodes near the
subject head (Fig. 12-1).

* Insert the optodes into the strap holes, taking care to
rotate the optodes so that the fibres run away from

the head in an orderly manner.

 Inspect each optode and part the hair under each
optode to ensure a good contact with the scalp.

Prepare and attach the subject tracker

Using the head-strap

Note that the receptacle in the head strap has two holes.
One will orient the tracker horizontally and the other
vertically.

* Decide which one to use based on the expected
location of the camera. If the camera will be Low
(e.g. eye level), then use the vertical hole so that
the subject tracker will be facing horizontally. If the
camera will be high looking down, then use the
horizontal hole so that the tracker will be facing up.

e Loosen the set screw in the receptacle and insert the
hex rod. Tighten the set screw, taking care to ensure
that the set screw comes into contact with a face of
the hex rod.

Using the glasses
The glasses have receptacles on both ends of the frame.

¢ Select the one that will ensure that the tracker will
be away from the coil.

e Loosen the set screws in the receptacle and insert
the hex rod. Tighten the set screws, taking care to
ensure that the set screws comes into contact with a
face of the hex rod.

Fix the subject tracker to the hex rod by loosening the set



Fig. 12-1

Typical arrangement for the NIRS.

Fig. 12-2

A: Head strap for attaching trackers.

B: Glasses with tracker mounts.

Fig. 12-3
TMS Session manager window.
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A session is a collection of all information recorded during an experiment with a subject. This
includes an ordered list of targets sampled and data such as sample location and coil settings.

Sessions:

| Name Date Created al
[ New... '»B Remove Review Resume

|

screws in the receptacle, mount the tracker on the hex
rod, and tightening the screws taking care to ensure that
the set screws comes into contact with a face of the hex
rod.

Ensure that the position of the subject tracker is such that
the Polaris will be able to see the tracker, and that its
location will not interfere with the coil location. You will
have the opportunity to confirm the visibility of the tracker
during the start of the TMS session.

PREPARE THE HARDWARE

If you are planning to use the navigation functionality,
ensure that the Vicra camera is connected as described in
Chapter 3.
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BEGIN A NEW NIRS ACQUISITOIN SESSION

 Launch Brainsight and open the subject’s project file

* Click on Sessions to bring up the session manager
window (Fig. 12-3).

* Ifyou are using the navigator to confirm/adust the
optodes and/or to record their final location, proceed
to the next section . If you are not using the naviga-
tor, skip to the following section .

Acquiring NIRS Data Using the Navigator:

* [fyou are using the navigator, begin a new session
by clicking New->Online Session. If you are not using
the navigator, click New->Offline Session. To resume
a previously created session, select the session from
the list and click Resume.

A session window will appear (Fig. 12-4).

e The first window shows a list of all the targets
defined earlier, and an empty list representing the
targets to use in the current session. Either select
the target and click Add-> or, using the mouse, drag
the targets to use in this session from the List of all
targets to the list for the session. Note that you can
rearrange the order of session targets by dragging
them up and down in the list. You can also add
multiple instances of a target in the session List.
This allows you to create a sequence of targets for a
session that can include stimulating the same target
more then once.

e Once all your targets are selected, click Next Step.
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Fig. 12-4

Session start screens:

A: On-line session where the navigator will be used

B: Offline session where the NIRS acquisition will be
performed without navigation

Drag and drop the targets to use for this session
from the pool of all targets on the Left to the session target list
on the right (or select the target on the left and click Move..

s Untitled - Session 2

B0 @ £ O @

Targets 10Box NIRS Polaris Registration Valdation Electrodes Perform

Choose the targets you want to sample it in this session by dragging from the left table to the right
table or selecting and pressing the ‘Add = button. In the right table, reorder targets into the
sequence you want by dragging and dropping.

Targets in project: Targets to sample in this session:

Name -~ Name Missing
Motor

Add = New Folder

Next Step

e0e Untitled - Session 1

& =0 £}

Targets |0Box NIRS Electrodes Perform

Choose the targets you want to sample it in this session by dragging from the left table to the right
table or selecting and pressing the ‘Add =" button. In the right table, reorder targets into the
sequence you want by dragging and dropping.

Targets in project: Targets to sample in this session:

Name ~ Name Missing

New Folder

Next Step




Chapter 13: Perform: Trigger and EMG Setup

One common use of NIRS is to record event related
data (e.g. repeating a task multiple times to allow
for averaging of the signal). If you are perform-

ing an event related acquisition, the events are
typically generated by an external trigger (e.g.
stimulus presentation computer). This chapter

will describe how to connect the trigger to your
Brainsight computer and/or the NIRS device and
configure the software to use the trigger to acquire
the event related data.

INTRODUCTION

Event related data recording is a common method used
in cognitive neuroscience. In general, an event related
experiment involves multiple repetitions of an event,
either exposure to a stimulus, or the performance of a
short task. The onset of the event may be synchronized
using a trigger. For example, many stimulus presentation
systems (e.g. E.Prime) provide a TTL trigger signal to
synchronize the acquisition.

The NIRS data is acquired in a continuous file both in the
NIRS device and in the Brainsight software. If at the same
time, a trigger signal is sent to the Brainsight computer,
the trigger times can be recorded to allow the acquisition
to be broken up into a series of epochs, one for each
trigger event. This allows for easy averaging during the
acquisition and these event triggers can be exported

as part of the NIRS data file for use in HOMER for data

processing.

USING THE STIMULUS TRIGGER OUT TO AUTOMATI-
CALLY RECORD EVENT RELATED NIRS SAMPLES

This section will describe how to enable one or more
methods to trigger the recording of a NIRS event related
sample. In addition to acquiring NIRS data epochs, if

you are acquiring EMG data, the trigger recording will
also apply to the EMG. Because the Brainsight /0 box
has a built-in digitizer for EMG, the trigger configuration
window will display the live data. Ignore this and focus on
the trigger options on the top left of the 1/0 box window.
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Click Trigger Options... to open the options window (Fig.

13-1).

e During the NIRS session, you may wish to create an
event manually. You can always do so by pressing
the Sample button.

« If you have a Brainsight computer trolley with an 1/0
box (see Chapter 20) or Trigger box (called an analog
receiver) and have connected the TTL trigger output
of the stimulus software (or other hardware generat-
ing a TTL trigger for you) to the TTL trigger in of the
I/0 box, enable it by enabling the Use TTL Channel
x checkbox (x=1 or 2). If the trigger is coming from
an rTMS device, enter the pulse train length as dead
time to have Brainsight use the first pulse in a train
and ignore the rest (until the first pulse of the next
train).

Setting up the EMG

Refer to the Brainsight NIBS user manaual for safe and
correct operation of the Brainsight EMG device. If you
have not already done so, apply the EMG electrodes on
the subject. The EMG data from both amptlifiers will be
displayed live in the EMG view on the screen. You can use
this to ensure that you have a good electrode contact.

As of v2.4.9, you can record EMG as event related (as
always) where a short duration of the EMG can be
recorded and associated with each sample. You can
now record continuous EMG as well, where one or both
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channels can be recorded for the entire duration of the v signal (for motor threshold). Its maximum range
study. is approximately 5 mv peak to peak.
To set up the EMG options: * Set the live EMG baseline correction. It is usually

* Double-check that you have selected the correct easiest to simply click on Auto compute [0 have

amplifier model in the preferences. Brainsight Brainsight calculate and set this value.
currently supports 2 models, each with different

gain values so selecting the wrong one will result in

incorrect EMG magnitude data. See “Setting up the

EMG" on page 84 for details.

Enable the recording of the Live EMG (both
channels) by enabling the checkbox.

* Enable one or both channels using the checkbox
next to each channel. Note that you can use either
channel or both, and as described on page 83,
you can enable either or both EMG channelsin a
second window while tracking two coils. This allows
you, for example, to track two coils at the same time,
and have one or both EMGs associated with one
coil's samples or the other.

Set the baseline (time prior to the stimulator trigger)
and trial (time after the trigger) durations for record-
ing. The baseline value is negative to represent

time before the trigger (which is the O time). The
maximum range for the EMG recording is -100 ms
to 250 ms and the minimum is -20 ms to 50 ms.

e NOTE: The built-in EMG device is designed specifi-
cally for recording motor evoked potentials (MEPS).
Its dynamic range is set to be able to visualize a 50
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Acquiring a good quality NIRS signal requires the
optimization of several settings. What settings
produce the best results depends on some real-
world factors including the distance from the
source to detector, the presence of hair and the
quality of the optodes and fibres. This chapter will
describe the fundamental relationships between
these factors, and how to optimize the acquisition
settings to obtain the best possible signal prior to
recording the NIRS data.

Chapter 14: Perform: Optimize NIRS Parameters

WARNINGS

Do not look directly into the source optode
during operation. Doing so may cause

eye damage. It is recommended to wear
protective glasses if manipulating the
optodes while the lasers are on.

QUICK STEPS

It is assumed that you have reviewed and have a basic
understanding of the NIRS configuration window,
specifically the different NIRS display elements, the
detector chain and how the various settings at each stage

of the chain can effect the quality signal acquired . If you
are not familiar with these, then skip this section and
familiarize yourself with the remainder of the chapter
before manipulating the NIRS settings. While the NIRS
system will be in operation in this section (to allow you to
view the signal and manipulate the NIRS settings for the
upcoming study), no data will be stored. Data collection
occurs during the perform step.

Setting the NIRS Acquisition Parameters

By this time, the subject should be wearing the NIRS cap
and optodes. It is not necessary that the subject-image
registration be performed at this point. The NIRS device
should have been connected to the same TCP/IP network
as the Brainsight computer and turned on (and its boot
sequence complete).

If you have not already done so, select the NIRS step in
the session window. The window will look like that in Fig.
14-1.

Chapter 14 > Perform-NIRS Parameters
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Fig. 14-1
Typical screenshot of the NIRS step

The most useful views here are the live NIRS, Live NIRS FFT, and Llive NIRS
rectangles view.

| | | Previous Step | | NextStep.

Live NIRS
Rectangles Display Mode




» Connect the computer to the NIRS device by select-
ing it from the NIRS device popup menu button, and
click Connect. After a moment, you should see the

status message should change from “Not connected
to “Locked by this Brainsight computer” (you may
see an interim message saying "unable to connect”,
but ignore that for a few seconds while it establishes
a connection. If the unable to connect message
persists for more than a few seconds, proceed to the
connection trouble shooting section. There may be
a delay of several seconds while the connection is

If you want to record NIRS data, use this step to configure the NIRS parameters,
and to perform a test acquisition.

NIRS device: | BrainsightNIRS.local.
Status: Locked by this Brainsight Mac

Fig. 14-2
Close-up of the NIRS connection manager portion of the NIRS
step.

| Disconnect |

established and then the system locked.

e Enter a name for this NIRS study. This will be used
as the file name on the NIRS computer for the data
to be acquired in the study.

e Select the cap and assembly that describes the cap
on the subject using the Measurement list popup
menu button.

e Once you have selected the measurement list, you

Study name: Untitled - Session 1

Acquisition duration: 600 seconds (1-86400)

Sampling frequency: 20 Hz (1-100)

Aux sampling frequency: 1 Hz (1-8065)

Laser power 685 nm: f—(_: |

Laser power 830 nm: =——————— ) [*| 20.0 mW

) |
) |

Bay 1 detector sensitivity: =—————xrf = [*| 152y
Bay 2 detector sensitivity: [ s |5| 90 v
Bay 3 detector sensitivity: ( j———————— (£ 90 V

Bay 4 detector sensitivity: | —————— [*| 90V

should see the individual detector channels appear
in the List.

Prepare a short acquisition to observe the incoming
NIRS signal. Set the acquisition time to a reasonable
length (e.g. 300 seconds).

Set the sampling frequency to the desired value (e.qg.
10Hz). You can sample up to 100 Hz. Keep in mind
that lower sampling rates will result in higher signal
quality (at the expense of temporal resolution), so
pick the lowest rate that meets your needs.

Set the laser power (all sources, both wavelengths)
to the initial desired value by selecting the all
sources in the sources list and sliding the power
sliders all the way to the right (Fig. 14-7) . It is often

| [+] 20.0 mwW

Fig. 14-3
Close-up of the acquisition parameters pane. The
slides control the laser power as well as the high

voltage that determines the gain of the avalanche
photodiode detectors (APDs).

best to start at the maximum power. If you notice a
Lot of signal saturation once you are acquiring, you
can lower the laser values. Remember to review
how the laser power, detector gain and digitizer gain
relate to each other to obtain the cleanest signal
(described later in this chapter).

Set the initial detector sensitivity values for each
block using the sliders. Start at the halfway point.

Make sure the operator and subject are wearing
their safety glasses, then click on the start button to
start the acquisition.

Set one of the views to Live NIRS and another to Live
NIRS Rectangles to allow you to evaluate the quality
of the incoming signal.
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» Watch the live NIRS signal. The main characteristics
to watch for are:

* Presence of physiology in the signal (heart and
respiration) with a good amplitude (it is a topic of
discussion as to how well the presence of physi-
ologic signal is a predictor of good NIRS data, but
this will evolve over time).

e Lack of saturation of the detectors (shown as red
underlines beneath the live data and an S symbol
in the NIRS rectangles.

e |f the data is saturated, lower the detector sensitivity
until you notice a good signal. If the signal looks
poor when the saturation stops, try raising the sensi-
tivity again, but first lowering the laser power. If one
of the wavelengths is producing a much stronger
signal (it is expected that the 830nm is stronger
than the 685 or 705nm because of the lower
absorbance of that wavelength by the tissue), lower
that one first until all wavelengths are producing a
similar amplitude for a given source-detector pair.
The goal is to get the best dynamic range without
saturating the detector. Review “The NIRS Detector
Chain" section of this chapter to learn more about
optimizing the components of the detection chain.

e Watch the Live NIRS rectangle views to ensure that
all the detectors on the head are returning a good
signal. If one or more of them look dimmer than
others (and the distance between the source and
detectors is similar to other pairs that are returning
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a better signal), then examine the optodes on the
scalp for problems including the presence of hair
under the detector, or poor coupling of the detector
on the scalp. If the detector is not staying on the
scalp reliably, consider another means of holding
itin place, including an elastic wrap to push the
detector down onto the scalp (see section xx for tips
on applying the cap and optodes onto the scalp).

e [fyou find that you have a few individual channels
with weaker signals (and raising the detector voltage
causes saturation), then you can select that detector
and try increasing the detector gain. This does not
add new signal, but makes better use of the digitizer
range to maximize the sensitivity of the analog-
digital (ADC) conversion.

* Once you are satisfied that the signal is acceptable,
click Stop Test to end the acquisition. If you need
more time and the test has timed out, click Start Test
again to repeat the process.

* |f your study will be event related (using an external
trigger), then set the baseline and trial duration
values in the associated text fields. This is not
required for continuous acquisitions. Make sure to
set the connect and enable the associated trigger
signal in the trigger and EMG step (if needed).

* Once you have completed the setup, click on Next
Step to proceed to the subject registration step if you
are performing an on-Lline session, or to the

THE NIRS DETECTOR CHAIN

The NIRS data undergoes several steps of detection,
amplification and digitization before any data is displayed
on the computer screen. Each of these steps can be
optimized to ensure the best quality of data is being
recorded. While it is a relatively straightforward process,
some understanding of each step is helpful.

Overview

The chain has several steps: Laser power, Avalanche
photodiode bias voltage, signal amplifier and finally the
digitizer.

Light Intensity

The starting point for NIRS is the injection of light into
the head. As the light enters the scalp, it will be diffused
and absorbed in the various tissues in the head. A small
fraction of this light will make its way to one or ore
detectors. When considering the path of the light that
leaves the source optodes and is picked up by a detector
diode, the shape is generally described as an arc into the
head and out again (banana shaped). The wider the gap
between the two, the deeper the arc goes into the head
(and thus the deeper we are scanning into the head). As
source-detector spacing increases, we see deeper into the
head but at the same time, the path length increases and
thus more photons scatter somewhere else other than in
the detector, so the amount of collected light decreases.
The generally accepted "sweet spot" for source-detector
spacing, the balance between scanning deep into the
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Fig. 14-4
[Llustration of the effect source-detector spacing and
APD bias voltage has on the APD output signal.

)

brain but still getting enough light out again to form a
good signal is a separation of about 3cm.

Each detector may pick up light from one or more
sources (and in fact, from each distinct wavelength.

Since at this stage, the detector cannot distinguish the
light from any specific detector (or wavelength within a
source optode) it is recording the sum of all light from all
sources and all wavelengths.

At this stage, the parameters that should be optimized
are to ensure that all sources within range of the detector
(say between 28mm & 32mm, for example) contribute a
fair share of the signal, so no one source dominates too
much. The strategy to help this is to find source-detector
distribution patterns that try to have similar spacing.
This is somewhat of an art and the actual layout vary
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a lot depending on the region to be imaged and how
densely you wish to image a region.

Each source may be emitting two or more distinct
wavelengths of light. As the light travels through the
tissue, some of it is scattered and some of it is absorbed.
The amount of light absorbed in the tissues depends on
the tissue and the wavelength. For example, two common
wavelengths used is 685nm and 830nm. Tissue tends to
absorb 685nm more than 830nm, so it may be advisable

to keep the total distribution of light relatively even. This
can be done by selecting the source(s) in the assembly list,
then using the laser power sliders.

Detector Sensitivity

The avalanche photodiode (APD) converts the NIRS
signal from photons to analog electrical signal (which
can then be amplified and digitized later in the chain).
Think of it as converting photons to one or more
electrons. Once the light input has been optimized

(in the previous step), the detector sensitivity can be
adjusted to optimize the conversion to electrical signal.
The sensitivity is adjusted by setting the bias voltage.
The sensitivity of the APD depends on the total amount
of light hitting the detector and the bias voltage setting.
If either too much Llight reaches the detector or the bias
voltage is set to high, the detector will reach a saturation
condition where is simply sends out a continuous, high
signal regardless of the input. The goal of optimizing the
detector settings is to detect as much light as possible
and for the detector to send as strong an analog output
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as possible. A strong signal here means less artificial
amplification will be needed in the next step prior to
digitization.

Incoming Analog Signal Digitizer Digital Signal

The setting is relatively simple to adjust. While acquiring [\ [\ [\

NIRS signal, simply raise the APD voltage bit by bit and
observe the incoming signal. As the voltage increases, U U U

OK

Dynamic Range

the signal amplitude will increase. At some point, the
APD will saturate and the saturation indicators (an “S"
will be displayed in the Live NIRS rectangles, and the
Live waveforms will have an line along the bottom. When

saturation is observed, back the voltage down again until [\ [\ [\

the saturation disappears. U U U

Analog Amplifier and Digitizer

Best

Dynamic Range

The goal of the previous steps are to ensure that the
signal reaching this stage has as much signal (as
opposed to noise) as possible. The final stage is to digitize

the analog signal for further processing and storage. [\ [\ [\

The digitizer itself has a set dynamic range, so the best U U U
digitization occurs when the incoming signal takes the

Clipped

>

Dynamic Range

most advantage of that range. If the range of the signal

is a small fraction of the digitizer range, then some of

the range is wasted. To help maximize the range in this Fig_ 14-6
step, the signal goes through one final amplification [llustration of the digitizer gain and the resulting signal.
step. The default amplification is set to 1, but that can

be increased. If the amplification is set too high, then the

signal may be clipped and the extremes of the data will

be lost.

The detector gains can be set individually, or as a group.
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Typically, you may find one or a few detectors returning

a weaker signal than the others (consistently across

all wavelengths). The amplification gain may be used

to boost that signal to something more consistent with
the other detectors. Note that this will not “create” new
signal, but will optimize the digitization of that detector,
So at least you are not losing out on the dynamic range
of the digitizer because that detector happened to be a bit
further from the sources than the others). When looking
at the assembly list, select all the sources on the left

side (select the top one, then shift-click on the bottom
one to select all sources. Observe that on the right List,
all detectors are now shown. Select the detector whose
gain you wish to set, and change the value on the bottom
using the gain popup button.

Brainsight <« usemawuaces

Set Measurement List...
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Source
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Chapter 15: Perform: Localizing Optodes

One of the key features in Brainsight is the ability to
associate the NIRS signals with the actual locations
of the optodes on the subject's scalp and to map
these locations to either a standard image-based
model for the brain or the subject's specific MR
images. This chapter describes how to associate the
locations of the optodes, either using the estimates
provided by the cap manager (mapped to either

a model MNI brain, or the subject's MRI) or by
actually digitizing them using the tracked pointer.

INTRODUCTION

One of the benefits of having an integrated navigator with
the NIRS is the ability to accurately place the optodes
using the subject's anatomy as a guide and/or to export
the location of the optodes along with the data for use

in more sophisticated analysis. The level of use of the
neuronavigation is optional and generally falls into the
following categories:

* No navigation and no estimated optode locations

» No navigation but using estimated optode locations
based on a model head or subject's MRI

e Estimated optode locations and placement using
navigation on a head model or subject's MRI

 Estimated optode locations and placement using
navigation and recording of final locations on head
model or subject's MRI

The simplest way of acquiring NIRS data (which is how
systems without navigation do it) is to simply create an
assembly list that defines the optode relationships from
a functional perspective (which source-detector pairs
to record) and to omit any information regarding their
locations.

A slightly more sophisticated way is to define a NIRS
cap with the MNI coordinates of each optode and the
list of source-detector pairs to record (as described in
“Managing Assemblies” on page 32). This will provide
an estimate of the relative positions of the optodes and
provide the possibility of visualizing the results overlaid

Chapter 15 > Perform-Localizing Optodes



on the standard brain (MNI head model) for interpreta-
tion. This information can also be warped onto the
subject's MRI by co-registering the subject-specific MRI to
the MNI model head.

The next step in incorporating navigation is the ability to
verify that the optodes are placed according to the plan.
This typically involves mapping the MNI-based optode
location template to the subject-specific MRl images,
co-registering the subject to those images and using
the tracked pointer to verify that the optodes are at the
expected locations. Adjustments can be made to move
the optodes to the correct locations. If the subject's MR
images are not available, the MNI model head can also
be used, albeit with lower accuracy.

Finally, the pointer can be used to digitize and record

the final location of the optodes on the head. This step
does not require that there be an original estimate of
the optode locations and in fact can be used to create

an initial estimate of the optode locations for future use
with this, or other subjects (see “Using a single subject to
create a NIRS cap definition" on page 98).

APPLYING AN ASSEMBLY LIST

If you are applying an assembly list that includes MNI
coordinates and this project is using subject-specific MR
images, you will need to have co-registered the MRI to
the MNI coordinate space first (see "Chapter 6: Prepare:
MNI/Talairach Registration”). If the assembly list does
not have MNI coordinates, then proceed as instructed

Brain WL  USER MANUALvV2.5
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however disregard the reference to the coordinate system
as they are only needed to convert MNI coordinates to the
subject coordinate space.

e [f you have not applied an assembly list yet in the
NIRS step ("Perform: Optimize NIRS Parameters"),
Click Add From->Assembly List... and an assembly
list selection sheet will appear (Fig. 15-1).

o Select the assembly list from the popup list button

e Select the coordinate system registration to apply
(the one you created in the Atlas step, or World/MNI
is you are using the MNI head)

 Select Snap to: Skin (you should have created a 3D
skin already as described in “Chapter 9: Prepare: 3D
Reconstruction”)

¢ Click OK to place the optodes.

Verify Correct Cap Placement

If your assembly list used a cap with initial location
estimates, then the image display should show the
estimated locations of the optodes (and electrodes, if
present) on the subject head. Assuming that you have
performed the subject-image registration, you can now
move the pointer around the head, touch the optodes
and electrodes on the head and visualize how well the
cap, actually on the head, agrees with the estimate. If
there are discrepancies, you have the choice of either
moving the cap on the head until it agrees with the plan,
or digitize the final locations of the optodes to record the
true locations on the head. Typically, you end up doing a
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Fig. 15-2
A set of optodes from an assembly list applied to the
subject-specific MRI.
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bit of both. Tweaking the cap and in the end, digitizing the
final location of the optodes.

To digitize the final locations of the optodes:

¢ Select Snap to: Skin in the popup button beneath
the optode list. This will tell Brainsight to project
the pointer tip to the closest point on the skin while
digitizing the optodes. This will compensate for the
optode thickness and ensure all locations are on
the skin, not floating over the skin by the thickness
of the optode. It will also use the skin to orient the
optodes on the skin so the 3D representations of the
optodes point into the brain (useful for visualization
purposes).

e |fyou are using the foot-pedal connected to the
Brainsight /0 box or trigger input box, then select it
now by enabling the Use 1/0 Switchbox checkbox.

e Select the first optode in the list. Note that the
computer will read out the optode/electrode name.

» Touch the optode with the pointer and depress the
foot switch or click Sample & Go Next. The location
of the optode as displayed on the skin should
update itself. The next optode in the list should have
automatically been selected (the computer voice will
call it out).

e (0 to the next optode and sample it as in the previ-

ous step. Repeat for all optodes/electrodes in the List.

Brainsight’ WL  USER MANUALV2.5

USING A SINGLE SUBJECT TO CREATE A NIRS CAP
DEFINITION

As noted earlier, the NIRS configuration step requires a
valid assembly list (the list of source-detectors to use for
the acquisition). In order to create an assembly list, one
needs a cap layout. This creates a bit of a “chicken and
the egg” problem in that we need MNI coordinates of the
cap "holes" in order to create the definition needed for
the assembly list, but need a subject to wear the cap to
measure them. This section will outline the steps to use
a single subject to measure the locations of the cap holes
and to convert these to MNI coordinates to use to define
the cap.

The overall process will consist of:

* Preparing a Brainsight project for the subject
(including an MNI registration in the Atlas step)

* Applying the cap to the subject (whatever the cap
may be, patch, EEG cap or elastomer straps)

* Initiating a session and co-registering the subject to
their MR images

 Using the electrode step to record the optode hole
locations.

* Exporting the sampled list of electrodes to a text file
(in the MNI coordinate space)

At this point, we assume you have done all the prepara-
tion and have a subject with the cap on, the images
loaded, the on;ine session has been initiated, the
subject-image registration already performed and are at

the Electrodes step. To digitize the new cap layout:

e Select Snap to: Skin in the popup button beneath the
empty optode List. This will tell Brainsight to project
the pointer tip to the closest point on the skin while
digitizing the optodes. This will compensate for the
optode thickness and ensure all locations are on
the skin, not floating over the skin by the thickness
of the optode. It will also use the skin to orient the
optodes on the skin so the 3D representations of the
optodes point into the brain (useful for visualization
purposes).

e |fyou are using the foot-pedal connected to the
Brainsight /O box or trigger input box, then select it
now by enabling the Use 1/0 Switchbox checkbox.

e Place the pointer on the first optode/electrode and
click New. This will create a new entry in the optode
list using the current pointer location (projected to
the skin).

* Note that the optode name in the list will be
highlighted. You can quickly overwrite that default
name (Electrode XX) by typing a new name (it is
best to have 2 people at this point, one sampling
the optodes and the other typing). You can leave
the default names for now as well and change the
names later.

* Move the pointer to the next optode and click New
again (and repeat the naming process). Repeat for
all optodes.



* Once all the optodes have been digitized and
named, click Export As..., select TEXT as the file type
and MNI as the coordinate system, provide a name
(a name describing the proposed cap is a good
name)and click OK.

 Return to the Cap Layouts Manager (described in
Chapter 4 on page 29) and select New->From
Flle.... Select the text file created in the previous
step and it will be added to the caps list.

* Change the name of the new cap layout (at least
remove the ".txt extension)

 Return to the Assembly Lists manager (also in
Chapter 4) and create a new assembly by selecting
New->YOUR CAP NAME.

* Configure the Usage-Bay-Optode information for
each channel used and the assembly List will be
ready for use in any project in the future.
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The Subject-Image registration step is where we
establish the link between the real world and the
image world. Once this link is established, it will be
possible to track any object of interest in the real
world (e.g. pointer) and display the representation
of it on the images. This will simplify the task of
ensuring the optodes are placed accurate;y accord-
ing to plan and to record their final Location.

The registration procedure varies a bit depending
on your project type (subject-specific MR images
vs. MNI model head). It is good to familiarize
yourself with both techniques.

Chapter 16: Perform: Subject-Image Registration

VERIFY PROPER POLARIS LOCATION

The next Polaris step is intended to ensure that the
Polaris is correctly connected to the computer and that it
is correctly positioned to view the relevant trackers.

e (Observe that a few seconds after the Polaris window
opens, the Polaris will beep, and the red boxes
describing the camera’s field of view will change
from red to blue. (If you have been using the Polaris,
it may not have required a reset and the camera's
field of view will already be blue).

e Make sure that the subject tracker (and any other
tools in the field of view) is well within the boundary
and that the tools you intend to use (as seen on the
list) are present. See

¢ Click Next Step.

If you are using a subject-specific MR-based project,
proceed to the next section. If you are using an MNI
model head based project, skip to the next section:

PERFORM THE SUBJECT-IMAGE REGISTRATION
(SUBJECT-SPECIFIC IMAGES)

Recalling Chapter 10, you selected a series of anatomical
landmarks on the images. In this step, you will identify
those same landmarks on the subject’s head using the
tracked pointer. The software will use these point pairs

to calculate the subject to image registration (Fig. 16-4).
This step requires close interaction with the computer as
you identify the points and "tell" the computer when you
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Fig. 16-1

Polaris verification screen.

What if my tools are not visible?

If you are placing your tools in front of the camera and they are
not tracked, one of several events may have occurred. Before
contacting Rogue Research, here are a few things to try/examine

are pointing to the requested landmark. Make sure that
the volume on the computer is high enough to hear the
computer, as it will speak the names of the anatomical
landmarks to identify. This step supports multiple input
methods. Activate the voice recognition and/or the switch
input by enabling the appropriate checkboxes (Fig. 16-3).
Alternatively, have an assistant present to operate the
computer for this step.

¢ Note the location of the cursor on the screen (or
click on the first landmark to begin).

o Carefully place the pointer tip on the same landmark

Brain WL  USER MANUALvV2.5

on the subject's head, being careful to gently touch
the skin surface (do not "poke" the subject) and to
keep the pointer still. Make sure both the pointer
and subject tracker are visible to the Polaris by
making sure the boxes next to them in the window
are green.

Have the computer sample that point by either
pressing the foot switch, speaking the word "sample”
to the computer (using the speech recognition), or by
clicking Sample & Go To Next Landmark.

* If you spoke the word sample (and you are using

(we will ask this if you contact us):

Does it only fail to track one tool? If so, examine the
spheres for scratches or dirt and make sure they are all
seated properly on the posts.

Does it track better (all tools) close to the camera, but not
near the rear of the field of view? Has this been getting
worse over time? If so, your camera may need re-calibra-
tion (required every few years)

Are there any reflective objects (mirrors, windows, reflective
pain in the IR spectrum) facing the camera? This can blind
the camera.

Was it a sudden failure to track all tools? Was the camera
dropped or bumped (the Vicra and Spectra have a bump
sensor). If so, it may require re-calibration or repair by
Rogue Research.

0S 10.9), you should hear a "whit" sound. If not,

try again (sometimes, saying "Simple" rather than
“Sample" works). Regardless of the input method,
you should hear a beep and notice a green check
mark appear next to the landmark in the list. If not,
repeat the voice command, or press the foot switch
again. If you hear an “error beep"” (it sounds different,
one that is universally recognized as a failure sound),
the pointer and/or subject tracker were not visible.
Make sure they are both visible and try again.

e Once you have sampled the point, it automatically



goes to the next landmark and calls it out. Use the
same technique to identify the landmark and have
the computer sample the point.

* Repeat for all landmarks.

* You can repeat any point by either selecting it in the
List (it will speak it out), or by speaking “previous”
to the computer to change the current landmark to
sample.
* Once all landmarks have been sampled, click on
Next Step.
This step serves to verify and refine the quality of the

registration obtained from the previous step. The cursor
will automatically move based on the location of the

& @ L O

Targets I0Box Polaris Registration Validation Electroc
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: Ye k the followil h P
persist on subsequent steps. IR, i, o e

Chapter 16 > Perform-Subject Image Registration



pointer on the head (the pointer is “driving” the cursor).
You have the option of recording additional refinement
points along the skin to attempt to improve the registra-
tion where the error is relatively small. While this can
improve the registration in certain cases, it is no substi-
tute for acquiring good quality points in the first step. In
the long run, a good registration can be achieved a Lot
faster by paying attention during the previous step.

* Move the cursor to various locations on the scalp
and observe the location of the pointer on the screen
(Fig. 16-4). Make sure that the pointer is shown on
the scalp at the same location as that of the pointer.
There will always be some Llevel of registration
error. Note the distance from the pointer to the skin
(assuming you performed a 3D skin reconstruction)
by looking at the number in the Crosshairs->Skin
display on the left of verification window. If the
error value is consistently below 3 mm, it should be
considered an excellent registration (the number is
shown in green). Below 5 mm is often acceptable
(shown in orange), particularly if it is below 3 mm
near your target, and 5 mm elsewhere.

If the pointer is between 3 & 5mm from the skin, try
adding refinement points by holding the pointer on
the skin, being careful not to push into the skin, and
create a sample by clicking Add or using the same
method as in the previous step (e.qg., foot switch or

voice command). Repeat this for several points in the

area where the error was observed. Notice that the
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Fig. 16-4

Registration verification screen.
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error should reduce as you add points.

e Always go back and examine the rest of the head
after adding refinement landmarks as they have a
global effect on the registration. In some cases, the
correction in one area may cause a larger error in
others.

* Distances larger than 5mm are shown in red as
a reminder than a better registration should be
attempted (you decide based on your requirements
what is actually acceptable and the colours are
suggestions).

e [f the registration is not acceptable, click Previous
Step to repeat the registration. Otherwise, click Next
Step.

The next step will be to apply the NIRS cap and verify/
digitize their locations. Proceed to "Chapter 15: Perform:
Localizing Optodes” on page 95.

PERFORM REGISTRATION USING THE MNI MODEL
HEAD PROJECT

If your project is based on the MNI model head template,
then the registration procedure is a little different. The
first step will consist of identifying three landmarks on
the skin (the nasion, left & right ears) and the second
step will be to record multiple landmarks on the scalp
(the extremities) to help Brainsight measure the height,
width and length of the subject's head to calculate an
additional scaling to help better match the model head to
the individual's head.

In this first step, you will identify those same landmarks
on the subject's head using the tracked pointer. The
software will use these point pairs to calculate the subject
to image registration (Fig. 16-5). This step requires close
interaction with the computer as you identify the points
and "tell" the computer when you are pointing to the
requested landmark. Make sure that the volume on the
computer is high enough to hear the computer, as it will
speak the names of the anatomical landmarks to identify.
This step supports multiple input methods. Activate the
voice recognition and/or the switch input (see Fig. 16-3).
Alternatively, have an assistant present to operate the
computer for this step.

» Note the location of the cursor on the screen (or
click on the first landmark to begin).

 Carefully place the pointer tip on the same landmark
on the subject's head, being careful to gently touch
the skin surface (do not “poke” the subject) and to
keep the pointer still. Make sure both the pointer
and subject tracker are visible to the Polaris by
making sure the boxes next to them in the window
are green.

* Have the computer sample that point by either
pressing the foot switch, speaking the word "sample”
to the computer (using the speech recognition), or by
clicking Sample & Go To Next Landmark.

* If you spoke the word sample (and you are using
0S 10.9), you should hear a "whit" sound. If not,

try again (sometimes, saying "Simple" rather than
“Sample” works). Regardless of the input method,
you should hear a beep and notice a green check
mark appear next to the landmark in the List. If

not, repeat the voice command, or press the switch
again. If you hear an “error beep"” (it sounds different,
one that is universally recognized as a failure sound),
the pointer and/or subject tracker were not visible.
Make sure they are both visible and try again.

Once you have sampled the point, it automatically
goes to the next landmark and calls it out. Use the
same technique to identify the landmark and have
the computer sample the point.

Repeat for all landmarks.

You can repeat any point by either selecting it in the
List (it will speak it out), or by speaking “previous”
to the computer to change the current landmark to
sample.

Once all landmarks have been sampled, click on
Next Step.

Record landmarks on the top of the head by gently
touching the top of the head with the pointer and
clicking Add Landmark (Fig. 16-6). Drop several
landmarks so Brainsight can use the topmost of
these for the scaling calculation (and you do not
need to be very precise since there will be multiple
landmarks to choose from).

Repeat this for the left, right front and back of the

Chapter 16 > Perform-Subject Image Registration



6

Use |0Box Switch

Alow

Subject tracker: [l ST640

Coronal & Landmarks B

Untitled - Session 1

Sagittal & Landmarks o

Fig. 16-5

Anatomical Landmark Recording

Brain L NRS ]

USER MANUAL v2.5

head.

* Look at the list of landmarks and note that Brain-
sight has automatically selected and labelled the
best landmarks as Frontmost, Backmost, Topmost,
Leftmost and Rightmost. Click Next Step.

The final step is to verify that the registration was
successful. Move the pointer on the head (Fig. 16-7),
focusing n the same areas where the scaling landmarks
were dropped in the previous step. Observe the numerical
error displayed on the left of the screen (Crosshairs-
>Skin). It should be consistently at or below 3-4mm.

Note that the error between these locations may be
significantly higher. This is due to possible differences in
curvature of the head shapes.

The next step will be to apply the NIRS cap and verify/
digitize their locations. Proceed to "Chapter 15: Perform:
Localizing Optodes" on page 95.
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Chapter 17: Perform: Acquire The Data

Once all the parameters have been decided on, it is
time to perform the actual study. This chapter will
describe the steps needed to acquire the NIRS data
during the experiment.

INTRODUCTION

A lot of preparation work has led to this step. Relatively
speaking, there is little work to do. It is assumed that
prior to reaching this step, you have connected to the
NIRS, selected an assembly list and run the system to
ensure that the optodes are well placed (see "Chapter 14:
Perform: Optimize NIRS Parameters"). At this point, there
is Little left than to click the record button and perform
the experiment.

There are a few types of NIRS experiments
NIRS-ONLY EXPERIMENT

e Ensure that the parameters for the NIRS study were
entered and tested in the NIRS hardware step (see
“Chapter 14: Perform: Optimize NIRS Parameters")

e [fyou intend to acquire event-related epochs, enter
a baseline and trial duration. The baseline is the
amount of data before the trigger and the trial
length is the amount of data after the trigger to
record.

* When you are ready to start the acquisition, click
Start NIRS.

* |f the acquisition was event related and you enabled
an external trigger, you should notice samples
accumulate in the samples list during the acquisi-
tion.

e |f you wish to stop the acquisition at any time, click
Stop NIRS. Otherwise, the acquisition will continue
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After a NIRS session, it is often useful to review the
data acquired in the session, compare and contrast
it with other NIRS sessions, analyze the data, and/
or export the data for analysis. Brainsight has
several tools to help review and analyze your NIRS
data, and the option to export the session data in
the common “.nirs" format for further processing.

Chapter 18: Reviewing and Analyzing Study Data

REVIEWING SESSION DATA
The usual purposes for review are:

* To verify that the data acquired was reasonable (e.g.
no significant artifacts).

 To sort through the data and export relevant
information for further analysis.

e To configure the display window and take screen-
shots for publication.

Review is initiated from the Session manager pane. Click
on the Sessions tab and then click Review, which will open
a new display window (Fig. 18-1).

Display Window
The review display window uses a similar layout the
perform window with a few changes.

e Anew list, the session list, can be seen next to the
samples list. You can show or hide all the samples
from a particular session as a group in the image
views by enabling the show checkbox. You can show
one or multiple sessions by clicking on their respec-
tive show boxes.

e The samples list displays all the samples from a
session selected from the sessions list. Selecting
multiple sessions in the sessions Llist will add all the
samples from each highlighted sessions into the
samples list. This is distinct from showing or hiding
a sample in the image views. The samples list allows
you to selectively view the attributes of one or more

Chapter 18 > Reviewing Study Data



Fig. 18-1

Session Review window.
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samples. Selecting another session in the sessions

List will affect what is shown in the samples list, but
not what is being displayed on the images. Clicking
Configure Columns... opens a window where you can
enable or disable the display of any attribute in the
samples list to simplify sorting on any one of them.

e The target list will have all the targets created in
this project. You can display any of the targets in
the image views by enabling their respective show
checkbox.

Examining the data and changing attributes

Samples can be made visible or hidden using the show
checkbox. To show or hide all of the samples quickly,
select any sample, press &-a to select the entire list (or
shift-click or 38-click to select a group from the List),
then ctrl-click or right-click on the list and select Show
Selected Samples or Hide Selected Samples from the
popup button.

When a sample is selected (and visible on any of the
image views), the sample will be highlighted by a red
bounding box. When multiple samples are selected, each
one is highlighted.

Selecting a sample in the samples List will display its
attributes under the samples list. Many of these attributes
were acquired when the sample was recorded, such as the
current target at the time and the EMG waveform (if you
were recording EMG). Many attributes are user selectable,
such as the colour and shape of the sample. These can

be changed at any time. Selecting multiple samples will
display the common attributes. Changing any of these
will be applied to all the selected samples.

One noteworthy attribute to describe is the peak-to-peak
response from the EMG. This value is not recorded but
rather it is derived from the raw EMG sample and the
EMG window set with the movable green lines in any
EMG display. If you move the MEP window controls (see
the Brainsight NIBS user manual for details onthe EMG
display), the MEP values will be recalculated. You can
also change the MEP peak to peak manually by selecting
the value in the list, and editing it directly. This new value
will be used in any subsequent motor map calculation
and will be exported when the Data Export option is
selected. This can be handy to remove outlier values
known to be noise or to replace the values with values
from a third party EMG device (and used to create a motor
map display). Note that if you change the MEP window
controls, any modified MEP values will be overwritten
with the newly calculated value, so take care when
changing the window.

The samples list represents a union of the samples from
the selected sessions. You can manipulate content of the
List display by clicking Configure..., and enabling and/or
disabling the available fields. You can display the samples
in the image views for comparison by clicking the show
checkboxes in the lists. You can also change the display
layout (as in any display window) to your preference by
clicking in the list headings to change the display order.

As was possible during the TMS session, you have access
to the inspector tool to customize the image view, change
the display attributes of the 3D surfaces as well as use
the motor maps feature.

EXPORTING THE DATA

You can export the targets or acquired sample data to
a text file for more detailed analysis. The file format is
essentially a tab-delimited text file where each row is a
sample (or a landmark or target if you chose to export
those as well) and each attribute is separated by a tab
character. Attributes with multiple values are separated
by a semicolon.

To export the data, select the samples you wish to
export from the List (if you want to export a subset of the
samples), then click Export... to open the export dialog
box (Fig. 18-2). You can choose to export the samples
as well as the targets and registration landmarks. If you
selected a sub-set of samples to export, click Selected
samples only, otherwise, select All or None. Among the
samples, targets and landmarks, you can select which
attributes for each type of entry to export. You can also
select the coordinate system to use for all coordinates.
The default is Brainsight's internal coordinate system
illustrated in Fig. 18-3. If the anatomical data set
contained a transform to a reference coordinate space
("world space"), you can select that if you choose. If you
performed an MNI registration, you can use MNI or
Talairach coordinates. Enter a file name (and navigate to
the desired folder), and then click Save.
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Exported Data Format

The text file begins with a short header describing the
fields and the order in which they are saved, followed

by the targets (if you chose to export them), then the
landmarks (if selected) and finally the samples. If you
chose to export the landmarks, each one consists of two
points (in the same coordinate space). The first is the
image-based location (the one identified on the images in
the landmarks step) followed by the coordinate sampled
by the pointer during the registration.

Attribute description

All data are written as strings. It is described as an
integer, it is implied that this is the format of the string.
Note that some attributes were added with newer
versions of Brainsight. If you are exporting a session that
was acquired with an older version, the newer attributes
may not be included since they were not recorded at that
time.

 Sample name [string.]: the name of the sample.

* Index [integer]: The index of the sample assigned in
the order of the creation of the samples. If samples
are deleted after they were created, the indexes are
not reused.

* Assoc. Target [string]: the name of the target that
was current at the time of the sample.

* Crosshairs driver [string]: Name of the tool that
was being tracked when the sample was generated.
Possible values are Mouse, Pointer or the name of

Brainsight’ WP  USER MANUALvV2.5

Fig. 18-2

Data export box.

The selected attributes of each sample will be
exported as a text file. The format is a straightforward
tab-delimited text file.
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Fig. 18-3

Brainsight's internal coordinate system.

the tracked tool given when it was calibrated.

Lox X (Loc Y & Loc Z) [float]. X, Y and Z values of the
location of the tracked tool at the time the sample
was taken.

mOn0 mOn1 mon2 [float]: The orientation (direction
cosine) of the x axis of the tracked tool in the host
coordinate space. See for a description of the tracked
tool coordinate system and how to use the location
and direction cosines to assemble the tool to image
transform. This transform can be used to convert
points relative to the tool to points in the image
space (e.g. projections along the coil's z axis into the
head).

m1n0 mlnl m1n2: [float]: The orientation of the y
axis of the tracked tool in the host coordinate space.
m2n0 m2nl m2n2; [float]: The orientation of the z
axis of the tracked tool in the host coordinate space.
Dist. to target [float]: The straight line distance from
the coil reference point to the target.

Target Error [float]: The shortest distance from the
line projecting into the head along the coil's path.
Angular Error [float]: The tilt error of the coil.

Date [string]: The date the sample was acquired in
YYYY-MM-DD format.

Time [string]: The time (according to the system
clock) in HH:MM:SS. XXX were HH is the hour, M is
the minute, S is the second and XXX is the milisec-

ond.

EMG Start [float]: Time in msec before the sample
time (e.g. when the coil fired) when the EMG record-
ing started. Also referred to as baseline. Always a
negative number.

EMG End [float]: End time in msec of the EMG sample
(trial duration)

EMG Res. [float] Time in msec between samples.

e EMG Channels [integer]: Number of active channels

during the session (usually O, 1 or 2).

EMG Peak-to peak N [float]: N is the channel number.
Peak to peak value in 1V calculated between the
EMG window at the time the data was exported.
Note that for multiple EMG channels, the order of
the data output is EMG Peak to Peak 0, EMG Data 0,
EMG Peak to Peak 1, EMG Data 1 and so on.

EMG Data N: [float;float;...float]. EMG samples in LV,
separated by a ;". The number of samples can be
calculated by

(EMG End-EMG Start)/EMG Res

You can perform the export more than once and switch

coordinate systems between exports to export the data in

multiple coordinate systems.
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Fig. 18-4

ILlustration of the relationship between the coil position and
orientation described by the Loc and direction cosine values.
They can be assembled into a matrix to convert coordinates
relative to the coil into Brainsight, world or MNI/Talairach
coordinate spaces. For example, to find the Brainsight
coordinate of a point 15mm under the coil, multiply the
transform matrix by the vector [0, 0, 15, 1].
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ANALYZING SESSION DATA

Data analysis of your acquired NIRS session can be
performed within Brainsight. From the Sessions tab,
select the session you wish to analyze, then click Analyze,
which will open a new display window with four tabs (Fig.
18-5).

Import

If your data was acquired by a Brainsight NIRS system
(the NIRS device), the NIRS data is already part of

the project, so you can skip this step. If your data was
acquired using another NIRS device, it is possible to
import the .nirs file here and match it to the assembly
list that was used to estimate and/or digitize the location
of the optodes. It is important that an assembly list was
used during the navigated session in order to have a valid
mapping from the channels of the NIRS data file to the
channels defined in the Brainsight project to project them
to the correct location on the head.

Onsets

In the Onsets step, you can define your conditions (or
events) and extract the onset times for each type of
condition.

» Under “Conditions”, name a new condition by
selecting "Add...".

e |n "Onsets for condition "Condition Name":", select
‘Add From..." and select your desired method for
setting your onset times to use for analysis:
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* NIRS Aux Channel Data: extracts onset times using
a threshold to detect voltage spikes recorded from
an auxiliary channel connected directly to your
NIRS device. This method will result in the most
precise synching of triggered events and the data.

* Existing Session Samples: extracts onset times by
using samples acquired during the session (i.e.
manual samples or triggered samples received by
the 1/0 box).

* Manual Time Indexes: manually create a comma-
separated list of onset times for the duration of
the session (e.g. 10,40,70,100, etc.).

The List will now be populated with onset times for your
chosen condition.

Processing

In the Processing tab, the optical density is calculated as
an intermediate processing step using the raw NIRS data,
the absorption coefficient of the tissue and the distance
travelled by the light from source to detector. To remove
any extraneous noise in the data, including respiration
and heart rate, you can apply either a low pass, a high
pass or a band pass frequency filter to the data. Select
the type of filter you wish to apply and click “Compute”.

Concentration

The Concentration tab allows you to display your
analyzed data. Average HbO, HbR and HbT concentra-
tions from a chosen condition for each source-detector

pair are displayed in the Image View of “NIRS Average

A Concentrations”. HbO is displayed in red, HbR is
displayed in blue, and HbT is displayed in green. To set
the parameters to visualize your analyzed data, input the
following:

* In "Time range around onsets", input the desired
time to be used for baseline data (the time before a
condition, as a control) and input the length of time
to be analyzed for the trials. Ensure to not have trial
times overlapping when performing your analysis
(e.g. do not enter a trial time value that exceeds your
intertrial interval), as this may make your resulting
data difficult to interpret.

* Select the condition you would like to view. Ensure
the correct onsets in the condition are checked. Then
click "Compute”.

The average concentration data can now be seen in the
Image View.

The individual trials used to calculate the averages are
shown in the "Onsets for Condition “Condition Name":"
window. In a condition, if one or more particular trials are
unsuitable for analysis, the trials can be unchecked in the
“Contribute” column and new averages will automatically

be calculated and displayed for that condition.

In the Legend of “NIRS Average A Concentrations”,
you can select which source-detector pair to highlight
in the graph by clicking on it once; you can remove a
source-detector pair from the graph by unchecking it;

and you can choose to view HbO, HbR and/or HbT by
clicking or unclicking their respective buttons at the
top of the legend. You can also highlight a particular
source-detector pair by clicking on a tube on the “Skin
and Electrodes" Image View.
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Fig. 18-5

NIRS data import window
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DemoNIRS_Mathieu_20170312 copy - Session 2 Analysis

If you acquired NIRS data with a non-Brainsight NIRS device you can impert the data in this step. The
session must already contain Electrodes that have been positioned correctly. Use the tables below to
ensure that the imported file matches the existing session data.

Electrodes in this session:

Name

M1 (B4-D1)

M3 (B4-D2)
M5 (B4-D3)
M7 (B4-D4)
M8 (B4-S1)

M11 (B4-S2)
M13 (B4-53)
M15 (B4-54)
T9 (B4-D5)

T (B4-D6)
T13 (84-D7)
T15 (B4-D8)

Optodes from imported file:
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Fig. 18-6

Analysis window: Onsets tab

Add conditions and then add the event onset times for each

condition using “Add From...".
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Onsets Processing Concentration

' NIRS Test.bsproj - Session 1 Analysis

An ‘onset’ represents a point in time in the NIRS
data. ‘Conditiens’ group multiple onsets by any
criteria relevant to your study. Multiple conditions
may be created. To exclude an onset from
participating in calculations, uncheck it in the
‘Contribute’ column. Later calculations are
performed per condition.
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Fig. 18-7

Analysis window: Processing Tab

Compute and view optical density data and the filtered data.
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Fig. 18-8

Analysis window: Concentration tab

For a selected condition, displays average changes in
concentrations for HbO, HbR and HbT for each source-

detector pair.
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Chapter 19: EEG Electrode Recording

Many Brainsight users also happen to use EEG for
many of their experiments. If you are one of them,
then you can make more productive use of your
Brainsight position sensor hardware to digitize the
locations of the EEG electrodes and of the scalp.
This often renders the need for the Polhemus
system (and the Locator software) redundant.

There are literally dozens of EEG data acquisition and
analysis programs in use today. Some of these use
standardized configurations of the EEG electrodes (e.g.
10-20 grid) to estimate the locations of each electrode.
Other programs use a 3D position sensor (not unlike the
Vicra used by Brainsight) to digitize the exact locations of
the electrodes and sometimes the scalp to either create
a more realistic model of the head, or to co-register the
EEG data to MR images of that subject. In addition to EEG,
many NIRS-DOT systems employ the same techniques to
localize the NIRS optode locations.

Brainsight supports two methods to represent the EEG
electrodes. One is a free form method where the three
anatomical landmarks are recorded, followed by the
electrodes in no particular order. The second method
uses a sequence file (commonly used by BESA) to define
a sequence of electrodes that can be loaded to prompt
you to digitize the electrodes in that order. In either case,
you may also want to digitize a random sampling of scalp
points to characterize the shape of the head.

Itis important to note that you do not need the MR
images of your subject for this procedure. Strictly speak-
ing, you are not performing any neuronavigation, you are
simply using Brainsight to talk to the position sensor and
take some measurements.

Once the measurements have been taken, you can save
them in one of a few file formats, depending on the
accepted formats of your EEG software.
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GETTING STARTED

* Launch Brainsight and dismiss the splash screen.
To open the EEG window, select Window->Electrode Fig 19-1
Recording (Fig. 19-1). Enter the name of the subject ’

in the field at the top of the window. First step of electrode recording.

Setting up 8ano Electrode Recording
¢ Before Starting, set up the trigger method(s) to Subject Name: | John Doe First, sample the nasion, left preauricular and
right preauricular from the ‘Landmarks' tab.
notify the computer whenever you are touching a { Landmarks | Electrodes  Head | R O I SIIgs
. L sample any number of head samples from the
landmark. Optionally turn on the speech recognition Hame e s Wead tab. You can import the list of
Nasion Nasion v X landmarks and electrodes to be sampled by
. . . . Left P icul : licki he 'Load ... b E
or Apple Remote by enabling or disabling their o e o Make Sure the Subjec tracker does not move
t|\/e Checkboxes relative to the subject during the procedure.
respec .
Load Sequence...
e Put the subject tracker on the subject's head and T
Export As...

place the subject in the view of the Polaris position

sensor (review how to prepare the subject and use
EUse Speech Recognition

the Polaris by looking at “Prepare the Subject” on o o T B R PP Ca e
a sample, "Next® or "Previous” to change
page 80) the selection, or the name of the tab to
change to.
E Use Apple Remote
USING A SEQUENCE FILE e
next samples, and the next and previous
e [fyou are using a sequence file, load it here by click- EAEB G Rl e,

ing Load Sequence..., and select the file using the file
dialog box. Refer to your EEG software documenta- Polaris status: OK & Tracking

tion regarding the file format specification for a
Pointer: I P630

sequence file (which has a .seq extension), or contact Subject tracker: [l ST435
Rogue Research for an example file. Once the ! )
Sample & Go To Next Remove ( Clear All ) If your tools are not visible, click this.
sequence file has loaded, the electrode references (" Reset Polaris )
will appear in the Landmarks and Electrodes tab —_——

(when you get to the next step). Note that loading a
sequence file clears any pre-existing samples.
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DIGITIZE THE ANATOMICAL LANDMARKS
 |f not already the active tab, click the Landmarks
tab to bring it up (or, if you have speech recognition
activated, say “Landmarks").

e Place the tip of the pointer on the first landmark and
either say "Sample"”, press Play on the Apple Remote
or have an assistant click on Sample & Go To Next.
The software will sample the location of the pointer
and associate it with the currently selected landmark
in the List. The green check mark confirms this.

e |fthere is another landmark, the software will
automatically go to the next one and speak the
name of the electrode (assuming you have the
volume turned up). Take note of this, and touch it
with the pointer and repeat the sample process.

¢ Continue for all landmarks.

Once you sample the last landmark, no landmarks will
be selected. If you wish to add additional landmarks,
continue to sample landmarks (as you did before) and
new unnamed ones will be created. You can change the
names as you go, or select them in the list after you have
finished and rename them at that time.

You can re-sample a landmark by selecting it in the list
and sampling it with the pointer again. You can remove
entries by selecting them in the list and clicking Remove.
Finally, you can clear all the samples by clicking Clear
ALL, which removes the sampled data but leaves the

Fig. 19-2

Electrode digitizing screen

800 Electrode Recording
Subiject N. - First, sample the nasion, left preauricular and
ubject Name: |John Doe right preauricular from the ‘Landmarks' tab.
[ Landmarks | Electrodes | Head 1 Then, sample the electrode positions from the
‘Electrodes' tab. Finally, you can optionally
Name Type Acquired sample any number of head samples from the
- . 'Head' tab. You can import the list of
32_Af3 Electric (EEG)  + ¢ landmarks and electrodes to be sampled by
33_F3 Electric (EEG) + + clicking on the 'Load sequence..' button.
N . Make sure the subject tracker does not move
S51Ecd CiEmia(EED) S relative to the subject during the procedure.
37.C3 Electric (EEG)  + o
38_Cp3 Electric (EEG) - ¢ M Load Sequence...
39_p3 Electric (EEC) & o —_—
41 PoS Electric (EEG) + + Export As...
42_Pa7 Electric (EEG) &
57_Fpl Electric (EEG) + +
55_Af1 Electric (EEG)  + +
54_F1 RS S M Use Speach Recognition
52_Fcl EIECU!( (EEG : v You can speak the word "Sample” to take
50_C1 Electric (EEG) + a sample, "Next" or "Previeus” to change
48 Cpl Electric (EEG) + + the selection, or the name of the tab to
47_P1 Electric (EEG) & o v EEED
45_Po3 Electric (EEG)  + o B Use Apple Remote
44 01 Electric (EEG) + + The "Play" button takes a sample, the plus
59 Afz Electric (EEG)  * o and minus buttons move to previous and
= B : next samples, and the next and previous
Gnd_Gnd Electric (EEG) + buttans change the active tab.
60_Fz Electric (EEG) &
62_Fcz Electric (EEG) + o
63_Cz Electric (EEG)  + o
Ref_Ref Reference (EEG) - ¢ Polaris status: OK & Tracking
65_Cpz Electric {EEC) + o
66_Pz Electric (EEG)  + o
68_Poz Electric (EEG) * H Pointer: [l P630
69_0z Electric (EEG) _+ 1 Subject tracker: Ml 5T435
Sample & Go To Next AN Remove ) ( Clear All ) If your tools are not visible, click this.
Reset Polaris
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entries so they can be re-sampled.

DIGITIZING ELECTRODES

e Click on Electrodes or say “Electrodes” to bring up
the electrodes tab (Fig. 19-2). If you are using a
sequence file, then all the electrode names should
be visible in the list. Otherwise, the list will be empty
and any new sample will automatically be named
“Electrode-1, Electrode-2...".

e Touch the first electrode (either the one highlighted
in the list, or if there are no entries in the list, your
first electrode) and either say "Sample”, press Play
on the Apple Remote or have an assistant click on
Sample & Go To Next. The software will sample the
location of the pointer and associate it with the
currently selected electrode in the List.

¢ |f there is another electrode, the software will
automatically select to next one in the list and speak
it. Take note of this, and touch it with the pointer and
repeat the sample process.

¢ Continue for all electrodes.

Once you sample the last electrode, no electrodes will
be selected in the list. If you wish to add additional
electrodes, continue to sample them (as you did before)
and new unnamed ones will be created. You can change
the names as you go, or select them in the list after you
have finished and rename them at that time.

You can re-sample any electrode by selecting it in the List
and sampling it with the pointer again. You can remove
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entries by selecting it in the list and clicking Remove.
Finally, you can clear all the samples by clicking Clear
ALL, which clears the sampled data, but leaves the entries
so they can be re-sampled.

DIGITIZING HEAD SHAPE (OPTIONAL)

The purpose of the head sampling function is to generate
a "cloud” of samples that will help define the shape of the
scalp. This is used by many EEG applications to generate
a subject specific head model or to co-register the EEG
electrode coordinate space to the subject's MR space.

To begin acquiring scalp samples:

* Click on Head or say “Head" to bring up the Head
sampling tab (Fig. 19-3). Note that the List will be
empty as there are no pre-defined head points.

* Touch the pointer tip gently on the subject’s scalp,
making sure that the pointer is visible to the Polaris
and either say "Sample”, press Play on the Apple
Remote or have an assistant click on Sample & Go
To Next. The scalp location will be recorded and the
entry will be appended to the list in the window.

* Move the pointer tip to an adjacent location on the
scalp and sample again (using the same options as
in the previous step).

» Continue to sample scalp locations throughout the
head according to the needs of your EEG software.
Typically, at least 20-30 points will be required.
make sure that you obtain samples all over the head

to obtain a reasonably good representation of the
head shape.

SAVING THE DATA

Once you have sampled the anatomical landmarks,
electrode locations and head shape cloud (if needed), you
can save this information to a variety of file formats.

 Click Export As... to open the save file dialog (Fig.
19-4).

* Select a file format from the popup menu (see
below), enter a file name and click Save.

FILE FORMAT DETAILS

The file format chosen for export will influence two
things: The format of the text and the coordinate system
of the samples. Choose the right one for your EEG
software. Take special care to fully understand the coordi-

nate system used for each format as they can be confusing!

Text (.txt)

This is the simplest file format. The coordinate system
uses the subject tracker as the origin and the coordinate
axes, which are arbitrary depending on the orientation
of the subject tracker. ALl samples are in this coordinate
system. The coordinate system details are irrelevant as
the anatomical samples would presumably be used to
co-register all the samples to your specific coordinate
system.



Fig. 19-3 Fig. 19-4

Head Sampling Screen File Export Dialog

800 Electrode Recording
Save As:“ I B
Subject Name: First, sample the nasion, left preauricular and
) John Doe right preauricular from the ‘Landmarks’ tab.
{ - andmarks = Electrodes- s ‘} Then, sample the electrode positions from the [ PR [ FE )_‘_{* m ! | [ Documents. H (Q search ™
'Hlectrodes' tab. Finally, you can optionally
Name Acquired Is.]mple any number of head samples from the W"F_ﬁ Date Modified ‘ -
Head-1 'Head" tab. You can import the list of E —_— = 2ndGenCoils.pdf Sunday, December 30, 2007 5:36 PM
ead- v landmarks and electrodes to be sampled by = . 3 6DArchitect Thursday, January 31, 2008 8:21 PM w
Head-2 v clicking on the ‘'Load sequence..' button. 3 calvin Mond 5 2009 3:23 PM
Head-3 v Make sure the subject tracker does not move El cawi... & 09_Hill-Kimber...UED50109.pps onday, January 5, :
relative to the subject during the procedure. {23 80-20 Framing Monday, February 25, 2008 5:22 PM
Head-4 v ¥ SHARED | 0000374_Upd...0.2 GM - Mantis  Tuesday, August 11, 2009 7:27 PM
Head-5 v Load Sequence... 2008 R9%D Time.xIsx Monday, June 15, 2009 1:03 PM
Head-6 v [ 2008 R%D Time.xIsx Folder Friday, June 12, 2009 1:35 PM
Head-7 v Export As... 8700247.ROM Friday, January 16, 1998 3:09 AM
8700248.ROM Monday, January 26, 1998 2:48 PM
54 20010201-1.sit Monday, March 30, 2009 4:09 PM
T 021193074.pdf Thursday, February 21, 2008 1:41 PM
. Y [ Alphaomega Saturday, January 3, 2009 4:55 PM
# Use Speech Recognition l@ Andrew_OHBM.pages Monday, June 15, 2009 10:23 AM
You can speak the word "Sample” to take ATA CArnet 2008.xls Tuesday, May 6, 2008 10:01 AM
5 ST, (D O e I disng; VST T AV_s650_UG_MB6OR. pdf Friday, March 7, 2008 6:12 PM L
the selection, or the name of the tab to [ DevTree — o r
change to. g Brainsight 2 roadmap.pages Wednesday, June 24, 2009 1:57 PM o
fif roch L 0 Bv Test Sunday, December 21, 2008 9:42 AM B
EUseAppleRemore T e e e
The "Play” button takes a sample, the plus
and minus buttons move to previous and
next samples, and the next and previous Export as| v Text (.txt)
buttons change the active tab. LOCATOR (.elp/.hsp)
BESA (.sfp)
New Folder Save )
i
Pointer: . P630
Polaris status: OK & Trackin
9 Subject tracker: Ml 5T435
Pointer: M P630 Sample & Go To Next 3 ( Remove ') ( Clear All ) If your tools are not visible, click this.
Subject tracker: ll 5T435 Reset Polaris
L Sample & Go To Next N £ Remove 't ( Clear All ) If your tools are not visible, click this.
)
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Locator

The coordinates are transformed according to the Locator
coordinate system (sometimes referred to as the CTF
coordinate system). In short, the X axis is defined as the
line starting at the midpoint between the RPA and LPA
and passing through the nasion. The Z axis is taken as
the cross product of the X axis and the RPA-LPA line and

the Y axis is the cross pI”OdUCt of the Zand X axes, which As more Brainsight users become familiar with EEG, we
is close, but not necessarily exactly along the RPA-LPA would be happy to include additional file formats to the
line (read that again 3 times!). list. Please do not hesitate to contact us.

BESA

The BESA file format structure is similar the Locator,
except that the coordinate system is slightly different (and
sometimes confused with the Locator coordinate system!).

The origin is the point along the LPA and RPA line where
the line from that point to the nasion would be perpen-
dicular to the LPA-RPA line (near the middle, but not
necessarily exactly the middle due to head assymetry).
The X axis is along the LPA-RPA line. The Y axis goes
from the origin to the nasion and the Z axis is the cross
product of the X and Y axes.
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The Brainsight computer trolley is designed to
provide a large screen computer, required input/
output ports as well as an integrated 2 channel
EMG device in a small footprint, mobile platform.
The updated version of the system will be released
shortly along with an updated version of this user
manual. This chapter will cover the version of the
computer without the 2 channel EMG device.

Chapter 20: Hardware Reference-Computer Trolley

The mobile computer (Fig. 20-1) consists of three main
parts: The computer, the trolley itself, and the 1/0 box.
Some early versions of the trolley did not have an 1/0 box.
We intend to upgrade all trolleys to the same 1/0 box in
the near future, so contact us to arrange the upgrade.

COMPUTER

The computer is an iMac (24" or 27" screen, depending
on the purchase date) with Intel processor. It is mounted
to the trolley via three fixation screws that screw the base
to the top of the trolley, or by a base platform, that itself
is screwed to the cart via the three fixation screws.

TROLLEY

The trolley allows you to move the computer anywhere
you need it. The keyboard and screen’s height can be
adjusted by pushing the foot pedal at the base of the
trolley, and lifting/pushing the computer up and down.

1/0 BOX

The current I/0 box (Fig. 20-2) contains a power bar,
cabling and the acquisition device that serves to monitor
the TTL and switch interface as well as provide the
analog inputs for our 2-channel EMG device. The box has
a rear panel that provides the BNC interface jacks for the
TTL trigger in and the foot switch (or hand switch), the
analog input connector, the mains switch and the Vicra
power switch..

Chapter 20 > Hardware Reference-Computer Trolley



Fig. 20-1

Overall picture of the computer/trolley

Fig. 20-2

Close-up of the rear panel.
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The Vicra switch also allows you to turn the Vicra on or * 1x hex key (bronze) 3. Place the trolley wheel base upside down on the I/0
off without affecting the computer to allow you to use the
computer for project preparation or data analysis without

box, and carefully align the holes in the wheel base

Tools required:
to the holes in the I/0 box as illustrated in Fig. 20-3.

) ) * Phillips (star) screwdriver
having to have the Vicra on. 4.

) ) Insert the two hex bolts into the holes of the wheel-
 Scissors or cutters for cable-ties

ASSEMBLY INSTRUCTIONS base and carefully tighten the bolts to secure the 1/0
Parts: Instructions box to the wheelbase using your fingers first, then
1. Unpack all parts and make sure they are in good with the included xx hex key. Take care to ensure that
* Trolley Wheel Base condition. the bolts are straight into the mounting holes of the
* Main Tube 2. Place a piece of flat "bubble-wrap" material on the 1/0 box and carefully tighten the bolts to not strip
* Foot Pedal floor, and place the 1/0 box on it upside down to them (i.e. if the bolt goes in crooked).
* Keyboard tray expose the mounting holes. 5. Flip the wheelbase back upright.

 Trolley handle kit (handle, front bracket, 2 insert

brackets) Fig. 20-3

e Computer base

1/0 box and trolley Leg, seen from underneath with the

e |/0 box mounting holes identified. Note that only 2 bolts are
/O Box (bOttom) required (one per Leg) to secure the box to the Legs.

e 2x hex bolts w. yellow threadlock (usually on the
bottom of the Main Tube.

e 2x hex bolts w. blue thread lock

e 2x hex bolts (longer)

e 3x counter-sink hex headed screws
* White Power Cable

e Medical grade power cable

e 2x 2m USB cable

e 2xlong cable-tie

e 6x short cable tie

e 1x3/16" hex key

Chapter 20 > Hardware Reference-Computer Trolley
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6. If present, remove the two hex bolts (yellow thread-

lock) from the bottom of the main tube.

7. Fit the main tube into the hole in the middle of the

wheelbase, taking care to align the tab of the main
tube with the notch in the wheelbase.

8. Carefully tilt the wheel base/tube onto its side to

expose the bottom, while keeping the tube in the
hole (you may need an assistant for this step).

9. Closely examine the two mounting holes at the

center of the wheelbase (underneath the base).
You should see the holes of the main tube roughly

Alignment Pin

Fig. 20-4
Pole in the receptacle in the base. Note the alignment pin on
the pole and the slot in the base.
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aligned with the holes. Gently twist the main tube
to make sure the holes are properly aligned (this
will prevent the mounting bolts from binding and/or
stripping later).

10. Take the pedal, and align the two mounting holes of
the pedal base with the 2 holes in the center of the
wheelbase. Make sure the foot pedal is between two
of the wheel base spokes (and NOT under a spoke).
If it is under a spoke, rotate the pedal 180° and align
the holes again. Hold the pedal in place.

Fig. 20-5

Correct placement of the pedal.

11. Using the 2 hex bolts with the blue thread-lock on

the tips, bolt the foot pedal, wheel base and main
tube together. Use the included hex key to tighten
the bolts. Take care that the bolts go in straight and
do not bind (see Fig. 20-6).

12. Place the assembly back on its wheels.

13. Partially assemble the handle by fitting (snapping)

the two insert sleeves into the two halves of the

Fig. 20-6
Example of a bolt that was not correctly inserted (pedal
omitted for clarity).

handle assembly.

14. Fix the handle to the top of the inner tube of the
main tube by screwing the two halves of the handle
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15.

16.

assembly around the tube using a #2 Phillips (star)
screwdriver.

Take the computer base platform, and disassemble
it by removing the two thumbscrews at the bottom,
and separate the two halves. The half with the 3
holes will be mounted on the trolley along with the
keyboard tray.

Take the keyboard tray and the bottom half of the
computer base (the half with the three holes) and
align them to the three holes on the top of the main
tube. Rotate the keyboard tray and/or the computer
base to ensure that the keyboard tray is over the

Fig. 20-7
Assembly of the computer base and keyboard tray. The tray
sits between the computer base and the top of the pole. The
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17.

foot pedal and that the front of the computer base

is over the foot pedal. The keyboard tray should be
on the tube and the computer base should be on the
keyboard tray.

Using the 3 counter-sink screws, secure the
computer base and keyboard tray to the top of the
main tube. Tighten the screws using your fingers
first (and ensure they are not binding) and then
tighten them using the included hex key. Make sure
the assembly is well secured and that there is no
wiggle between the computer base and the tube.

three screws go through the computer base i and then the
keyboard tray and are fixed into the three holes in the pole.

18.

20.

21.

22.

23.

24.

Unpack the iMac computer and remove the plastic
film covering the base.

Place the computer on the computer base, ensuring
that the base fits into the cutout in the base. The
base should not protrude past the height of the
cutout.

Place the two foam spacers on the front part of the
iMac base.

Place the upper part of the computer base on top of
the lower part (sandwiching the iMac to secure it),
and secure the upper part to the lower part using
the two thumbscrews.

The power cable and 2 USB cables come as a
harness (cables in a spiral wrapper). Plug the white
power cable into the power outlet in the front of

the 1/0 box (the part against the main tube of the
trolley). Plug the two USB cables into plugs labelled
USB 1 and USB 2. Run the cable up the tube,
through the handle (the handle should be facing
the rear of the trolley), through the hole of the iMac
base into the iMac power receptacle in the rear.

Plug the power cable and the two USB cables into
the receptacles at the rear of the computer. Note
that it does not matter which USB ports are used,
but using the ports towards the middle will minimize
the clutter.

Press the foot pedal, and raise the iMac as high as it
will go.



25.

26.

27.

28.

29.

30.

Tilt the iMac back to pull as much cable as will be
required to tilt fully through the hole in the iMac
base.

Take one long cable-tie to be used to fix the cable
harness to the trolley handle in a way to take the
weight of the cable of the connectors on the iMac:
Observe where the harness comes close to the
trolley vertical pole, between the trolley handle and
the bottom of the iMac base.

Run the cable-tie through the spiral wrap of the
power/usb cable harness and then around the pole

at the location described above. Secure the cable-tie.

Plug the power cable into the rear panel of the I/0
box, and into a power outlet.

Remove the twist-ties that secure the Vicra cable at
the rear of the 1/0 box.

Follow the instructions in the Brainsight user
manual to connect the Vicra to the Vicra cables.

Using the computer

1.

Make sure that the mains switch at the rear of the
trolley is set to ON.

Press the power button at the rear of the iMac. After
a few seconds, you should notice it start up.

Once booted, follow the instructions in the Brain-
sight User Manual to operate the Brainsight system.
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Software Updates

Like all modern computers, your Brainsight computer
and software require regular software updates, which are
supplied via the internet. Make the appropriate arrange-
ments with your IT dept. to allow regular access to the
internet by the computer.
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